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About this manual

This manual contains 10 chapters that are independent of each other. It is not mandatory
to study them all. Chapters 1 “Hardware Setup” and 2 “Software Setup” explain the
installation procedure of the measuring system on your PC. Chapter 3 “MF Menus”
explains the menu functions in tabular form for future reference. Chapters 4 “Measuring
preparations” and 6 “Measuring loudspeakers” contain general information on measuring
methods and accompanying hardware peripherals. Chapter 8 “Examples” explains
common audio measuring procedures and setups for an easy start. To get a grip on MF
and its hardware, standard measurements according to these examples are recommended
which may later be modified according to your requirements. Chapters 10 “Crossover
Works Option” and 11 “HUGO” introduce an optional module to calculate FIR filters,
and the digital controller HUGO respectively DSC28 by GAE. Another chapter on Digital
Field Control (DSC) by HK-Audio is in preparation.

Advice in the text is distinguished as follows:

MF menu items: AD/DA basic settings

Pointers: The port address is $0530...

Warnings and important pointers: Attention! Do not connect...

Key functions: by CTRL M ....

Menu options and functions: Averaging... (A=Hotkey)

Meanings of icons:

Icon Meaning

: For service purposes only; do not adjust

$ Read only; no entry intended

I Attention: adjust settings only when familiar

with hardware and signal processing

M Important parameter; do not adjust running on

standard hardware

N Critical menu; incomplete or insufficiently

tested

7 Entry necessary
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CE conformity

This is to confirm that the ITADDA16-Dual 16-bit AD/DA measuring system conforms

with EEC directive 89/336/EEC.

DIN EN 55011; DIN EN 55013; DIN EN 55014; DIN EN 55022; DIN EN 60555; DIN EN 50081-1/2

The conformity certificate may be viewed at the manufacturers:

Audio & Acoustics Consulting Aachen

Dr.-Ing. Swen Müller (MF und MFX) and Dr.-Ing. Anselm Goertz (MAXILS)

Robensstr. 62

D-52070 Aachen (Germany)

Tel. ++49 241 155820 ; Fax ++49 241 155821 ; e-mail anselm.goertz@t-online.de

Note: The CE label only confirms compliance with the law. It is no harmonized system of

quality assessment.
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Liabilities and warranty

Liability: Audio & Acoustics Consulting shall not be liable for damage to loudspeakers,

amplifiers and other audio equipment, damages arising out of loss of use, loss of revenue

or profits, or any other damages, whether incidental, consequential or otherwise.

Warranty: ITADDA is warranted to be free from defects in material and workmanship

for a period of 24 months commencing from the date of purchase by the original

purchaser. Audio & Acoustics Consulting replaces and repairs defect parts if defects

occur under normal operating conditions. The product must be returned in the original

packaging freight and insurance prepaid. Audio & Acoustics Consulting reserves the right

to determine if the defect(s) are covered by the warranty. Not covered by the warranty are

defects from accident, misuse, abuse, neglect, attempted repair and units on which the

serial number has been removed.

Warning: Measuring equipment and measuring setups are equivalent to laboratory

conditions and must be handled with care. Connecting and operating measuring

equipment requires experience with audio equipment and measuring technology. Lack of

competence may result in serious material and physical damage when handling

loudspeakers, measuring and audio equipment. Always make sure measuring setups are

properly grounded. Never operate MF without connection to ground!
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Packaging contents

The standard ITADDA packaging contains

• 1 pc. ITADDA 16-bit 2 Channel ISA PC plug-in

• 1 pc. ITADDA Front-end with preamplifier and power amplifier

• 1 pc. Sub D 15 pin cable to connect front-end and plug-in

• Test protocol

• DOS software disk

• Instruction manual

Software

MF, MFX and MAXILS software is published by:

Audio & Acoustics Consulting Aachen

Dr.-Ing. Swen Müller (MF und MFX) and Dr.-Ing. Anselm Goertz (MAXILS)

Robensstr. 62

D-52070 Aachen (Germany)

phone ++49 241 155820 ; fax ++49 241 155821 ; e-mail anselm.goertz@t-online.de

Unauthorized copying and distribution in any form is prohibited.

Copyright

The copyright of this manual is owned by:

Audio & Acoustics Consulting Aachen

Dr.-Ing. Anselm Goertz

Robensstr. 62

D-52070 Aachen (Germany)

Copying and distribution of this manual is specially requested!
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Hotline

A Hotline for software and hardware is available at any time. Questions by e-mail are

desired. For very urgent questions we also answer with pleasure at the phone.

Audio & Acoustics Consulting Aachen

Dr.-Ing. Anselm Goertz

Robensstr. 62

D-52070 Aachen (Germany)

Tel. ++49 241 155820 ; Fax ++49 241 155821 ; e-mail anselm.goertz@t-online.de

Service

The following additional chargeable services are available:

- Installation of audio test setups and test rooms

- Training in audio and acoustic measurements

- Measuring service in anechoic chamber or on-site

- Measuring of poweramps, mixers, ... with Rohde & Schwarz UPD

- Design, calculation and simulation of PA systems

- Lining up and programming of digital controllers

- Measuring of speaker data for simulation software

like EASE, CADP2 and ULYSSES
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1 Hardware Setup

1.1 General

The ITADDA16 plug-in can be installed in any PC with a 16-bit ISA slot. Minimum

requirements are a 386 processor with a 387 coprocessor, 486DX or Pentium types are

preferable. 486SX models without coprocessor cannot be used. There are no special

RAM size requirements. Memory can be linearly addressed in 32-bit mode so resolution

and length of test signals depend on memory capacity. For normal use 8MB or larger are

recommended. Only 4MB hard disk space is required for all program files. The external

ITADDA16 front-end is connected to the internal AD/DA converter via a 25 pole sub-D

cable. Attention: do not connect the cable to powered units to prevent short circuits!
The front-end requires a dedicated AC outlet for its internal power supply while its digital

circuits are powered by the PC power supply. The standard plug-in port address is $0530.

If necessary the setting may be changed on the plug-in. The new address must be entered

in the AD/DA basic settings menu of the MF software. A check appears behind

the address if the card is detected correctly. Read on for further setup details.

1

Figure 1 Front view of the ITADDA Front-end
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1.2 Analog I/O’s

The MF system is fully stereo with left and right inputs and outputs. Balanced XLR

inputs and outputs are located on the front panel. On the rear panel, unbalanced MDP

(banana) outputs are provided next to the heat sink to connect loudspeakers to the

integrated 20W monitor amplifiers.

1.2.1 Inputs

The inputs are electronically balanced and provide 48V phantom power switching for

microphones. Maximum input level is dependent on attenuation and indicated by an LED

meter right of the XLR connectors. Attenuation may be preset in 20dB steps to -40, -20,

0, +20 or +40dBu (0dBu = 775mVeff) on your PC. For unbalanced input pin 3 of the input

connector must be connected to ground (pin 1). For fine tuning the A/D converter input

sensitivity may be set in 1.5dB steps in the AD/DA basic settings menu

depending on the estimated input signal strength.

1.2.2 Outputs

The XLR outputs on the right of the front panel are electronically balanced. 0 or +20dBu

maximum output levels with LED indicators are selectable in the AD/DA

basic settings menu. For unbalanced output connect pin 3 of an XLR-to-RCA (or

similar) adapter to pin 1 (ground). The output level to pin 2 automatically increases by

6dB, the output voltage from pin 2 to ground is identical to the differential voltage

between pins 2 and 3 in balanced mode.

1.2.3 Monitor Amplifier

The integrated 20W monitor amplifier provides 20dB maximum gain adjustable by a front

panel level control. For measuring purposes this should be turned fully clockwise for

20dB gain (Cal.). Actually, the level control is contradictory to the system philosophy to

control all settings by software only to prevent operating errors. However, the level

control/Cal. setting compromise was made to adjust the loudspeaker/headphones level

when using the amplifiers for monitoring purposes during measurements. The output

signal is fed to the rear panel MDP connectors and the ¼” front panel headphones socket.

Attention: maximum output voltage @ 4 Ohms or more is about 20dBu (approx.
8Veff). For that reason  the output level must not be set >0dB to prevent clipping which

results in “ragged” curves when measuring frequency response with maximum length

sequence noise.
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1.2.4 AD/DA Converter

The Crystal CS4231 chip on the plug-in contains two 16-bit A/D and D/A converters each

providing a sampling rate from 5.5kHz to 48kHz. Signal-to-noise ratio is minimum 80dB

and typically 85dB facilitating problem-free measuring of all kinds (loudspeaker,

microphone, acoustics). THD is minimum -75dB and typically -90dB and fully sufficient

to measure distortion of loudspeakers and audio components. Measurement results below

-80dB THD (=0.01%) should be checked for plausibility by calibration to determine the

system and test object THD amounts. Bridge the test object and repeat the measurement

with the same settings for calibration.
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2 Software Setup

2.1 General

The PC initializing files AUTOEXEC.BAT and CONFIG.SYS must be slightly modified

for MF. The EMM driver must be deactivated completely in CONFIG.SYS. For

practical reasons enter DEVICE?=C:\DOS\EMM386.EXE. After starting your PC answer

N (= no) to the “Load driver?” query. Enter the installation path in AUTOEXEC.BAT,

e.g. PATH C:\DOS;C:\WINDOWS;C\MESS.

Available DOS memory should be minimum 450K for MF and 500K for MFX.
Memory may be queried by the DOS command MEM /c /p in case the error message

“Oh Lord, more memory please” pops up when calling MF or MFX. This also provides a

survey of the programs in memory. MFX differs from MF only by including the FIR filter

calculation option. Therefore MF is less spacious and does not reach the memory limit in

the lower 640kByte DOS domain as quickly.

After these preparations create the path MESS and copy the MESS-SYS.ZIP and

PKUNZIP.EXE files from the disk to MESS. Calling PKUNZIP MESS-SYS.ZIP unpacks

all necessary files from this folder. Select this path if a weighted noise sequence or

specific fonts are required for the measuring programs.
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2.2 AD/DA Converter

The AD/DA basic settings menu contains all important measuring hardware

settings. Hardware type must be selected first. The system described in this manual is

called ITADDA16+ROBO. A standard setting for normal use is preset in all other menu

items depending on hardware selection. Since only the line input is hardware compatible

this must be selected for the AD/DA converter. After the first setup the port address

should be checked. MF looks for the $0530 setting on the plug-in. If the plug-in hardware

address is changed because of potential conflicts with other plug-ins by a jumper an

automatic search for potential addresses can be started by “?” in the Port address menu

item. A check appears behind the address if the search has been successful.

The menu items AD voltage range and DA voltage range control the measurement scale

according to hardware input sensitivity. The full drive value at minimum gain must be

entered only once. All other input and output sensitivity adjustments are made in AD and

DA full scale in the lower third of this window. A/D voltage range is 109.54V = +40dBu

for ITADDA16+ROBO. DA voltage range is 10.95V = +20dBu for ITADDA16+ROBO.

The Crystal CS4231 AD/DA converter provides sampling rates from 5.5 to 48kHz. The

anti-aliasing low pass filters necessary for the converter are included on the plug-in and

automatically adjust their cut-off frequency to the sampling rate. Note: no signals higher

than half the sampling rate must be fed to the A/D converter input or measuring faults

will occur. Standard sampling rates are 44.1kHz (CD player) and 48kHz (DAT).

Considering the filter stop bands for measurements cut-off frequencies are approximately

20kHz at 44.1kHz and 22kHz at 48kHz sampling rate. Sampling rate is selectable in the

menu item AD sample rate. Select the next value above the clock step which the

hardware permits.

The number of DA bits  for the Crystal CS 4231 is fixed at 16 bits and not adjustable. The

same applies to Clock & Trigger settings for external signals that are not supported by

the hardware.

Special attention must be paid to the lower third of the AD/DA basic settings

window which contains important setting facilities. Input channels left/right or stereo

mode are selected in AD inputs. Both D/A outputs are always operative. DA inv. R

channel inverts the right channel signal, e.g. to feed a power amp in bridged mode. AD

and DA fullscale  control the maximum input and output voltages at the balanced front-

end connectors. Note: the additional 20dB gain must not overdrive the monitor amps

when they are incorporating for measuring. To protect them from excessive input a DA
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fullscale setting of 0dBu is recommended. Clipping onset is at 20dBu. All values are in

dBu and V peak.

Measuring quality largely depends on correct A/D converter settings. A small bargraph

right below the graphs indicates the level in 10dB steps. The white bar turns pink at

clipping. Maximum input level is controlled in AD fullscale and should be set close to

within a few dB after estimating the actual input level. It is recommended to use the

autorange option. Excessive levels at the A/D inputs result in clipping, annoying pulse

response peaks and “ragged” frequency response curves (Figure 2). Insufficient levels

and signal-to-noise ratio may result in wide band interference or, e.g. due to AC hum,

interference in specific bands (Figure 3).

Note: when smoothing is selected interference may be covered up. However,

incorrigible faults will occur at further evaluation. Normally smoothing should be off

during measurements which should be saved without smoothing or other treatment to

maintain all information for future processing.
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2

Figure 2 Frequency response measurement with correct level
(below) and excessive level (above)

3

Figure 3 Frequency response measurement with insufficient level
(below)
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2.3 Processor and Memory

The Utility Processor/Memory menu indicates the identified processor type and

memory distribution for MF. MF runs on 386 processors and up. 386 and 486SX types

require a co-processor. Due to the optimized assembler routines of time-critical program

parts MF offers rapid processing even of complex signals, e.g. in the Crossover Module,

on 486/33 types already.

The lower bar in the processor/memory window indicates the complete processor RAM.

The memory occupied by MF and its data fields is shown in white. To fully use the

processor capabilities EMM drivers for DOS or Windows must not be loaded.
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2.4 Graphics and Printer

MF supports two basic possibilities to print measuring diagrams and to integrate them

into other documents. HP Laser Jet and HP Desk Jet printers with their own memory and

HPGL interpreter can be directly addressed from the program. Unfortunately this is

impossible with recent Windows printers such as HP Desk Jet 870. HP laser printers are

recommended. “Antique” HP compatible plotters may also be used.

A compact HPGL file may be generated for future processing by other programs and

integrated by a graphic converter. Word 6.0 and Corel Draw provide this facility. The

common PCX format may be utilized if HPGL files cannot be read in. PCX files may be

exported by Corel Draw after importing an HPGL file. The DOS program “printgl” offers

a faster solution. It is called by the file name without the HPGL file extension via the

batch file PLOT-PCX.BAT and expects the HGL extension. This is the basic MF setting.

To view the HPGL file on a monitor use the batch file PLOT-VGA.BAT.

Settings for HPGL graphic files are selected in the Plot Shop menu. The presets are for

one graphic per file standard color graphics. Printing on a printer or into a file is started by

striking P if a measurement is shown on the monitor. A menu window with a file name

suggestion pops up first. Only the detail of a graphic visible between the corsurs is

printed. To print a frequency response from 20Hz to 20kHz place the left cursor to 20Hz

by striking L, Alt B, P, Y, 20↵, and the right cursor to 20kHz by striking

R, Alt B, P, Y, 20k↵. The selected detail is shown by striking x, striking G

shows the complete frequency range again. Programming the sequence as macro greatly

simplifies this procedure. The macro programming is initiated and finalized by striking

Alt M.
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2.5 Data File Management

MF supports application by several users or from separate directories with separate

settings. The only prerequisite is that MF is in a directory in the PATH statement. MF

creates a pick file in any directory it has been called in which saves all program settings.

When MF is called again from this directory that file is loaded and all previous settings

are recalled. Thus separate settings from separate directories can be used without resetting

or saving. Additionally there are special setup files for macros and crossover menu

setting. Pick files can be loaded and saved by the PCK File Menu function in the

Utility menu, macros by Files in the Macro menu and crossover setups by

Crossover work... Setup file menu of the Edit menu. For every example in

chapter 8 you can find an associated PCK File.

Caution: After a software update the PCK file format can be changed.

There are additional setup files for macro programs and crossover menu settings. Pick

files can be loaded and saved in the Utility Menu under PCK File Menu... ,

macros in the Macro menu under Files and crossover set-ups in the Edit menu

under Crossover work... Setup file menu.

The MF measuring files are divided into time, frequency and polar files. Time files contain

samples for the D/A converter or samples from the A/D converter, e.g. noise sequence

required as test signal for measuring. Their extension is .DAT. When choosing a file from

the file menu or viewing a signal Ctrl U and Ctrl B select time or frequency domain. The

file menu only shows the files of  the selected domain. Change from frequency to time

domain by Ctrl Z to load a time signal. Frequency files contain complex frequency

spectra with magnitude and phase angle and real and imaginary parts respectively. Their

extension is .SPK. Polar files are in ASCII with the extension .POX. Note: polar

measurements with MF are precise and easy, results of a measuring series however
cannot be processed in their entirety. To process polar files call Windows and Excel 5.0

for graphic display. Excel can read in non-native format MF files and display them as

polar plots and isobar curves. Chapter 0 contains further information on polar

measurements.

All file management functions are in the File menu. Files can be surveyed, deleted,

renamed and comments can be read. File headers can be viewed and changed. To import

non-native measuring data an import and export filter for MLSSA FRQ files in frequency

mode and a user definable import filter are provided. In time mode MLSSA TIM files can
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be read and written. WAV and VOC files can be read and written for Windows

applications.

MF time and frequency files may contain several channels, e.g. a time signal recorded in

stereo requires two channels. Maximum channels are 31 numbered Ch0 thru Ch30. If a

multi-channel file is read in and saved via the file menu all channels are completely loaded

or saved including all samples or frequencies. The Read Block or Write Block

functions of the Edit menu permit reading a file partially or writing only parts into a file.

To maintain the complete results recent measurements should normally be saved via the

file menu. A short comment may be entered for future reference by striking K, the file

name is entered by the Alt D and S combination. File extensions are automatically

added by MF according to the signal type.

Files may be combined in several forms by the Write and Read functions of the Edit

menu. Depending on the Read Block menu setting a previous file is processed with a

new file loaded completely or partially. To compare two measurements select and load

the first file in the file menu and the second file in Read Block of the Edit menu.

Also selectable is if the second file is simply shown as a second channel or multiplied by,

divided by or otherwise linked to the source file. Select divided to show the divergence of

two measurements, e.g. a pair of loudspeakers. The source file value is divided by the new

file value and the result is shown. The important combining function is explained in

chapter 8.3.
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3 The MF Menus

3.1 File

Files containing time signals or frequency spectra may be read in, saved, deleted or

renamed in the File menu (Alt F). Only files corresponding with the file extension

setting are shown. *.DAT is preset for time and *.SPK for frequency files. Only  time or

frequency files are shown depending on the current domain. Striking Ctrl Z or

Ctrl B switches between time and frequency domain in the file menu. Scrolling thru

the file list on the right of the file window shows the comments on each file in the

comment line above.

File (Alt F)

Parameter Function

Path Current path

Mask File mask

Name File name

Load Load file

Save Save file

New Delete current window and open new window
Degree: FFT length within the frequency range
Length: number of samples for new time signal

Edit header .... View and edit file header

Rename Rename file

Delete Delete file

Make Dir Start new directory

Size Save file with 1/2/3/4 bytes per sample (time signal)
or 4/8 bytes per sample (frequency spectrum)
Attention: for export to MAXILS time signals
require 2 bytes/sample,
frequency spectra require 8 bytes/sample
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File (Alt F)

Format Memory format: ITA, MLSSA (FRQ or TIM),...

Remaining Allocatable space on current drive

Exit MF Exit the program

DOS command Change to DOS mode

Sort Criteria for sorting the file list: name/date/size,
up/down

Table 1 File menu functions

3.1.1 File Header

A 256 byte header is added to each time or frequency file if saved in the ITA format. The

header contains information on the number of samples, sampling rate, number of

channels, date, time and type of display selected when saving. It also includes the

comment line which can be edited before saving. Striking K while in the time or

frequency domain allows entering additional comments in the comment line to facilitate

future data processing.

/*****  ITA-Header für C-Programme   28.05.93   ***********************/

struct ITA_header

{

long Samplezahl;

double Samplingrate;

int Offset;

char Kanalzahl;

char Kanalliste[16];

double Voltagerange[16];

int Leftcursor;

int Rightcursor;

char len_ADDAident;

char ADDAident[20];

char len_Kommentar;

char Kommentar[71];

} header_in, header_out;

Figure 4 File header for time signals and frequency spectra in C
(definition for Maxils)
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The header structure is shown in its original Pascal language in Figure 5. Borland-C-

programmers must start the strings with a separate Längenbyte. ASCII zero suppression

is not dangerous but unnecessary. The compiler option "Word align data" must be off or

the header byte entries are stretched by a Füllbyte (this does not apply for  Borland

Pascal). To understand the header and to read in the following data Monkey Forest

requires only a few entries from Fremd programs. However Nicht gesetzte Einträge must

be initialized by 0, e.g. in advance by "fillchar (Header,sizeOf (Header),0)". The entries

which must subsequently be set correctly with a value > 0 are marked by "!" in the

following  header listing.

Time signals: The samples are saved as 16 or 32-bit integers in pair complementation.

When reading in there may be an offset which must be subtracted from the samples to

achieve pair complementation. The offset must be entered in the header. The samples of

individual channels alternate in multi-channel filesn the first channel is channel 0.

Example for a 3-channel signal:

Spektrum files: The spectral values are saved as 32 or 64 bit Floating pointzahlen with

real and imaginary phase angles. However these are filed in separate continuous blocks.

The real phase angle is the first block after the header. For multi-channel spectra the real

and imaginary phase angle blocks are written alternatingly in ascending channel number

order. Example for a 2-channel spectrum (not to scale):
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type LinksRechts = (links,rechts);

type LRLongInt = array [LinksRechts] of LongInt;

type Headertyp = record

{Offset}

{   0} SampleZahl : longint; {! Anzahl Samples pro Kanal}

{   4} SamplingRate : double; {! Abtastrate in Hz}

{ 12} Adoffset : word; {Zeitsignale : Integer-Offset der AW's}

{ 14} Kanalanzahl : byte; {1 : Mono, bis zu 31 sind erlaubt}

{ 15} KanalNr : byte; {aktueller Kanal, 0 bis Kanalanzahl - 1}

{ 16} alleBearb : boolean; {1 : Editieren wirkt auf alle Kanäle}

{ 17} Preemphasis : boolean; {1 : 50/15 µs Preemphasis}

{ 18} LiCursAktiv : boolean; {1 : Linker Cursor aktiv}

{ 19} CursorKreuz : boolean; {1 : Horizontale Cursorlinie erscheint}

{ 20} CursorLock : boolean; {1 : Cursor bewegen sich gemeinsam}

{ 21} Darstellung : MalTyp; {0 : Punkte,1 : Striche, 2 : Balken}

{ 22} Odarstellung : MalTyp; {wie �, aber nur für Ortskurve}

{ 23} Bewertung : char; {für Spektren : Bewertung als Buchstabe 'A'}

{ 24} HierEine0 : byte; {derzeit unbenutzt}

{ 25} NormMax0dB : boolean; {1 : Spektren und Leistung : 0dB = ¦Max¦}

{ 26} Yzoom : boolean; {1 : Y-Bereich auf Maximum normieren}

{ 27} Xlog : boolean; {1 : Spektren : Frequenz logarithmisch}

{ 28} Ylog : byte; {YLog-Bits 1,2,4,8}

{ 29} VersionsNr : byte; {früher 0, jetzt 95}

{ 30} FFTnorm : byte; {0: Leistung, 1: Energie, 2: Passband}

{ 31} VoltageRange : double; {! max. Spannung im Zeitsignal}

{ 39} Reserviert : array [0..59] of byte; {mit Nullen füllen}

{ 91} Hun : byte; {Hundertstel}

{ 92} Sec : byte;

{ 93} Min : byte;

{ 94} Hour : byte; {Entstehungszeit des Signals}

{ 95} Day : byte;

{ 96} Month : byte;

{ 97} Year : word; {Entstehungsdatum des Signals}

{ 99} Start : longInt; {(Nr-1) des ersten Wertes in Datei}

{103} XachsSchrift : string [3]; {Einheit an der X-Achse}

{107} YachsSchrift : string [3]; {Einheit an der Y-Achse}

{111} Rand : LRlongInt; {dargestellter X-Bereich}

{119} Cursor : LRlongInt; {Position der Cursorlinien}

{127} Grundlaufzeit : double; { [s] }

{135} d : dBBlock;

{bestehend aus folgenden 3 Werten :

{135} OberkantdB : double;       dB an der Oberkante

{143} Dynamik : double;       Oberkante [db] - Unterkante [dB]

{151} VoltBei0dB : double;       Bezugsspannung für 0 dB}

{159} LeftCursOld : word; {alt, für Signale bis Länge 65535}

{161} RightCursOld : word; {alt, für Signale bis Länge 65535}

{163} ADDAident : String [20]; {Quantisierung als ASCII-String}

{184} Kommentar : String [71]; {Beliebiges Blabla}

Figure 5 File header for time signals and frequency spectra in Pascal
(definition for MF compatible to Maxils)



MF Audio Measuring System: The MF Menus                                                               28/277

                                                                                                                                                       

© by Audio & Acoustics Consulting Aachen V 3.2E printed 12.12.99 11:02

/*****  ITA-Polheader für C-Programme  ***********************/

struct ITA_Polheader

{

int Startwinkel ;

int AnzahlSchritte ;

int Schrittweite ;

char len_Richtung ;

char Richtung[80] ;

double Abtastrate ;

double Startfrequenz ;

int AnzahlFrequenzen ;

double Frequenzfaktor ;

double Fensterbreitenfaktor ;

double Normwert ;

double dBWert ;

double ObereGrenzfrequenz ;

char len_Kommentar ;

char Kommentar[110] ;

} Polheader_in, Polheader_out;

Figure 6 File header for polar plots in C for Maxils
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3.2 Domain

Time or frequency domain are selectable in the Domain menu (Alt O). Selection affects

display only. All time signals and spectra remain in memory. After measuring time signal

samples are in Time signal, the pulse response calculated from the time signal is in

Impulse response. If a frequency spectrum has been calculated from the pulse

response via FFT magnitude and phase angle values are in their own respective menu

entries.

Domain (Alt O)

Time Domain Function

Time signal Ctrl T Display time signal (read in from a file or after
measuring)

Impulse response Ctrl U Imulse response calculated from a time signal

Power Ctrl E Display of time signal energy

Int. impulse

response

Ctrl N Integrated imulse response for reverberation
time calculations

Probability Ctrl Y Time signal distribution
This function shows the number of samples in a
specific amplitude range

Distribution Ctrl D Time signal distribution density
This function shows the number of samples
below or at a specific amplitude

Frequency domain Function

Magnitude Ctrl M Display frequency spectrum (response curve)

Real Ctrl R Real part of a frequency spectrum

Imaginary Ctrl I Imaginary part of a frequency spectrum

Phase Ctrl P Phase response of a frequency spectrum

(phase-frequency characteristics)
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Domain (Alt O)

Group delay Ctrl L Group delay of a frequency spectrum

Nyquist Plot Ctrl O Nyquist plot

Table 2 Domain menu functions
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3.3 Display

Display settings and type such as cursor position, enlarged detail or scaling are controlled

in the display menu (Alt Y). Other functions facilitate finding specific time or

frequency values, e.g. maximum values.

Display (Alt Y)

Menu item Function

All channels visible A Display all channels or active channel only

Display range .... D Scaling of y-axis

Edit comment .... K Enter comment in comment line

Jmp to Max of all channels M Position active cursor on maximum value of
all channels

Make left cursor active L Activate left cursor (yellow)

Make right cursor active R Activate right cursor (yellow)

Toggle active cursor ≡ Switch active cursor

Surrounding at cursor U Display surrounding of active cursor

Set window region W Set a window in time domain; active and
passive cursor determine window outset
and end

Zap drawing mode Z Switch between curve, node and line
display

+ Zoom in + Enlarge display surrounding the active
cursor

- Zoom out - Scale down display surrounding the active
cursor

= pull cursors together = Position passive and active cursors
identically



MF Audio Measuring System: The MF Menus                                                               32/277

                                                                                                                                                       

© by Audio & Acoustics Consulting Aachen V 3.2E printed 12.12.99 11:02

Display (Alt Y)

Expand cursors to 2n TAB Set number of samples between cursors to
next higher 2n value

Reduce cursors to 2n ↑ TAB Set number of samples to next lower 2n

value

Center arround cursor ↑ C Center display around active cursor

Cursor distance .... ↑ D Set a fixed distance between cursors

Find nice colors .... ↑ F Set display colors (setup 2 provides better
results with DSTN displays)

Entire, cursor ←→ ↑ E Position cursor on both ends of a signal and
display all

Set mark .... ↑ K Set mark

Jmp to impulse start ↑ I Position active cursor one sample before
maximum time signal level

Jmp to threshold .... ↑ T Position active cursor on a preset time
signal threshold

Jmp to max active channel ↑ M Position active cursor on maximum level of
the active channel time signal

Jmp to zero transit ↑ Z Position active cursor on time signal zero
transit

Cursor position .... ↑ P Position active cursor by entering samples,
or directly by time or frequency values

Jmp to mark .... ↑ Q Position active cursor on a mark

Table 3 Display menu functions and entry windows
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3.4 Edit

The Edit menu (Alt E) provides a multitude of possibilities to process time signals and

frequency spectra. It includes the block function for reading in additional channels and

linking new signals to existing files. Single channels of a measurement file can be linked

and processed by the channel work function. In the frequency domain it contains the

crossover module option to calculate FIR filters for crossovers and loudspeaker

equalization, see chapter 10 for further explanation. The second column of the table lists

the domain where edit functions are operative.

T = Time Domain

F = Frequency Domain

Edit (Alt E)

Menu item Domain Function

Add .... T  F Adds a complex constant

Crossover work .... F FIR filter calculation for crossovers and
loudspeaker equalization, see also
„Crossover Works“

Create bandpass .... T Generates the impulse response of a custom
bandpass

Remove DC T Calculates and subtracts the time signal DC
offset

Delete T  F Deletes the area between the cursors

Extend T Extends a time signal to a desired number
of samples

Fade T Fades a time signal in and out

Generate T Generates test signals in time domain, e.g.
sine, square, noise, sweep etc.

Insert .... T  F Inserts a desired number of samples into a
time signal or frequency spectrum
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Edit (Alt E)

J-Filter .... T  F Generates any variety of filter functions in
time and frequency domain, see also
„Crossover Works“

Channel work .... T  F Links single channel signals of a file

Group Delay .... F Processes the frequency-dependent delay of
a spectrum

Multiply .... T  F Multiplies a time signal or spectrum by a
constant (in frequency domain also by
complex values)

Negate T  F Changes sign +/-

Overwrite .... T  F Overwrites the active domain with a
constant

Phase .... F Processes the phase response of a spectrum

Apply Window .... T Applies a window function to a time signal

Read Block .... T  F Reads in another file as block. The new file
can be displayed as another channel or
linked to existing files

Smooth .... F Smoothes a frequency spectrum

Time invert T Inverts the time of a signal

Invert F Inverts phase and magnitude of a frequency
spectrum

Cyclic move T Shifts a time signal in cycles

Write Block .... T  F Writes the samples between cursors as
block in a desired format (also ASCII)

Extract T  F Generates a new time signal from values
extracted between cursors

Byte/Sample T Switches from 2 to 4 bytes per sample
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Edit (Alt E)

Sample rate conversion T Converts the sampling rate of a time signal
including low pass filtering

Clip T Removes all values above a threshold (hard
clipping)

Differentiate T Differentiates a time signal

Envelope T Generates the envelope

Reduce to full periods T Reduces a periodic time signal to an integral
number of periods. Remaining values are
overwritten by 0.

Integrate T Integrates a time signal

Up/Down Sampling T Converts the sampling rate of a time signal
including low pass filtering to an integral
multiple or fraction of the original sampling
rate

Compress T Compresses a time signal like an intelligent
limiter

Interpolate T Linearly interpolates between the samples at
cursor positions

Normalize T  F Normalizes a time signal or frequency
spectrum to a selected value

Raise to the power T samples(Power)

Retains sign of samples

Repeat block T Adds the active part of a time signal at
active cursor position

Rectify T Rectifies a time signal

Smoothe T Smoothes a time signal by averaging a
selected number of samples

A (un)weighting F Multiplies a frequency spectrum A-
weighted or reverses multiplication
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Edit (Alt E)

Uncle Hilbert .... F Calculates a minimum phase for a selected
amplitude response by Hilbert
transformation

Mirror F Mirrors a frequency spectrum at the active
cursor

Slope .... F Adds a desired slope to a frequency file

Stretch/squeeze .... F Expands or compresses the response of a
frequency spectrum

Table 4 Edit menu functions and entry windows

All functions in the table above apply to the active section of a time signal or frequency

spectrum between cursors. If the functions process all channels or the currently active

channel only is selectable in their respective entry windows. Attention: sometimes there

is no possibility to cancel signal processing !!  Save signals and spectra first when in

doubt.
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3.5 Info

The Info menu (Alt I) contains information on acoustic parameters, signal statistics,

spectrum statistics and distortion characteristics relative to a fundamental of time signals

and frequency spectra. If the impedance of a loudspeaker has been measured both with

and without a defined auxiliary load the two measuring files may be used to calculate the

loudspeaker’s Thiele-Small parameter. Chapter 8.10 contains further information.

Info (Alt I)

Time signals Function

Room acoustics Impulse
response

Acoustic parameters of an impulse response
measured in a room

IACC Impulse
responses

Inter-aural cross-correlation coefficient from two
impulse responses for right and left ear

Signal statistics Time
signal

Statistic parameters of a time signal

Decay Times Integrated
impulse
response

Decay times calculated from the integrated
impulse response

Frequency spectra

Distortions Distortion from k2 to k10 in a spectrum with a
selected fundamental
place active cursor on fundamental

Spectral statistics Statistic parameters of a frequency spectrum

Loudspeaker param. Thiele-Small parameter
Two impedance measurements necessary
(with and without auxiliary load)

Table 5 Info menu functions and entry windows
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3.6 Transformations

The transformations menu (Alt T) contains a variety of mathematical

transformations and the setting of a standard flow for processing time signal samples.

Settings do not refer to measuring in the AD/DA menu.

Attention: flow should only be altered when familiar with processing or serious
display and interpretation faults may occur.

Processing steps from time signal sample to frequency spectrum display can be set in the

signal processing menu window.

Trans (Alt T)

Time domain Function

Processing Transformation flow for measuring:
- Hadamard transformation
- windowing
- Fourier transformation
- display

I

FFT F Fourier transformation of a time signal into the
frequency range by 2n values

Sliced FFT Generates up to 32 decay spectra displayed in
channels 0..31. The time window can be set in
the Sliced FFT  window

FHT H Hadamard transformation of a time signal by
2n-1 values

IFHT I Inverse Hadamard transformation of a time
signal by 2n-1 values

ACF Autocorrelation function of a time signal

CCF Crosscorrelation function of two time signals in
separate channels of a file

Frequency domain
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Trans (Alt T)

Processing Inverse Fourier transformation flow I

IFFT I Inverse Fourier transformation of a 2n value
frequency spectrum into a 2n value time signal

Table 6 Trans menu functions and entry windows

Signal Processing (Alt T, P)

Menu item Function

2n-1 method 2n-1 values can be changed to 2n values by
sample rate conversion (SRT). Alternatively the
last value of a Hadamard transformation can be
added to result in 2n values.

When measuring with 2n-1 maximum length
sequences (MLS) FHT calculates the impulse
response of the measured system.
Necessary before  FFT!

I

Sampling Rate

Conversion

Sample rate conversion to provide 2n time signal
values for FFT

FHT

Interleave Interleaved sampling for MLS measurements
with x-times pulse rate, also allows measuring
with x-times cut-off frequency.
External MLS generator required.

Group delay comp. Impulse response delay compensation after FHT

Windowing

Window Impulse response windowing after FHT

FFT

FFT Normalizing Frequency response normalizing after FFT

- power (depending on FFT length)
- energy (independent of FFT length)
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Signal Processing (Alt T, P)

- passband to determine effective filter gain
  (e.g. in filter files for HUGO XFIR?.DAT)

Spectral processing

Equalizing Frequency response compensation after FFT by
a file, A curve, sinc(x) or filter (setting in J-
Filter)

Channel combine Multiple channels can be linked in the frequency
domain after FFT

Smooth Smoothes frequency response

Display

Source of data Frequency response display depending on the
following parameter settings or as determined
by a signal file

Dynamic range Dynamic range (typically 50/75/100dB)

On top Value at upper graph edge

Ref. for 0 dB 0dB reference value, e.g. 1V or 20µPa

dB reference 0dB reference as set above or maximum
response

Y scaling Linear or logarithmic Y-axis scaling

Table 7 Signal processing settings menu Trans (Alt T, P)
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Sliced FFT (Alt T, S)

Slices Number of slices by which the selected time
window is moved across a selected impulse
response
(maximum 31)

FFT Degree FFT degree for the time window (must be
smaller than the impulse response degree)

Start Detect Automatic search for the impulse response start

Windowing

Window Size Window size in % of FFT length,
e.g. 50% at FFT degree 13 = 0.5 x 213 = 4096

Overlap Overlaps two time windows following each
other

Slice Step The resulting slice step between two time
windows in ms

$

Window ....

Window type Window type

Slope Window left, right or center

Mode Normal or inverted

Range Adjust all or detail

Tukey Passband (window value = 1)

Zero DC Subtract DC

Table 8 Signal processing settings menu Sliced (Alt T, S)
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3.7 AD/DA

The AD/DA menu contains all functions to start a measurement and to feed the A/D and

D/A converters. It also includes Basic settings for hardware setup. Sound velocity

and microphone sensitivity are set in Miscellaneous.

AD/DA (Alt A)

Basic settings T  F Hardware setup, port addresses, channel
selection, sensitivity

Miscellaneous T  F Sound velocity (340m/s preset)
Microphone sensitivity

Hear my cry (DA) T ↑ H Time signal output from a file via the D/A
converters

AD only T  F A/D operation only to sample signals, e.g. to
measure output noise level of equipment

AD & DA simultanously T  F Simultaneous A/D and D/A operation, e.g.
D/A signal from a file to measure power
amplifiers with sine bursts

Recorder T ↑ O ---

Micro calibration T Piston microphone calibration

THD+N single f F THD measuring at frequencies up to k10

THD+N (f) F Frequency-dependent THD measuring

LS max SPL F Maximum loudspeaker SPL measuring with a
pre-determined THD limit

LS Sensitivity T  F Loudspeaker frequency response measuring
including sensitivity

Frequency response T  F General frequency response measuring

Polar Response F Polar plot measuring and triggering of
turntables – attention: no display of the
complete result !
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AD/DA (Alt A)

Laser Vibrometer F ---

Impedance F Impedance measuring

SPL F Sound pressure level measuring

Table 9 AD/DA menu functions and entry windows (Alt A)
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3.8 DSP

This menu is currently inoperative because of dated hardware.
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3.9 Plot

The Plot menu provides configuration and starting of direct printout or output into a

graphic file. Only the section active between cursors is printed.

The Plot Shop menu item includes all standard presets for one graphic per file or

printout. Printout is started in Plot or by striking P. For further processing by other

programs output into an HPGL file is recommended.
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3.10 Macro

All MF functions can easily be custom programmed as macros. Macro recording is

initialized and finalized by ALT M. After macro recording press the desired function key

to recall the macro. Macros can be saved  and processed in their own files (*.TM).

Macro (Alt R)

Start recorder ALT M Initializes and ends macro recording
 – select function key subsequently

Delete all Deletes all macros

Edit Edits macros

Files Saves, loads and deletes macros....

Table 10 Macro menu functions and entry windows (Alt R)
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3.11 Utility

The Utility menu contains settings for graphic resolution, keyboard velocity and

mouse sensitivity. Memory and CPU values can be read additionally.

Utility (Alt U)

PCK File Menu Pick file management

More files Standard name for pick file
Autosave for pick file
Autoview of file header in the file menu

Dialogue manners Silent messages, seriousness level

Graphics 640 x 350 to 1024 x 768 resolution

Keyboard & mouse Keyboard  velocity and mouse sensitivity

Memory & CPU Memory distribution and processor type - control
function only, no settings possible

Computation times Recent FFT or FHT duration - control function only, no
settings possible

Delay Delay time between two measurements

Sound Audio file output

Notification Text output

RS232 cmd RS 232 configuration and output

Table 11 Utility menu functions and entry windows
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3.12 Help

The MFINFO.DOC file contains a detailed help text delineating the principles of signal

processing that can be revised with any basic text editor. Sorry, this text is available in

German only.
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4 Measuring Preparations

4.1 I/O level

The bargraph level indicator below right on the screen should be used to set the level

correctly which is a prerequisite for precise measuring results. At the beginning of the

signal chain is a test signal sent by the D/A converter via the front-end. The maximum

output level is set in the AD/DA Basic Settings menu and DA fullscale. At the

start of a measurement the level cannot be set higher than the fullscale value in the

measuring menu. Attenuation is possible anytime by internal scaling of the output signal.

The value is indicated in dB relative to fullscale and in dBu in all menus at the start of a

measurement. Always select the best possible level for the test object connected to the

front-end. To measure an equalizer with line level inputs and outputs 0dBu is appropriate.

Reduce the level to avoid clipping if the test object provides ample gain, e.g. microphone

preamps or power amps. Remember the monitor amp adds 20dB gain to the front-end

when measuring loudspeakers.

Considering the front-end input sensitivity estimate the expected level and set the

fullscale input value within a few dB tolerance. Measuring microphones provide the

lowest levels (-40 to –20dBu) while power amplifiers may provide very high levels (20 to

40dBu). The front-end full scale settings range from -40 to +40dBu to cover most

applications. The test signal output level should be set at 0dBu when measuring an

equalizer for instance. Depending on the EQ setting the equalizer output level may vary

from +12 to +20dBu. The system inputs should therefore be set at +20dBu.

Sensitivity must also be set for calibration. No test objects or external connections are

required. Inputs and outputs of the measuring system are connected, calibration is

software controlled via front-end relays and indicated by a red LED. The output level for

further measuring should also be set during calibration. It will be fed to the measuring

system input for calibration so the input fullscale value must be set accordingly. No reset

is necessary if input and output of the following measurement are line level fed. For

loudspeaker measuring with varying input and output levels a reset is mandatory. For

instance:

A loudspeaker is connected to the front-end monitor amp output, the measuring

microphone to the input. The test signal level is set at -10dBu. A +10dBu test signal is fed

to the loudspeaker because of 20dB monitor amp gain. The measuring microphone

sensitivity is low (-40dB relative to 1V/Pa). The microphone input must be set for high

gain, i.e. a small fullscale value (e.g. -20dBu). If this setting was used for calibration the
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monitor amp signal clipping the input would lead to inaccurate results since the monitor

output is fed to the system input with 20dB attenuation only. Therefore the fullscale input

level must be increased to 0dBu to prevent clipping by the +10dBu-20dB monitor signal.

After calibration the input level must be reset. Otherwise results may be misleading since

the small microphone signal will be lost in the residual noise of the measuring system.

The autorange function is recommended for the normal measurement and for the

reference measurement.
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4.2 Test Signals

MF generates nearly any type of test signal. Maximum length sequences are

recommended for frequency response measuring. They are preset in all menus. Sweep

signals may be more convenient in critical conditions regarding time invariance, e.g. when

measuring loudspeakers outdoors. See chapter 8.15 and chapter 7.

Sine signals are used for distortion measuring since they permit easy evaluation.

Limitations arise from the inherent distortion of the D/A converter when measuring

nonlinear response. The measuring limit of approx -90dB is uncritical for loudspeaker

measuring. Chapter 8.9 on measuring maximum loudspeaker levels contains further

information.

4.2.1 Maximum Length Sequences

Maximum length sequences are random sequences with N=2n-1 values that are simply

generated by a shift register or by software. Energy density is equal in all frequencies.

Because of even energy distribution throughout the length of a sequence they provide a

good signal-to-noise ratio and do not require high levels. Also, they permit easy

processing by the fast Hadamard transformation algorithm.

For measuring a maximum length sequence is generated by the PC and fed to the test

object input via a D/A converter. The test object output is fed to an A/D converter for PC

processing. The test object impulse response is calculated by a Hadamard transformation.

Response including phase and magnitude throughout the frequency range is calculated

by a Fourier transformation. The measurable frequency range is approx. 0Hz to half the

sampling rate which can be selected from 5.5kHz to 48kHz. The maximum impulse

response length is calculated from the sampling frequency fs and the sequence length N

by N/fs. The frequency response resolution is calculated from the inverse fs/N. The

sequence is characterized by n degree. A typical audio measuring setting is a sequence of

15° with a 44.1kHz sampling rate which results in a resolution of 44100Hz/215  = 1.34Hz.

Increase the sequence length or reduce the sampling rate for higher resolution. Lower

sampling rates are hardly necessary since processing time is tolerable even for very long

sequences.

The even energy distribution of maximum length sequences is advantageous when

measuring mixing consoles, power amps, equalizers etc. but detrimental for measuring

loudspeakers. Results may be distorted by interfering low frequency signals, e.g. wind

noise, calling for better signal-to-noise ratio by higher low frequency levels. A wide band
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level increase would put a strain on midrange and high frequency drivers. By far the

largest portion of the test signal energy is used for the high frequency range, e.g. 90% at a

2 kHz crossover frequency. Frequency weighted sequences with  higher low frequency

energy parts provide a solution. Sequences with custom energy distribution can be

generated. Also, files of optimized sequences are available for the S. Müller method of

loudspeaker measuring. These can be selected as test signal in all menus for starting a

measurement in exciter origin by the file function and the appropriate file name.

Preprogrammed peanut sequences (see Figure 7) for degrees 9 to 16 are included with

MF. A better signal-to-noise ratio in the low frequency range results from exciting that

range more than by conventional maximum length sequences. Weighted sequences,

however, are not useful for measuring midrange and high frequency systems exclusively.

Select the internal sequences by exciter origin intern for that purpose.
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4

Figure 7 Frequency weighting of a peanut sequence

The test signal frequency response is incorporated by calibration and automatically

compensated while measuring. Chapter 4.4 contains further information.
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4.3 Sweep Signals

See also chapter 8.15.
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4.4 Calibration

All MF frequency response measurements can be compensated by an initial calibration.

The test object is bridged automatically by the hardware when calling calibration. It

includes all measuring steps except the test object. All frequency response variations

caused by weighted sequences, filter, A/D and D/A converters, preamps and power amps

are incorporated. After calibration all further measurements are compensated by the

reference file. To test calibration connect the measuring system inputs and outputs. If the

frequency response displayed is not absolutely linear input levels may be excessive or

highly insufficient. The impulse response calculated from calibration contains all faults

since the reference file compensates in the frequency domain. Setting postcomp for

impulse response in the measuring menu calculates the test object pulse answer again by

an inverse Fourier transformation after frequency compensation to provide the true pulse

answer. This setting is recommended to prevent faults when evaluating the impulse

response in the time domain. Processing by the additional transformation takes only a tad

longer.
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4.5 Display

Measuring results can be displayed in time and frequency domain. Different processing

steps are selectable in the Domain menu while measuring. The most important displays

are impulse response in the time domain, frequency and phase response and group delay

in the frequency domain. All information is available after measuring and the display is

selectable. Ctrl Z selects the impulse response while viewing the frequency response of

a loudspeaker to check reflections or other interference for instance. The switching key

combinations are listed after the settings in the Domain menu.

The complete measurement or any section of a frequency or impulse response can be

displayed on the monitor. Shift E selects the full display anytime. Two cursors are

automatically placed at both ends. Position the cursors on the desired ends for detail

display. The x key switches to the detail display. Cursors can be positioned by the cursor

keys, mouse or the Display Cursor Position menu. The active cursors (yellow)

are selected by striking the L key for the left and the R key for the right cursor. The x and

y axis values valid for the active cursor can be viewed below the graph. All operations

influencing the measuring results that are selectable in the edit menu only refer to the

active range between the cursors. To boost a complete frequency response by 3dB

position the cursor at both ends of the curve by Shift E and select the Multiply

function in the Edit menu. The same applies to multi-channel displays and files where

all edit menu functions affect the active channel only. To process all channels select all

channels in the selection window. Single channels are activated by their respective

number key. Numbering starts at channel 0.
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Below the display there are several switching key combinations.

Function Key Meaning

y-Norm Y Normalize display to largest active domain value

x-Zoom X Display active section between cursors only

entire ↑↑  E Display all values/samples

cursorlock O Lock cursors on a selected distance

all channels lines a All channels viewable

crosshair c Crosshair cursor instead of line cursor

Y-Log ↑↑  Y Logarithmic Y-axis display

X-Log ↑↑  X Logarithmic X-axis display

Table 12 Scaling function for display and printout
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5 Measuring Microphones and Amplifiers

Selecting a measuring microphone, preamplifier and power amplifier to feed loudspeakers

for measuring is basically unproblematic as long as they do not generate nonlinear

distortion, e.g. a power amplifier or microphone preamplifier should never be driven into

clipping when measuring. For convenience use the integrated front-end components.

Almost any 48V phantom powered microphone can be connected to the front-end input,

sensitivity can be adjusted within a wide range. Higher powered microphones (e.g. B&K

4165, 200V) requiring their own preamp are the exception. Their preamp gain must be

entered in Preamplifier Gain for proper sound pressure levels. Microphone sensitivity

must be entered under Miscellaneous in the AD/DA menu in mV/Pa. Values are

usually listed in the microphone specification sheet. If a  piston microphone with a

defined SPL is available sensitivity including preamp divergence can be recorded under

Mic Calibration in the AD/DA menu in the time domain.

Only a few very expensive microphones provide linear response from 20Hz to 20kHz.

Reasonable, basic models can be used for precise measuring after comparison with a

reference microphone and the recording of their frequency response divergence in a

compensation file. Similar to calibration this file is used to correct the measuring result.

Compensation is automatic if activated in the loudspeaker reference measuring window

and a compensation file name is entered.

Some measurements require an external power amplifier. The monitor amplifier power is

insufficient only to determine the maximum SPL of a loudspeaker. Enter the external

amplifier gain under Amplifier Gain in the AD/DA LS max SPL menu. Connect the

external amplifier to the front-end line outputs. It must also be included in the calibration.

Use an appropriate adapter to connect the external amplifier loudspeaker outputs to the

front-end inputs. Select external reference in the calibration window. Select internal

reference only if the monitor amplifier is connected to the measuring inputs.
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6 Measuring Loudspeakers

Engineers and users argue which measuring techniques and benchmark figures are

practical to describe a loudspeaker and and its sound characteristics. Some claim

loudspeaker qualities are not measurable and must be experienced by listening while

others maintain this or that measuring method is most important. Opinions on the step

response for instance differ widely. One faction knows nearly everything about a

loudspeaker from the step response,  for the other it is irrelevant as measuring evidence.

The following chapters explain practicable loudspeaker measurements and various special

features. The measuring series described therein includes linear response, distortion

characteristics (nonlinear response) and dispersion characteristics.
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6.1 Complex frequency response

The frequency response curve (Figure 8/left) is the most common measuring curve of a

loudspeaker. It is measured on axis and should contain the sensitivity value relative to 1m

distance and a terminal voltage equivalent to 1W at the nominal loudspeaker impedance.

Conclusions on sound characteristics and tuning can be drawn from the upper and lower

loudspeaker cut-off frequencies and the deviation from a desired response. Additionally

measuring conditions should be stated, e.g. if a time window was applied to the impulse

response to avoid interference by reflections, or if the response was smoothed. 1/6 octave

has proved practical and aurally compensating to smoothe response curves..

Decay spectra (figure 8/right) permit assessing the causes of ripple. Enclosure resonance

or cone break-up can be seen from the decay shown here. Dips and peaks often result

from long or late mechanical or acoustic resonances. Their effect on sound may be more

serious than might be guessed from the frequency response. Extreme caution is necessary

if the frequency response is to be corrected by electric pre-filters and levels are increased

at resonances  resulting in sound deterioration. The resonant frequency of approximately

600 Hz in Figure 8 shows as dip in the frequency curve and as resonynce in the decay

spectrum.

A peculiarity must be mentioned here. Common 3“ or 4“ high frequency PA drivers

often generate delicately structured ripple of 5-10dB because of unavoidable cone break-

up at high frequencies resulting in cone resonances. Adverse effects of such an obviously

non-linear frequency response however could not be noticed if the resonances occured

above 8 kHz. High resolution digital filters may be used for equalization. However, this

has proved rather problematic since no sound improvement could be achieved. The high

frequency decay of the loudspeaker shown in Figure 8 is excellent. The ribbon transducer

used in this example has the advantage of no cone break-up because of its even energy

distribution.
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5

Figure 8 Loudspeaker frequency response (l) and decay (r)

6

Figure 9 Loudspeaker phase response (l) and group delay (r)

The complex frequency response includes phase response besides the amplitude

response. A single chassis can mainly be interpreted as a minimum phase system which

does not apply to multi-way systems. The phase response of the two-way sample

loudspeaker  in Figure 9/left shows a phase shift of 2x 360° equivalent to the minimum

phase angle of a corresponding 4th order high pass filter in the lower frequency range for

the bass reflex system. Seen individually the high frequency way is a 2nd order high pass

with a 180° phase shift. Another 360° phase shift result in conjunction with the 2nd order

crossover. The second curve in Figure 9/left corresponds to the idealized 4th and 2nd high

pass filters for the low and high frequency drivers and the 2nd order crossover. Deviation

from the minimum phase angle and severe phase shift point to differing delays of the

individual ways in the crossover frequency band. Depending on driver arrangement these

may also result from the measuring position. Differentiating the phase angle  from the

frequency results in the group delay shown in Figure 9/right. The  low frequency delay

increase results from the woofer that has the effect of a 4th order high pass filter in a bass

reflex enclosure tuned to 36Hz. von 36 Hz ergibt. This increase is more pronounced at

higher filter orders, e.g. electric 6th or 8th order Butterworth prefilters. Sealed enclosures

are equivalent to a 2nd order high pass function only. Their group delay of 7ms at a cut-off

frequency of 36Hz compares favorably to 18ms of a 4th order and 28ms of a 6th order
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tuning. The occasional 8th order  increases group delay to no less than 42 ms! Delays that

long leave the impression of a “dragging“ bass that does not match the music. A DSP

system  can easily compensate the delay and phase response of a loudspeaker by a digital

FIR filter or emulate loudspeaker response. Listening tests with different filters simulating

the delay of various filter types for tuning woofers have shown a preference for those

types with the lowest delay increase at low frequencies. Accordingly, loudspeakers with

low frequency delay compensation by a FIR filter scored highly. The inevitable

disadvantage of this practice are delays of 20-50ms that are unacceptable for most studio

and stage applications.
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6.2 Time Response

Phase and frequency response must be examined in conjunction with time response.

While phase and frequency amplitudes are shown along the frequency axis a step

response curve shows the sound pressure level resulting from a voltage jump along the

time axis. The same applies to the impulse response where loudspeaker response to a

very short voltage impulse is measured. Each of the curves, i.e. complex frequency

response including phase response, impulse and step response contains identical

information on the measured system and can be transformed into the others without loss.

The impulse response is mathematically calculated from the complex frequency response

by an inverse Fourier transformation while the step response is calculated from the

impulse response by a time integration. Conversely the impulse response is calculated

from the step response by differentiating, and the complex frequency response is

calculated from the impulse response by a Fourier transformation.

7

Figure 10 Impulse (l) and step response (r) of the three
loudspeakers

8

Figure 11 Frequency (l) and phase response (r) of the three
loudspeakers

A two-way loudspeaker and two constructions are used for explanation. Phase and

frequency response and the accompanying impulse and step responses of the two-way
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loudspeaker are shown as the center curves in Figure 10 and Figure 11. The response of

an artificial construction is shown on top in Figure 10 and 11. It has the frequency

response of the original, the phase response is that of an ideal loudspeaker with 50 Hz and

20 kHz high and low pass cut-off frequencies. Another construction (lower curves in

Figure 10 and Figure 11) adopts the phase response of the original resulting in an ideal

frequency response, again with 50 Hz and 20 kHz high and low pass cut-off frequencies.

These examples illustrate how phase and frequency response influence the loudspeaker

time response. While the original and the ideal frequency response construction time

signal curves in Figure 10 hardly differ the ideal phase response construction curves show

almost perfect impulse and step reproduction.

The phase response of the original loudspeaker more or less leads to partial divergence of

different frequency bands. Also, the transient response of the low and high frequency

drivers is clearly different. This result is hardly surprising since it only reflects basic signal

theory.

At this point two contradictory psycho acoustic statements are interesting. One argument

is that human hearing has only minor capabilities of phase hearing. Therefore differences

between the ideal phase/time response construction and the original should be hardly

audible. However, the same faction  attaches great audio-physiological importance to

frequency response – a deviation of less than 1 dB should be clearly dsitinguished. The

other faction arguments that loudspeaker phase and time response are more influential on

aural perception.

It is easy to simulate the three loudspeakers above with a very high resolution FIR filter

for a simple experiment. Listening tests with various program material were taken using

three appropriate filters to replicate the frequency, phase and time response curves of

Figure 10 und Figure 11. Electret headphones were used for monitoring since

loudspeakers would have affected response preventing correct evaluation. No difference

could be noticed between the original and the optimized phase response type. However, if

the frequency response was compensated and the phase remained unchanged slight

differences were noticed. It must be mentioned again that the basic frequency response

with 2nd order 50 Hz high pass and 20 kHz low pass filters was maintained to prevent

irritationen by an extended range, especially in the low frequencies.

As result of these listening tests it can be stated that phase/time response compensation

has audible advantages only if  extreme delays can be compensated as in the low

frequency systems with high order high pass tuning previously mentioned. The same

applies to delays resulting from filters with slopes higher than 48 dB/oct. The audibility of
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delay and phase response of “normal“ systems (i.e. no “pathological design“) is

uncritical.
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6.3 THD

The THD specification of a loudspeaker is one of the most important specifications to

select its proper applications. Unfortunately many manufacturers still specify a maximum

level only that is of little validity and does not refer to a frequency band. A response curve

across the entire frequency range showing THD at a constant input voltage or the

maximum level at a fixed limit is more expressive. Both curves can easily be recorded by

PC aided measuring systems. Sine bursts can be used as test signal that are examined for

distortion by an FFT analysis after reproduction by a loudspeaker. The sample curves in

Figure 12 were measured with 180 ms bursts and a 4K FFT for analysis. This measuring

method is occasionally problematic when assessing the maximum level since most high

frequency studio and sound reinforcement drivers are thermally protected and the level is

considerably reduced when protection sets in. Indeed, although conservatively set limiters

respond to drastic overload only by normal program material they must respond to sine

bursts of above length. In these cases the measuring period and FFT length can be

shortened for the high frequency range only without  lowering resolution too much.

Reflections which may lead to significantly inaccurate results by interference are a further

problem of this measuring method. When measuring with sinus signals of fixed

frequency intervals (typically 1/6-1/12 octave) the averaging of several values is not

recommended. Therefore a completely anechoic environment is absolutely necessary.

Figure 12/left shows problematic frequencies at 65 Hz and 85 Hz caused by reflecting

measuring room walls below 100 Hz. These problem areas can be reduced within certain

limits by a second measuring series from a shorter distance. Both series can be combined

later on with the greater distance measurement serving as reference level.

THD at a constant input voltage as shown in Figure 12/right has proved a valid criterion

for studio monitors. Depending on listening distance and level THD and harmonic

distortions k2 and k3 can be clearly seen. For sound reinforcement systems a fixed THD

limit is preferable. 1%, 3% and 10% THD limits are well-tried and reliable. The 1% curve

is not too practically oriented but permits quick detection of potential weak spots. The

effective level a loudspeaker can generate is well shown in the 10% curve. In both cases a

linear response without dips and peaks is desirable. Dips in certain areas not only point to

weak construction but may also result in noticeable distortion and dirty sound.

Depending on the program material to be reproduced peaks of the maximum level curve

may be useful in certain frequency bands. Apart from the extended low frequency

requirements of today’s music the fundamental range should be especially considered.

Headroom in this range permits input without compression by limiters or to put emphasis

on vocals and instruments at high overall levels. However, this range is the weak spot of
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many sound reinforcement loudspeakers. The common combination of direct-radiating

woofers and horn loaded low-mid systems and low crossover frequencies of 100-150 Hz

often put a strain on the horns that are frequently underdimensioned. The sensitivity loss

in this range requires strong controller compensation. The result is a linear frequency

response but for adequate sound pressure levels the horn driver power handling capacity

is insufficient.

9

Figure 12 Maximum level at a selected THD limit (l) and THD, k2 and
k3 at a defined level (r)

Often the curves of different THD limits converge (see Figure 12/left) which is basically

impossible since the limits must be clearly defined. This can be explained by limited

power amp performance or by the use of limiters that prevent further level increase. It is

especially recommended to reduce the maximum power for dome tweeters to a useful

level since they generate very little THD and are prone to overload without protection

circuits.
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6.4 Dispersion Characteristics

Loudspeaker dispersion characteristics are shown in various ways with more or less the

same validity. The traditional way is the use of polar plots that show dispersion of

selected frequency bands (1/3 octave or octave)  on one level. A polar plot requires 30

individual curves for a 1/3 octave resolution. For that reason isobar (see Figure 13) or 3D

displays showing dispersion of the entire frequency range on one level are preferable.

This chapter deals with a large twin coaxial horn PA loudspeaker optimized for constant

directivity. Its coverage angle of 60° x 40° is nearly constant from approximately 500 Hz

to the highest frequencies relative to -6 dB off axis. To cover larger areas multiple systems

can be lined up in arrays. Because of clean dispersion characteristics and to avoid

interference each loudspeaker should only cover a defined listening area angle. Due to

limited low-mid horn dimensions the dispersion angle increases at frequencies below

500Hz as shown in Figure 13. Multiple systems work best below this frequency if units

are as close as possible to provide acoustic coupling. The system above is impeccable on

this score and allows combining multiple loudspeakers without larger interference areas

or coverage gaps. Isobar displays should not show irregularities or peaks for loudspeakers

used in clusters or arrays.

To avoid feedback sound reinforcement systems should not produce side lobes. These

occur frequently on the vertical plane of a loudspeaker as shown in Figure 13/below at

approximately 500 Hz. Increased feedback inevitably results in that frequency range if

such  systems are placed centrally above the stage, i.e. above microphones.

Loudspeakers that are used as single systems exclusively, e.g. studio monitors, are less

critical. The isobar displays of typical cone and dome systems show characteristic

irregularities depending on the number of ways similar to a Christmas tree. Hypothesizing

the listener is always close to the loudspeaker axis and the environment is nearly anechoic

one could allege off-axis response is of secondary importance. However, as soon as a

closed environment is excited both on-axis and off-axis response are brought into play by

reflections and reverberation. These affect mainly the mid and low frequencies depending

on the absorption characteristics of the environment. Measuring in a reverberant

environment provides further conclusions by registering the full loudspeaker response.

The energy density in a reverberant field is proportional to sound pressure and the

reverberation time of the room. However, this is highly frequency dependent and must be

compensated for measuring.
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10

Figure 13 Isobar display of horizontal (above) and vertical (below)
dispersion (3 dB/div)

The anechoic response and the reverberation time compensated reverberant field

response of the sample system are shown in Figure 14/left. The reverberant field

measurement cannot be evaluated below 200 Hz because of pronounced singular room

modes. Furthermore a steady slope down to approximately 1 kHz can be seen. Beyond

that response is nearly linear as it should be at a constant dispersion angle. It deviates

only between 2 and 4 kHz by about +3 dB where the loudspeaker produces more energy.

Depending on room characteristics this exaltation will be more or less audible. The EQ



MF Audio Measuring System: Measuring Loudspeakers                                              74/277

                                                                                                                                                       

© by Audio & Acoustics Consulting Aachen V 3.2E printed 12.12.99 11:02

curve in Figure 14/right to compensate the reverberant field response was derived from

these measurements. Whether it is useful to compensate the reverberant field response by

a filter depends on room reverberation. The curve is a reference for filter setting which can

be attenuated if necessary.

11

Figure 14 Anechoic and reverberant field response (l) and
resulting reverberant field EQ curve (r)

The reverberant field response tendencies may be guessed from the isobar diagram in

Figure 13 where the dips and peaks appear as narrowing and widening in the vertical

plane. Nevertheless reverberant field measuring is recommended since the two isobar

diagrams only cover the horizontal and vertical planes. Reverberant field measuring

covers all directions. Alternatively a multitude of frequency responses may be recorded in

full-space on a spherical grid around the loudspeaker as commonly practised to gather

loudspeaker data for room simulation programs. A 5° resolution however requires 2812

measuring points the recording of which with a complicated swivel mechanism is very

time consuming. Reverberant field frequency response, directivity and Q can be

calculated from these data as well. The advantages of this measuring method are the 3D

graphic dispersion characteristics and easy evaluation. Side lobes and coverage gaps can

also be easily seen.
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6.5 Conclusions

Frequency and decay response curves, maximum level curves  and isobar diagrams

provide comprehensive information to characterize a loudspeaker by measuring. The

weighting of individual criteria depends on the intended loudspeaker application. It is of

vital importance, though, to consider all criteria for safe assessment and establishing a

connection with aural perception. Also, relations can be found between deviating

measuring results such as extreme delays, cone resonances or irregular directivity and

loudspeaker sound characteristics.
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7 Swens Little Measuring Primer

Knowing the frequency response of a loudspeaker is the prerequisite  for equalisation.

Starting with the various measuring methods that record frequency response at one point

only (the measuring microphone position) this chapter also deals with compensation

possibilities for large rooms, reverberating environment and the use of large clusters.

Basically any measuring method is suitable that correctly determines frequency response

by angle and phase in sufficiently small increments. FFT spectra are required as data base

for FIR coefficient generating which is discussed in-depth in the next chapter. Their

length must be such that resolution at the lower end of frequency response is satisfactory.

Due to constant frequency increments is much higher by multiples than necessary to

characterize and equalize high frequency drivers. The loudspeaker files therefore require a

lot of hard disk space whuich should not be a problem with today’s GB disks
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7.1 FFT Method

7.1.1 Impulse

This measurement can be taken most easily from a linear time-invariant system (which

loudspeakers basically are if their power handling capacity is not surpassed) with a short

Dirac-shaped impulse. The recorded response to the individual impulse is the impulse

response without the necessity of any mathematical operations. To determine the transfer

function a single FFT is necessary. Of all methods impulse measuring requires the least

computing effort if impulse response and spectrum are to be shown.

The ideal Dirac impulse mathematicians and signal theorits would love to see is infinitely

small but it has an area or energy respectively of 1. Actually there is no interest for an

extremely short and extremely high impulse with a spectrum well into the microwace

range in audio technology. The impulse requires only a sufficiently frequency-constant

amplitude response in the evaluation range. If a modern D/A converter with multiple

oversampling is used to provide the impulse the requirement of amplitude consistency is

met up to nearly half the sampling rate. The sin(x)/x-trailing edge caused by aperture (see

chapter 1) is hardly noticeable. Instead of the impulse the impule response of the

oversampler (i.e. a weighted and usefully truncated sin(x)/x function) is used as stimulus..

For the measuring result this is convolved with the test object response which may

occasionally be distracticng when displaying the impulse response, especially because of

the precursory “non-causal“ portions of the linear phase oversampler low pass filters. In

this case spectrum compensation (as described later) is necessary which considerably

increases computing effort because the desired impulse response is available after

compensation  and a subsequent IFFT only.

The biggest drawback of impulse measuring is lack of energy. Dynamics are mostly

insufficient especially in the lower frequency range an can be improved only by many

coherent averages. On the other hand the impulse can nearly always be fed to the

loudspeaker with full power amp amplitude without damage. Especially sensitive dome

tweeters that usually burn out at 5W continuous power can be excited by more than

100W impulse power without problems. Non-linearity from excessive excursion must be

expected at extreme voltage amplitudes only because of mass inertia. This puts the lack of

energy into perspective with the alternative measuring methods described later. High

frequency drivers can safely be measured with an impulse in quiet environment.

Dynamics are almost always sufficient for electrical orpurely digital measuring. Impulse

measuring is for instance always advantageous over pseudo noise signals described later

when quick and correct equalization of a measured frequency response on display is
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required. If a change of the filter settings, i.e. a time invariance , occurs during a

measuring period the frequency response on display is grossly distorted when using

pseudo noise signals whereas impulse measuring is hardly affected by such changes. On

the other hand the effects of potentially existing non-linearities cannot be separated from

the impulse response.

7.1.2 Two-channel FFT Analysis

Test signals with even energy distribution across the measuring period are more suitable if

more dynamics are required. Formerly two-channel FFT analyzers were often used for

that purpose with simple analog noise generators as test signal sources. These fed one

analyzer channel while the measuring microphone fed the loudspeaker signal fed the

other. Response is obtained by dividing the second spectrum by the first. This method

also has a drawback. The noise generator may provide white noise averaged over an

extended period of time, the single period used for measuring, however, shows serious

fluctuation with deep dips. The division of the spectra results in random values at these

frequencies. Usable results can be achieved by much averaging that preferably does not

allow for the areas lacking dynamics. This extends the measurement unnecessary. On the

positive side any source, e.g. speech, music, can be used as test signal. For that reason

this method is suitable to discretely control frequency response during events. It is still

used today

First generation two-channel FFT analyzers were bulky, heavy and above all expensive.

Signal processing hardware was specially designed and complicated. They have long been

superseeded by PCs that can replace these dinosaurs with just an additional AD/DA

converter plug-in. The computing power of even the least expensive current models is

sufficient for FFTs with multiples of the speed necessary for real time operation. Taking

advantage of the 64 bit floating point format they all provide today they are much more

accurate than stand-alone analyzers operating usually with fixed point and limited word

width. Today’s AD/DA converters for audio are mass-produced and inexpensive. They

require only few external connections and provide excellent S/N ratio and linearity.
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7.1.3 Deterministic Signals with FFT Block Length

Integrating a D/A converter into a measuring system provides the important opportunity

to synthesize test signals by software and recall as file. This makes the second FFT

channel obsolete since the test signal is deterministic. Its spectrum must therefore be

calculated only once. It is discrete when periodically repeated, and amplitude and phase

of each frequency it contains can be set completely independently. This way colored

noise signals can be generated from amplitude spectra by random phase selection from a

spectrum. The test signal is obtained directly by an IFFT. To optimize the  crest factor, i.e.

power at a fixed maximum amplitude, phases are randomly selected from an MLS

spectrum instead. Thus test signals can be generated with characteristics very similar to

the corresponding maximum length sequences and the favorable length of  2n .
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Figure 15: Above: Amplitude response (-6 dB/octave) of noise and
sweep signals.
Center: Group delay response. Below: time signals.

A sweep signal is generated from the same amplitude spectrum by raising and lowering

the phase throughout the frequency range by a fixed increment and IFFT.

Superb sweep signals are generated from amplitude spectra by transforming a spectrum

into the time domain with 0° phase  and windowing the symmetrical impulse answer. The

window should be no more than half the width of the time period. After transformation

into the frequency domain again the desired transit time is impressed. After IFFT a non-

overlapping sweep signal at disposal. If the amplitude response of a sweep signal with

logarithmic frequency increments is to be time-constant the amplitude must fall by

3 dB/octave.
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Figure 15 shows two signals generated from the same amplitude spectrum. At a first

glance the corresponding time signals seem to have nothing in common although the

energy of each frequency is identical. As with a two-channel FFT analysis response is

obtained by dividing the response spectrum by that of the test signal.

Test signals of any length can be generated at random by an inverse discrete Fourier

transformation since amplitude spectrum and test signal phase can be selected freely in

the frequency domain. For evaluation by FFT their length is restricted to 2n which is no

impediment in practice. If the frequency resolution

df = fs/N fs = sampling rate N  = number of samples

is insufficient it can be doubled by selecting the next higher square. Recently pseudo

noise signals of FFT typical 2n length are used in some FFT-based measuring systems.

They go by the somewhat strange name of “multi-sinus-signal“ presumably to express

that the periodic test signal consists of a defined number of sine waves with controlled

amplitude and phase. However, this is true for any periodic signal such as the maximum

length sequences described later that are often contrasted with multi-sinus-signals. The

simple FFT of the response of a system followed by the division by the exciting spectrum

is fully sufficient to determine the transfer function and advantageous for realizing a

measuring system. The impulse response is obtained by an IFFT, interference and

reflections can be windowed if necessary (as is nearly always the case with acoustic

measuring). The corrected impulse response can be transformed into the frequency

domain by an FFT which increases the number of transformations necessary for a

measuring run to three. Computing time is approximately twice the amount required for

the MLS method which is negligible considering the speed of modern PC’s. For state-of-

the-art measuring systems maximum length sequences have lost their attractivity.
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7.2 Time Delay Spectrometry

Time delay spectrometry is a dated measuring method that uses linear frequency sweeps

(df/dt = const.) of constant amplitude and requires  no Fourier transformation to

determine the transfer function. Operational TDS analyzers can still be found in many

loudspeaker research and developmernt laboratoies. Richard Heyser dedicated a large part

of his life to TDS. The complete originally fully analog method reqires appropriate

software and AD/DA converters only, the complicated hardware previously needed is

superfluous.

The TDS system is based on a sweep generator providing a sine and a Versatz

phaselocked cosine signal with increasing frequency and 90° offset. The test object is fed

one of the sweep signals and the response is multiplied by both signal components.The

multiplier output signal is low pass filtered providing the real (multiplication by sine) and

imaginary (multiplication by cosine) phase angles of the transfer function.

Figure 16 Basic operation of a TDS measuring system. The broken
lines are operative only if the cos signal is used as exciter
for the second measuring to eliminate low frequency
ripple (as described later).

If the generated and the measured signal frequencies match a DC offset results at the

demodulator outputs (the distribution between both outputs depends on phase relation)

which is suppressed by the following low pass filters. If the frequencies do not match

because of test signal delay (which is the case with most acoustic measuring) beats result

from the frequency difference of the measured and the generator signal. These are

suppressed by the low pass filters provided the beat frequency is significantly higher than

the filter cut-off frequency. For that reason the generator signal must be fed to the
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demodulator time delayed by the measuring distance delay. A useful result for

loudspeaker measuring is the suppression of unwanted reflections that inevitably arrive

delayed and that have a lower momentary frequency than the direct sound. Again beats

originate from the difference to the demodulation signal. Its influence on the measuring

result is reciprocally proportional to the delay time and frequency difference. Amplitude,

phase, delay and Nyquist plot and, by a normal inverse Fourier transformation, impulse

response can be obtained from the complex real and imaginary phase angle spectrrum

gained by TDS. TDS analyzers are also known for their display of energy-time curves

(ETC) propagated by Richard Heyser which results from the amplitude of the complex

value analytic signal and shows the envelope of the impulse response. The envelope can

always be calculated from a given impulse response independent of the measuring

method.

Figure 17: Linear (l) und logarithmic graphs (r) of impulse
response (grey) and energy time curve (black) of a 15“
bandpass subwoofer.

The analytic signal consists of the real part which is the impulse response itself and the

imaginary part which is the impulse response with a 90° phase shift. It can be obtained

by an FFT of the impulse response, 90° phase shift of all spectral values and subsequent

IFFT. Non-causal content of the imaginary part cannot be avoided by this spectrum

manupulation, i.e. it does not disappear at negative times. The ETC should be used with

care especially if it is tu be interpretated as the progression of energy flow. Delay times

and the dying of the impulse answer are shown well in an ETC since the impulse

response zero crossings are “filled“ by the 90° phase shift component.

Note: The 90° phase shift is easily accomplished by negating the real part and

subsequent exchange by the imaginary part. Negation is achieved quickly by inverting

the sign bits of the floating point numbers (by adding 128 to the highest value byte), i.e.

the floating point unit is not even needed for the entire operation.
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A big drawback of TDS is the use of linear frequency sweeps resulting in insufficient test

signal energy in the lower octaves and extended measuring duration in the upper octaves.

The free selection of the spectral energy distribution of a test signal as detailed before is

more favorable for adjustment to all measuring environment. At least  the evaluation

range can easily determined by simply selecting the sweep start and stop frequencies.

Also, spectrum length is not fixed at FFT typical 2n valueas although this is practical to

calculate the impulse response by IFFT Because of poor spectral energy distribution

division of the frequency range and measuring in two stages seems a good idea..

Difficulties at the lower frequency limit resulting in oscillating spectra in this range have

also been reported in conjunction with TDS measuring. These can be explained by the

decreasing smoothing of the squared momentary frequency by the demodulator low pass

filters. Also, the low pass filters must rise after the sudden onset of the sweep signal.

Lowering the low pass cut-off frequency increases smoothing, sweep duration must be

proportionally increased however to maintain frequency resolution since the filter reacts

slower to fast fluctuations. A better solution is measuring in two stages, i.e. with a normal

sweep and a 90° phase shift derivative. Both test object responses are are multiplied by

the delayed 90° phase relation generator signals. The results are added (subtracted in the

imaginary section - see broken lines in Figure 16) and fed to the low pass filters to obtain

the real and imaginary parts. Since the sine and cosine squares add to 1 the oscillations

caused by the exciting frequency disappear. The low pass cut-off frequency can be raised

again. For reflection and interference-free environment the filters are not even required.

This does not solve transient response problem at the onset of the sweep signal, though.

Starting the sweep signal and its evaluation at lower frequencies (“negative“ frequencies if

necessary) and evaluating the low pass output signals from a fixed later time, i.e. a fixed

frequency is a potential solution. nehmen. More elegant is the use of a sweep signal as

shown in Figure 15. Ist spectrum hardly adds additional noise because of its soft high

pass characteristics and gently oscillating start even at non-periodic sends.

Compared to the other methods (MLS, 2n signal) TDS has considerable disadvantages for

frequency response measuring. Wide band measuring is more time-consuming and

resolution is limited by the demodulator low pass filters. Some users like their smoothing

effect on the measured spectra, although this can be obtained by all other measuring

methods by gliding averaging or impulse response windowing. The spectral energy

distribution of TDS chirps is as unfavorable as white noise especially for acoustic

measuring. Delay must be determined and correctly set before evaluation while the other

measuring methods enable detection and windowing of the impulse response within the

evaluation period by maximum search. Also, interference-free measuring at lower

frequencies requires inconvenient additional measuring by a 90° phase shift signal.
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7.3 Interference

Interference reveals differences between various test signals. Examples of two common

types of interference were simulated  by a noise and a sweep signal of 2n length for Figure

18. A short impulse type of peak by a single inaccurate sample disfigures the test signal in

the first example, for the second all samples were raised to power 0.96. This is equivalent

to non-linearity of 1% that occurs in similar form as transfer distortion at zero crossing if

amplification stages provide insufficient zero signal current.

Macroscopically seen the impulse type of interference has the same effect basically on

both amplitude spectra (that have been multiplied by the inverse exciting spectrum

already). The impulse responses calculated by IFFT however show a very different noise

floor. The interference seems to be convolved with that of the inverse exciting spectrum

that was inversely Fourier transformed. Since in this case the interference was a Dirac

impulse the impulse response of the spectrally inverted test signal is added to the result.

Whe simulating distortion sweep signals seem to have less effect. They are more practical

for measuring with this type of distortion. The corresponding impulse response shows

interesting phantom peaks.
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Figure 18: Measuring interference and resulting impulse
responses. Left: interference by a single peak, right:
interference by distortion (raised to power 0,96). To
distinguish the sweep responses they are on the -20 dB
axis. The impulse response amplitudes (black = sweep)
have been magnified, maximum voltage is 1V.

Time variance is another type of interference that often occurs during acoustic measuring.

When measuring in open air greater distances between measuring microphone and test

object, the flow of air (wind, thermal currents) and temporary changes of sound velocity

caused by it result in time variance interference. The effect of slight temperature changes

on sound velocity only can cause serious interference when measuring methods require

many coherent averages to achieve sufficient dynamics. If a voice coil heats up

significantly because of the power it is fed by measuring a loudspeaker itself can cause

time variance, especially in conjunction with passive crossovers. In this case the

increasing voice coil impedance not only results in a wide band loss of sensitivity but also

in frequency response deviations due to changing termination impedance. Since these

deviations are gradual mostly (if no excessive power is fed) time variance within a

measurement is rather small.
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Fast time variances within individual periods of the test signal are more disturbing.

Depending on interference time significant differences result for the individual test

signals. Two differing “time variance signals“ representing the deviation of each sampling

point were generated to demonstrate the time variance effect on the example signals. The

first is a rather exaggerated scenario of white noise with triangular distribution and a ±0.5

sample amplitude. The second signal also deviates by no more than half a sample

following the soft flow of a sine oscillation.

To simulate the fluctuation of the sampling points the sampling rate of both test signals

was increased to the 256-fold by inserting 255 zeroes between two samples. Next the

sampling points were shifted according to the artificial time variance curves that were

normalized to the value range ±128 for that purpose. The resulting jitter signal was fed

through a high slope low pass filter with a 21 kHz cut-off and undersampled by a factor

of 256 to return to the original sampling rate of 44.1 kHz. The last two steps are

unnecessary for evaluation but reduce the amount of hard disk data. To avoid side effects

all steps were used for three successive test signal periods. The middle period was

evaluated only.

The simulation results shown in Figure 19 are rather revealing. The white noise interfering

with the sampling points shown left has basically the same effect on the noise and sweep

signals. The measurement  is only recognizable below 1 kHz due to the high jitter

amplitude of ±0.5 samples chosen for simulation. The low frequency sine interference

looks very different: while the noise signal measuring also suffers considerably the sweep

signal measuring is nearly immune! Since time variances during measuring will usually be

of the low frequency kind the sine signal is probably more representative of actual

interference. As a conclusion sweep signals must be clearly recommended if time

variance is expected (e.g. with analog recorders or measuring sound reinforcement

systems for large outdoor events).
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Figure 19: Measuring interference by time variance and resulting impulse
responses. Above: time variance for simulation, center: response
to noise (grey) and sweep signals (–20dB axis,black).
Below: impulse response from IFFT (maximum voltage = 1V)
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7.4 Maximum Length Sequences

Besides FFT test signals of 2n length that can be made up at random (noise, sweep or any

other signals with adequate energy distribution) so-called correlation signals are

especially suitable for measuring purposes. Correlation signals have an autocorrelation

function very close to the ideal of a single Dirac impulse. This chapter deals with

periodically repeated sequences exclusively which meet this demand most easily. The

periodic ACF (PACF) of a perfect sequence disappears except for a principal value per

sequence length. For that reason the amplitude of all frequencies in the corresponding

discrete spectrum is equal, i.e. it is white, as can be shown by the Wiener-Khintchine

theorem:
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Perfect sequences of sufficient length for measuring purposes must take on at least three

different amplitude characteristics. Perfect binary sequences have not been discovered

apart from one sequence with four values only. For most applications including

measuring technology sequences are sufficient that meet the demand for a perfect PACF

approximately only. To characterize the correlation qualities two criteria are used. The

first determines the relation of  principal maximum to the largest secondary PACF

maximum:
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The closer principal-secondary maximum relation and merit factor approximate infinity

the whiter is the spectrum of the examined sequence. .....offers a comprehensive view on

the creation and use of a variety of correlation signals including complex value and multi-

dimensional arrays.

How are correlation signals used for measuring? By establishing the crosscorrelation

between a correlation signal and an LTI system response the approximate impulse

response is obtained. Approximation is as close as the signal used is to a perfect PACF.
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The frequency response is calculated as usual by an FFT. However, a crosscorrelation

takes up considerable computing effort for standard test signal lengths if it is to be

established discretely in the time domain.

Fortunately there is a class of pseudostochastic binary signals with favorable

autocorrelation characteristics. They are easy to generate and process by a highly efficient

crosscorrelation algorithm: the well-known maximum length sequences (MLS).

Maximum length sequences are generated by shift registers two to four steps of which are

fed back to the input by an XOR gate. This can be achieved by simple hardware or

compact software routines. The shift register taps for the XOR coupled feedback can be

selected by “primitive polynomials“ so that all possible shift register states are passed

before returning to the initial state (with the exception of “0 all“ - the register will empty).

Maximum length sequences owe their name to that characteristic: at a fixed number of

shift register steps their period length ist the maximum possible length. An n-step register

enables the production of 2n different numbers. Subtracting the “forbidden“ 0 results in

the typical maximum sequence length of 2n-1 values. The MLS consists only of the bits

“gushing“ from the final step, however, not of complete register states. If these are lined

up on top of all 2n-1 states the desired MLS is at hand. It is binary because it contains the

values 0 and 1 only.

For the use as test signal the sequence must be brought up to a suitable amplitude. DC

offset is removed by subtracting half the amplitude. The resulting signal contains

maximum energy at a fixed maximum amplitude since all values reach maximum

amplitude. The crest factor (peak/continuous power relation) is an unsurpassable 0 dB.

The high energy content of binary sequences is often seen as a tremendous advantage

over all other test signals because of theoretically higher dynamics at the same level. At a

closer look this alleged advantage is crossed out by the necessary D/A converter anti-

aliasing filter. All of today’s D/A converters use multiple oversampling (independent of

converter principle) to keep demands on analog anti-aliasing filtering low. Oversampling

and high slope linear phase digital filters let the entire audio range pass with minimum

amplitude fluctuations (unattainable by a higher order analog filter)  developing a a high

slope low pass effect shortly before the Nyquist frequency. The high slope filter

characteristics cause heavy over-oscillation at surge points which are a common MLS

feature.
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Figure 20: Effect of a typical 8 times oversampling filter (black) on
a maximum length sequence (grey). Because of the 0dB
low pass filtering the crest factor falls off to 7,76 dB. The
MLS magnitude must not exceed 41% of maximum
voltage.

For that reason the MLS level must be significantly below maximum level to avoid hard

clipping and negative effects on measuring results. In practice the MLS level must remain

below–8 dBFS to prevent interference by phantom impulse response peaks and a

“ragged“ spectrum curve, i.e. the maximum length sequence must never leave the system

at full level. The tolerable MLS level is above that of a genuine stochastic noise signal

which needs 11 dB minimum headroom relative to the RMS level. A sweep signal with

frequency constant amplitude (crest factor = 3 dB) which can be sent at full level without

problems contains 5 dB more energy! If a test object has narrow band resonances,

though, amplitude must possibly be decreased to avoid overload when crossing the

resonance.

Usually it is hardly possible or necessary to make us of the full dynamic range of

amplifiers and signal processors. For loudspeaker measuring power handling capacity or

human hearing is a limit that must be rigidly observed. Also, the white amplitude

spectrum of correlation signals is by no means ideal for these and many other

measurements. The S/N ratio of purely electrical measuring is normally significantly

higher than that of acoustic measuring set-ups so that level may be generously reduced

without negative effects of noise on measuring results. From that point of view the

optimum crest factor of unfiltered MLS is irrelevant for everyday measuring.

If a periodically repeated MLS m‘(t) is fed into an LTI system with the impulse response

h(t) the convolution product of the periodically repeated MLS and the system impulse

response can be observed at the system output: g‘(t) = m‘(t) * h(t)
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The periodically repeated MLS of the LTI system results from convolving the output

signal g‘(t) with the time inversed MLS m‘(-t):

g‘(t) * m‘(-t) = h(t) * m‘(t) * m‘(-t) = h‘(t)

If it has decayed below the resolution limit within a period it is equivalent to the non-

periodic system impulse h(t).

MLS measuring is similarly interference-prone as 2n pseudo-noise signal measuring.

Especially low frequency sampling point shifts have negative effects on MLS measuring

(Figure 21). If large time variances are expected from adverse measuring conditions the

use of the sturdier sweep signals is recommended.

Figure 21: Sine-shaped time variance interference (amplitude 0.5
samples, cf. Figure 19) of a linear MLS measurement.
Left:spectrum, right: resulting impulse response (peak =
1V)
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7.5 Test Signal Coloring

Independently of the measuring method the spectral characteristics of a test signal must

meet several demands. First, the level of all frequencies of interest must be sufficient to

counter acoustic or electric interference effectively. Secondly, the amplitude difference of

adjacent frequency components must not be too big. Since test objects are always more

or less non-linear intermodulation products will otherwise overlap weak test signal

frequencies rendering these areas unusable. This must especially be borne in mind if

program material is used as test signal. The evaluation of several sections is usually

necessary to register the entire spectral range with sufficient precision.

Also, the spectral test signal distribution must depend on loudspeaker power handling

capacity and human hearing. A white spectrum such as that of unfiltered maximum

length sequences or TDS sweeps is not useful at all for wide band measuring of a

complete loudspeaker system (e.g. for verification after filtering). Due to the constant

energy/bandwidth ratio the high frequency driver must handle more than 85% of the

power load at a 3 kHz crossover frequency and a 44,1 kHz sampling rate although delicate

home audio dome tweeters handle approximately 5% of the nominal load only. Sound

reinforcement compression drivers are sturdier but due to their high efficiency white

spectrum test signals are a serious danger for human ears if send levels are much too high

by mistake.

The interference spectrum of acoustic immissions usually increases significantly at lower

frequencies while the test object SPL decreases by 12 or 24 dB/octave below its cut-off

frequency. A subwoofer operating up to 100Hz might have to handle less than 0.5%

power if it was fed by a white noise signal. A significant boost of low frequency level is

necessary for wide band measuring. It can be compensated again by dividing the result by

the test signal spectrum. A test signal with low frequency boost is also psychologically

advantageous. It is perceived as more pleasant and warmer than white noise which is

perceived as cold and harsh. Also, higher low frequency levels will hardly be annoying

since the human ear is much less sensitive in this range.

The high frequency part of a maximum length sequence can be attenuated by using all

shift register states as mentioned above instead of removing the last bit each time. Signals

generated this way are no longer binary but each amplitude between 1 and 2n-1 (n =

number of register steps) occurs exactly once. Somehow these “m-nary“ signals (m =

MLS length) are linked closely to the original binary MLS and, funnily enough, the

Hadamard transformation is also applicable.
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An impulse response shows by crosscorrelation that has a strong resemblance to an RC

low pass and a similar spectrum (Figure 22). Compared to the crosscorrelation with the

correct MLS the impulse response peak shifts back in time by n values (number of

register steps), i.e. it shifts proportionally to the left of the peak crosscorrelation function.

Cyclic exchange by n values moves it to the starting position t=0. The spectrum is the

same for all sequence lengths and no longer white. High frequency attenuation however

only starts in the upper range and is too moderate. This modified MLS is mentioned

because it can be generated without additional effort directly by the shift register

algorithm.
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Figure 22: Left: MLS section from numerical shift register values (DC offset
removed by subtraction of ½ sequence length). Right:
Crosscorrelation by Hadamard transformation with normal
binary MLS (at the right) A binary MLS of the same amplitude
would cause a 1V peak in the crosscorrelation function. Below:
corresponding response, normal MLS level = 0 dB.

Spectral coloring at random is more desirable of course. It can be achieved by convolving

the periodic MLS with the impulse response of the proper filter. Discrete convolution in

the time domain is the fastest is the impulse response is very short. Segmented

convolution in the spectral domain is faster if impulse responses are longer. Fortunately

the inverse Hadamard transformation according to Eckard Mommertz is even faster for

convolution with maximum length sequences. The impulse response h(t) of the desired

filter must be stretched to the MLS length. It should have died at least within one MLS

period, preferably sooner than that. If the impulse response is not symmetrical it must be

mirrored, i.e. time-inverted. The prefiltered time-inverted MLS is calculated from the

inverted impulse response by a normal Hadamard transformation:

h(-t) * m(-t) = v(-t)
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The result is inverted again to provide the MLS v(t). This procedure follows a suggestion

by Jeffrey Borish who uses troublesome matrix operations for deduction to finally realize

it is only necessary to invert the sorting sequence of both permutations. This is eqivalent

to the time inversions mentioned.

Figure 23 shows a former 13th degree MLS with a 20dB boost in the lower octaves

generated this way. It is suitable for loudspeaker measuring and sounds better than the

naked white MLS. The signal was modeled with a filter the impulse response of which

should be as short as possible. This was achieved by “tight“ windowing (5 ms) and a

subsequent Hilbert transformation of the impulse response. Disturbing reflections can be

windowed fairly well before compensating the low frequency boost (which can be

accomplished only after transformation into the frequency range). Other cut-off

frequencies and amounts of boost are also suitable.The frequency splitting the signal in

two bands of equal energy content in this example is still rather high at 4,7 kHz.

Figure 23: Time signal, impulse response and response of a  filtered
13th degree MLS (Crest: 7,6 dB) suitable for loudspeaker
measuring. To distinguish impulse response amplitude
it has been enlarged, the amplitude of the first value left
is 1V.
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Apart from matching the amplitude response to the measuring conditions prefiltered MLS

can be generated by skilful phase and delay selection which provide a quickly dying

impulse response after FHT that can be separated easily from slightly delayed reflections.

This is of advantage when measuring the reflection characteristics of surfaces in situ

[Mom95b]. Further details and interesting applications of prefiltered MLS can be found in

[Mom95a]. In many cases MLS coloring at random provides crucial refinement of

measuring methods. This is impossible with MLS measuring systems based on hardware

MLS generators. A genuine D/A converter integrated into the measuring system also

provides the flexibility to use other, completely different measuring signals, e.g. sine wave

signals to measure THD or music samples for subjective evaluation of loudspeaker sound

characteristics.

By coloring a pseudo noise signal generated from a maximum length sequence loses its

valuable correlation signal characteristics (in the sense of an approximately Dirac shaped

PACF). In fact coloring is a deliberate deviation from the demand for constant energy of

all frequencies. The Hadamard transformation can still be applied but it results in the test

object impulse response convolved with the filter impulse response, of course.

Compensation can only be accomplished by dividing the spectrum obtained by FFT of

the impulse response by the test signal spectrum.
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Figure 24: Frequency response of an inexpensive 16-bit sound card
Codec equipped measuring system with a colored MLS
as in figure 23 (grey) and resulting compensation
response (black) with 30 dB inversion dynamics. Test
signal coloring, slight digital filter ripple, low pass
characteristics from 18 kHz and analog high pass
characteristics below 50 Hz are evident..

It also allows compensation of possibly irregular frquency response of the system

converters and power amps. For that purpose input and output of the measuring system

are connected directly and the natural frequency response is measured. It is

recommended to invert this reference measurement and use it (multiplicatively) for

subsequent measuring (Figure 24). Depending on converter reference voltage consistency

a measuring accuracy of 1/1000 dB or better can be achieved.

For acoustic measuring the compensation technique enables the use of inexpensive

electret microphones instead of the usual condenser microphones. Equipped with an

ultra-thin metal foil diaphragm these precision units are highly sensitive and shockingly

expensive. However they are also highly sensitive to all kinds of shock. To avoid comb

filter effects caused by reflections when measuring close to floors it is often necessary to

place the inconspicious microphone directly on the floor where it ends up the victim of

inadvertent personnel during a frantic measuring series. For that reason inexpensive

standard models are recommended especially for outdoor use to avoid the loss of high-

priced laboratory microphones.

There are simple electret microphones with a surprisingly linear frequency response

which explains their sometimes excellent sound although their linearity is not up to that

of high-priced condenser models. However, the deviations of electret units can be

registered and compensated by the substitution method. A loudspeaker is set up and
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frequency response is measured using the reference microphone. Next, the measurement

is repeated using an inexpensive model as a substitute in exactly the same position. To

save time both microphones are placed next to each other and measured simultaneously

(two-channel comparative method) although accuracy suffers slightly because of cross-

talk. The quotient spectrum HREF/HCHEAP is used (again multiplicatively) as compensation

spectrum for measuring with the inexpensive microphone. To achieve satisfactory

dynamics the loudspeaker must reproduce all audio frequencies with sufficient levels. For

adequate low frequency reproduction a prefiltered test signal may be helpful.

The accuracy of these methods is rather low compared to purely electrical compensation.

Even when measuring carefully minimum tolerance is 0.5dB. A compression chamber

provides somewhat better results if the microphone fits airtight within the aperture.

The demand on measuring signals to be suitably auto-correlating becomes obsolete by

the possibilities of spectral compensation described in this chapter. By complex

compensation amplitude is corrected as well as phase of the entire measuring period and

test signal. From this point of view the Hadamard transformation which corrects phase

exclusively  and which is necessary before transformation into the frequency domain

actually is a superfluous step of MLS measuring. Still, it must be taken for an FFT

requires 2n periods for correct results and MLS period length is 2n-1. This applies at least if

the transfer function is of interest only. On the other hand it is nearly always

advantageous for acoustic measuring to use a window for fading out impulse response

reflections and interference. When using 2n signals for transfer functions this can only be

accomplished by IFFT, windowing and subsequent reverse FFT. MLS measuring

however allows windowing “en route“ between FHT and FFT. Since the impulse

response of colored MLS is wider windowing in their case can possibly be accomplished

after spectrums compensation only. Prefiltering the maximum length sequences with a

filter impulse response as short as possible is a viable solution (as applied to the colored

MLS in Figure 23). In many cases the uncompensated impulse response can be

windowed as well.
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7.6 Windowing

For most acoustic measuring windowing, i.e. the fading out of the impulse answer after a

period of time, is an indispensable element of data processing. It is mainly used to remove

unwanted reflections which otherwise result in disturbing comb filter effects. Also, non-

linearities of test objects and interference by noise imission can be suppressed improving

the measuring S/N ratio. When measuring with maximum length sequences non-

linearities result in increased noise floor and more or less pronounced impulse response

phantom peaks spread across the measuring period (see Figure 26). Their effect on the

spectrum is similar to that of multiple reflections. They result in a wide “ragged“ curve

which mikroscopically seen consists of many small dips and peaks. Since this

interference is spread rather evenly across the periodic impulse response length the use of

test signals as long as possible is recommended to examine the frequency response of

non-linear test objects and to increase the ratio between windowable and total

interference. Windowing should commence where the impulse response disappears

beneath the noise floor.

To suppress reflections the window must be applied much sooner which unfortunately

limits the low frequency evaluation range. While the high frequency impulse response

part usually dies quickly extended resonances of the lower frequencies can be seen. Even

if the test object is non-dispersive the lack of definition increases at lower frequencies.The

valid measuring range shifts up the more the closer the window approaches the impulse

response. High frequency drivers can be measured comfortably in a normal room by

carefully placing the measuring distance in its center to ensure that the first reflection

arrives as late as possible. Usually the complete impulse response can be easily separated

from all reflections. At their lower end this is hardly possible when measuring midrange

drivers, and low frequency driver measuring requires anechoic environment since direct

radiation and reflections cannot be separated cleanly anymore.

To exemplify the problem a PA enclosure (12“, 2“ with CD horn) was measured in an

anechoic half space (Figure 25). Loudspeaker level (2 m) was chosen for microphone

placement instead of the 100% reflective floor. The first reflection arrives approximately

7 ms later which equals a detour of 2.4 m. Constructive and destructive interference

alternates every 71.5 Hz and causes a pronounced comb filter pattern the amplitude of

which decreases noticeably because of increasing loudspeaker directivity (Figure 25

below left). The impulse response must be windowed until the arrival of the first

reflection to suppress this nasty interference. It is inevitable that the lower frequency

range suffers. The windowing effects are shown in Figure 26 below right: the comb filter

pattern has disappeared completely. However, the spectrum has been incorrectly rounded
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off in the lower range rendering the measurement useless below approximately 500 Hz.

Especially the high slope below 60 Hz is not shown correctly anymore. Sub-sonic

response is completely misrepresented by a horizontal curve. Due to windowing the

positive and negative impulse response half-waves are no longer completely balanced

resulting in a DC offset.

A low frequency cut-off depending on a fixed level error and window position is hard to

establish since the cut-off also depends on how much the low frequency parts are lagging

behind the impulse response. As an alternative to unilateral windowing a full-size

standard window can be used symmetrical to the impulse response peak although this

attenuates the low frequencies noticeably more as experience shows. On the other hand

the standard window causes less inaccurate fluctuations in the other frequency bands.
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Figure 25: Impulse and frequency response of a PA loudspeaker at 2m
height including floor reflections.
To distinguish reflections the impulse response Y-axis has been
enlarged (impulse response peak: 7.36 kPa). Left: original
including reflections, right: windowed.

Figure 26: Noise floor of the measurement in Figure 25, enlarged across
the measuring period

Even under “optimum“ conditions in an anechoic chamber the low frequency response

of a loudspeaker is hard to establish because absorption capacities decrease at lower
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frequencies due to limited absorber wedge length. Absorptive qualities are insufficient if

wavelength exceeds quadruple wedge length resulting in sound pressure variations.

Nearfield measuring of all radiating apertures and subsequent complex addition (weighted

by the root of surface relations) is a remedy. The nearfield total can be “glued“ to the full-

space measurement in an area where both nearfield and full-space measurement are valid.

Amplitude, delay and phase must be matched to avoid discontinuitiy at the joint.

Unfortunately the result does not always tally with the frequency response measured

under true anechoic conditions but it is closer to the truth than standard on-axis

measuring from some distance.

Apparently, difficulties exist in practice to correctly determine the full frequency response

of a loudspeaker. Looking through catalogs and reviews inconsistencies become obvious

that can be related mainly to “tight“ windowing. This evens out the curve nicely in the

lower frequencies but it does not show the true response. Impeccable measuring results

however are of utmost importance for FIR filter generation described in the following

chapter.
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8 Examples

This chapter describes various common measurements and lists the necessary program

settings. Refering to the examples it is usually easy to create custom variations with

individual settings. On the accompanying disk are pick files for each example that

configure the appropriate settings. Pick files can be loaded and saved in the

Utility menu under PCK File Menu... .

8.1 Hardware Settings

The MF philosophy is based on reference measuring to determine the behavior of all

measuring components with the exception of the test object, i.e. the system measures

itself. A file is generated containing the frequency and phase response of the measuring

set-up to calculate further measuring and to compensate all linear measuring faults of

power amps, preamps A/D and D/A converters etc. The accompanying Robo front-end

enables easy reference measuring without changing external connections. Inputs and

outputs are switched off by relays and internally bridged. Depending on the measuring

mode power amps or reference loads are integrated into the measuring loop. Potential test

signal frequency weighting is also registered. For loudspeaker measuring a measuring

microphone compensation file can be incorporated into the reference file. The automatic

mode for internal front-end connection is activated under Ref: int in the reference

measuring menus as standard. If no internal reference measurement is desired, e.g. if an

external power amp is inserted into the reference measuring loop, this must be set to

Ref: ext. Red LEDs on the front-end indicate if a measurement is made in internal

reference mode. Amp Ref indicates the power amp is within the reference loop, Line Ref
connects the line inputs and outputs internally only. A third reference mode indicated by

10 Ohm Cal is for impedance measuring and incorporates an internal 10 Ohm reference

load. The power amp output signal is attenuated by a 20dB pad during reference

measuring which is automatically allowed for by the software.

Note: During reference measuring  utmost care must be taken to avoid distortion or

other measuring faults by inaccurate system level settings. Potential errors will interfere

with any further measuring!!! The bargraph level indicator should always be checked after

a reference measurement. Figure 33 shows correct and inaccurate reference measuring

level settings. Phantom power must be switched off during reference measuring !!

The settings in Table 13 for hardware set-up apply to all the following examples. If

required the sampling rate (typically 44.1 kHz) and the input channel/s can be selected.

The important input and output level settings depend on the test object and cannot be set
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generally. It is recommended to always select the Autorange option which adjusts input

sensitivity automatically. The Autorange function has no effect on output level.

Basically input sensitivity should be set in AD/DA Basic Settings only in AD

fullscale. The # key changes from the AD/DA measuring menus to AD/DA Basic

Settings to alter settings. To quickly return to the previous menu The ↵ key is used to

quickly return to the previous menu .

The output level can be set in Level in the measuring menus relative to the fullscale output

value. This can also be set in the AD/DA Basic Settings menu in DA fullscale. A

D/A fullscale setting of 0 dBu and a level setting of -10 dB for example result in bedeutet

-10 dBu output level. The power amp level is set by the single rotary front-end control

and should be left at +20 dB since this value is not registered by the software and level

references become tampered at inaccurate settings.

AD/DA Basic settings

Hardware M ITADDA16

Input M Line

Port address M $0530 (change and reset on  the ITADDA16
board or search by autodetect (?))

AD voltage range M 109.54 V

DA voltage range M 10.954 V

AD sampling rate 7 44.1 kHz or 48 kHz

DA bits $ 16

AD/DA clock M Internal

Trigger active M No

DA clock always int: M yes

AD inputs 7 Left/right/stereo

Frontend M Robo

AD fullscale 7 See Table 14
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AD/DA Basic settings

DA fullscale 7 See Table 14

Remote M int

Auto range 7 Yes

DA inv. R channel 7 No

Overlapped AD $ M no

Table 13 AD/DA basic settings for example measurements

For frequency response measuring the test object inputs and outputs are connected to the

front-end. XLR-RCA or XLR-MDP adapters with an internal bridge between XLR pins 1

and 3 must be used for equipment with unbalanced inputs and/or outputs. Also, the test

object gain and maximum I/O levels should be known. The following table provides a

survey of some exemplary units. Input sensitivity is adjustable from -40 dBu up to

+40 dBu to cover nearly every appliication. Only extremely powerful amps provide

output levels higher than +40 dBu. For these an external attenuation cable with a 20 or

40 dB pad is recommended.

Pointer: EQs and similar equipment are especially suitable to discover the MF system

functions since no acoustic artefacts “are on rampage“ in these units and serious damage

by misuse is highly unlikely.

Table 9 shows the measuring menus of the AD/DA main menu and their applications.
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8.2 EQ and Amplifier Frequency Response Measuring

A reference measurement which requires no external connections must be made at the

beginning of a measuring series. Only input sensitivity and the system output level must

be adjusted according to Table 14. All other settings are made in the AD/DA

Frequency Response  menu according to Table 15.

Equalizer     Power Amp     Mic Preamp

typ. input level 0...+20 dBu 0...+14 dBu -60...0 dBu

typ. output level +20 dBu 20...46 dBu +20 dBu

typ. gain 0 dB 20...40 dB 0..60 dB

System output level
Measuring menu
level setting –10dB
fs

-10 dBu -10 dBu -30 dBu

System input
sensitivity
(AD fullscale)

+20 dBu
or Autorange

+40 dBu
or Autorange
(levels > +40 dBu
require an external
attenuation cable)

10 dBu
or Autorange

System output level,
reference measuring

-6 dBu -6 dBu -6dBu

System input
sensitivity, reference
measuring
(AD fullscale)

0 dBu
or Autorange

0 dBu
or Autorange

0 dBu
or Autorange

Table 14 Exemplary settings for frequency response measuring of
EQs, power amps and preamps
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AD/DA Frequency Response

Mode single Single or continuous

measuring

Degree 14 MLS degree
Frequency range resolution:
sampling rate/2degree

e.g.  48 kHz/214 = 2.93 Hz

Pre sends 1 Number of pre-sent MLS

Averaging 4 Number of measurements to

average

Level -10 dB FS Level relative to D/A fullscale

setting

Build imp. resp. post comp Calculate impulse response of

compensated frequency

response again and process

(see also 8.5)

Pre = use the impulse response of
the measured signal path for
windowing

Post =  Calculate impulse

response of compensated frequency
response again and process, i.e. use
test object impulse response for
windowing only

Group delay comp. none Group delay compensation

Window no Impulse response windowing

function

Equalizing file Compensation by reference

measurement
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AD/DA Frequency Response

Equalizing file COMP14.SPK Reference measurement file

name

Smooth no Smoothing

Dynamic range 50 dB Display range

Ref. for 0 dB 1 0 dB display reference

On top 25 dB Upper display edge

Info window no Information window for

measuring

Go for it ß Start measuring

Reference and more .... Set before the first

measurement !

Window for reference

measurement settings

Table 15  AD/DA Frequency Response menu settings

Frequency Response Reference

Degree 14 MLS degree during reference

measurement

Exciter MLS Type of test signal

Origin internal Test signal source

Level -10 dB FS Level relative to fullscale

setting during reference

measurement

Interleave 1 Interleave sampling by

factor..

Equalizing file COMP14.SPK Reference measurement file

name
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Frequency Response Reference

Dynamic range 30 dB Maximum compensation

dynamics

Lower Cut Off 10 Hz Lower compensation

frequency cutoff

Upper Cut Off 22.05 kHz Upper compensation

frequency cutoff

Ref int Internal or external reference

Go for it ! ß Start reference measurement

Table 16 AD/DA Frequency Response Reference menu
settings

The reference measurement is made with settings above and automatically saved in the

COMP14.SPK file. It is strongly recommended to check the bargraph level display below

right on the monitor or to use the Autorange function of the AD/DA Basic settings

menu. The measuring level should be between -20 and 0 dB. One bar equals10 dB. Figure

27 shows an example for degree 14and an internal MLS.Settings: internal ; MLS ; 14
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12

Figure 27 Exemplary reference measurement, degree = 14, file
name COMP14.SPK

This file is automatically used as compensation file for further measurements. For test

purpose the object is bridged. A straight horizontal line should show at 0 dB on the

monitor. Inserting the test object and measuring are the next step. Figure 28 shows the

exemplary measurement of a digital EQ. Phase and impulse response are available at the

same time and their display can be selected in the Domain menu.
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13

Figure 28 Frequency response of the exemplary digital EQ

The phase response (Ctrl P) in Figure 29 shows a strong phase shift that does not

correspond with the minimum phase-shift filter response. The reason is the system

immanent delay of digital equipment (in this case the EQ) which can also be seen in the

impulse response in Fehler! Verweisquelle konnte nicht gefunden werden.. Changing

to the impulse response display is accomplished in the Domain menu or the  Ctrl U

keys.

This initial delay is automatically compensated if Group delay comp. is set to left aligned

in the AD/DA Frequency Response menu. The impulse response maximum is

always moved to the time signal start by cyclic moving of the impulse response in this

setting. Figure 30 Impulse response of the measurement shown in  shows the

resulting phase response which now corresponds with the minimum phase-shift part of

the response in Figure 28. Moving the maximum to the impulse response start can also be

accomplished in the Edit menu. The active cursor is placed on the maximum by

Shift M. The Cyclic Move function in the Edit menu moves the maximum.

Afterwards the cursors must be placed at both ends of the impulse response by

Shift E. To transform the processed impulse response back into the frequency domain

Shift I calls up an IFFT. Ctrl P selects the phase response display which now also

shows the minimum phase-shift part.
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14

Figure 29 Phase response of the measurement shown in Figure 28

15

Figure 30 Impulse response of the measurement shown in Figure 28
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16

Figure 31 Phase response of the measurement in Figure 28 without
delay (minimum phase)
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8.3 Loudspeaker Frequency Response Measuring

8.3.1 Environment

Measuring loudspeaker frequency response requires completely anechoic environment.

Ideally, these would be a full space or half space, e.g. a large outdoor area. Half space

measuring with loudspeaker and microphone placement on the floor theoretically require

a 100% non-absorptive floor. Granite or marble meet this demand at best. Normal

concrete or cobblestone floors are by no means non-absorptive of mid and high

frequencies and cause measuring faults at higher frequencies. Measuring faults must also

be expected by air movement, e.g. wind outdoors or air conditioning in closed rooms

which result in pronounced fluctuations at higher frequencies from measurement to

measurement. Basically, loudspeaker measuring appears to be a difficult affair.

A room with anechoic walls or a sufficiently large full-space around loudspeaker and

microphone within a normal room can be used as compromise solution. In this case

loudspeaker and microphone must be placed on stands. After determining distance (the

larger the loudspeaker enclosure the greater the distance) a test measurement should be

made. With several meters of full space around the measuring set-up disturbing

reflections can usually be cut off by skilful windowing to obtain a valid curve down to

200 Hz. The low frequency response can be complemented by a nearfield measurement

which is uncritical as far as reflections are concerned. Thus the situation is less despairing

than initially expected.

8.3.2 Sensitivity 1W/1m

Usually the frequency response measurement of passive systems should indicate

sensitivity with reference to 1W/1m angeben, i.e. the level a loudspeaker generates on axis

measured a distance of 1m at 1W input power. The input power of 1W refers to the

nominal impedance of 2, 4, 8 or 16 Ohms instead of the actual loudspeaker impedance

that varies frequency-dependent. Instead of rating power it would be more correct to

indicate the effective voltage of 1W input power at the nominal impedance. Sensitivity

2.83Veff /1m would be the appropriate reference of an 8 Ohm loudspeaker..

Loudspeaker and microphone distance and output voltage can be selected at random

when measuring with MF since the program always calculates the corresponding 1W/1m

value. Nominal impedance and distance must be entered correctly, of course. Small

nearfield monitors can be measured from 1m distance without problems. Larger

enclosures require correspondingly greater distances. Otherwise the distance between the
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individual drivers on the baffle is too large compared to the measuring distance. As a rule

of thumb the measuring distance should be at least five times the greatest distance

between the centers of two drivers on the baffle. Depending on driver arrangement

measuring positions may produce more or less pronounced interference effects in the

crossover ranges of the individual ways. Favorable positions are on the tweeter axis, the

center axis between tweeter and midrange driver or midrange driver and woofer. Positions

too far off the tweeter axis may result in insufficient levels at the highest frequencies.

Some measuring experience is necessary to correctly assess conditions and effects.

8.3.3 Test Signals

The measuring signal frequency weighting should be selected depending on the test

object. The energy distribution of a common MLS is even across the frequency range, i.e.

when measuring loudspeakers a large part of the energy is inconveniently fed to the high

frequency way. Another criterion for test signal selection is the spectral distribution of

potential interference. Low frequency interference by wind, machine noise etc.

predominate usually. A common MLS is therefore not very advantageous for

loudspeaker measuring. Choosing a level for sufficient S/N puts an unnecessary strain on

midrange and high frequency drivers. Avoiding excessive high frequency levels usually

results in unsatisfactory S/N below 100 Hz. Prefiltered noise sequences as described in

chapter 4.2.1 (the term “maximum length sequence“ is by definition no longer correct)

are a suitable remedy in most cases. To achieve energy distribution that is more useful for

loudspeaker measuring the level below 400 Hz is increased by approximately 20 dB.

Prefiltered noise signals are selected in the reference measuring menus by setting

Exciter: MLS and Origin: file. They should not be used for small high frequency drivers

such as dome tweeters, slot and ring radiators, however. For those Exciter: MLS and

Origin: internal must be selected. It is also possible to generate custom noise and sweep

test signals with custom spectral distribution. This feature is explained in detail in 8.15.

8.3.4 Reference Measuring

This chapter explains the loudspeaker measuring procedure completely which begins as

usual with a reference measurement. First, the loudspeaker is connected to one of the

front-end power amp outputs. Self-powered loudspeakers are fed by the balanced line

output on the front panel. The respective AD/DA menu item is LS sensitivity -

Reference and more. The monitor should display amplitude response in the

frequency domain (Ctrl M).

The reference measurement is crucial to the MF measuring method. All measuring

components must be incorporated with the exception of the measuring microphone and
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the test object, i.e. the loudspeaker to compensate frequency deviations caused by the

measuring components and the prefiltered test signal during the following measurements.

The microphone is characterized by sensitivity (in mV/Pa) and its frequency response

registered in the microphone compensation file. This leaves the loudspeaker the only

unknown quantity.

The standard setting Ref: int automatically connects the power amp output to the system

input and attenuates the power amp level by 20 dB for reference measuring. System input

sensitivity must be set accordingly in AD/DA Basic Settings (typ. 0 dBu) or

Autorange must be activated in AD/DA Basic settings.

Note: For measuring self-powered loudspeakers the front-end power amp is not required.

The automatic reference measurement which includes the power amp is incorrect in this

case. Therefore Ref: ext should be selected. The loop is no longer closed automatically

and the appropriate input and output on the front must be connected by an XLR cable.

Otherwise the procedure remains the same.

The following table shows all LS sensitivity-Reference and more menu

settings for loudspeaker reference measuring.
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AD/DA LS sensitivity Reference

Mic sensitivity z.B. 15 mV/PA Microphone sensitivity
( refer to microphone
specifications)

Mic equalization MIC-KOMP.SPK Measuring microphone
compensation by
comparative measuring with
reference mic (e.g.. B&K
4165 oder 4135)

Degree 14 MLS degree (14 or 15 for
loudspeakers)

Exciter MLS Test signal type
MLS = maximum length
sequence

Origin intern oder file Test signal source
- prefiltered: file
– unfiltered: intern

Signal file C:\MAXIDAT\
ERDNUß14.DAT

Prefiltered noise sequences
ERDNUß14.DAT or
ERDNUß15.DAT

Level -10 dB FS Level relative to fullscale
setting during reference
measurement

Equalizing file LSCO14.SPK Reference measurement file
name (set automatically)

Mic preamp gain 0 dB External microphone preamp
gain
(if operative, otherwise 0 dB)

Dynamic range 50 dB Maximum compensation
dynamics

Lower Cut Off 10 Hz Compensation low frequency
cut-off



MF Audio Measuring System: Examples                                                                      124/277

                                                                                                                                                       

© by Audio & Acoustics Consulting Aachen V 3.2E printed 12.12.99 11:02

AD/DA LS sensitivity Reference

Upper Cut Off 22.05 kHz Compensation high
frequency cut-off

Ref Int Internal or external reference
- passive loudspeakers: int
- self-powered: ext

Go for it ! ß Start measuring

Table 17 AD/DA LS sensitivity Reference and more
menu settings

The already inverted spectrum resulting from the reference measurement is displayed on

the monitor as shown in Figure 32 left. If microphone compensation is activated the

microphone measurement file is integrated into spectrum calculation (see right curve).

Suitable value-for-money microphones are among others Sennheiser KE4-211-2,

Monacor MCE-2000 or Monacor ECM-30. Figure 32 right shows the Sennheiser

measuring file which indicates the frequency-dependent sensitivity as deviation from the

nominal value (15 mV/Pa @ 1 kHz).

17

Figure 32 Left: Prefiltered MLS reference measurement with and
without microphone compensation
Right: Sennheiser KE4-211-2 compensation file

Attention: During reference measuring utmost care must be taken that distortion or

other measuring faults by inaccurate level settings do not occur. Potential faults will

seriously interfere with further measuring!!!
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18

Figure 33 Reference measurement with system levels too high
(above), accurate (center) and too low (below).

8.3.5 Levels

Input sensitivity is only adjustable by AD fullscale in the AD/DA Basic Settings

menu. The Autorange function may be selected as an alternative to manual setting. The

output level relative to the fullscale output level is selected by Level in the measuring

menus. It can also be found in the AD/DA Basic Settings menu under DA

fullscale. A D/A fullscale setting of 0 dBu and a level setting of –10 dB result in –10 dBu

output level. -10 dBu output level. The power amp gain should be left at +20 dB since this

value is not registered by the software and level references become tampered at inaccurate

settings. The Level setting in the appropriate AD/DA menu provides quick output level

matching. A glance at the bargraph meter on the monitor below right is recommended

after measuring to correct the level if necessary.
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Passive loudspeakers Self-powered
loudspeakers

System output level
during measuring
(DA fullscale 0 dBu)

-10 dBu
(+20 dB of the
internal power amp)

-10 dBu

System input
sensitivity (AD
fullscale)

-40..0 dBu
or Autorange

-40..0 dBu
or Autorange

System input
sensitivity during
reference measuring
(AD fullscale)

0 dBu
or Autorange

0 dBu
or Autorange

Table 18 Input sensitivity and output level settings for
loudspeaker measuring

8.3.6 Loudspeaker Measuring

After the preparations described above the first loudspeaker frequency response

measurement can be made. The window (Window) and smoothing (Smooth) functions

should be switched off for the first measurements. For sensitivity calculation and later

windowing the correct distance should be entered in Mic-LS distance. MF detects

distance automatically from the maximum position of the impulse response if the

measurement is started by Ctrl ↵ instead of ↵. This is necessary only once if

loudspeaker and microphone position remain unchanged. The delay resulting from the

distance between loudspeaker and microphone is automatically compensated according

to the distance entry if the Delay shift option is activated. Simultaneous windowing may

cause overcompensation if the impulse response portion before the maximum moves to

the end of the time signal and is cut off by the window. This can be corrected by entering

a slightly smaller value than the acoustically detected.

The result might be similar to the example in Figure 34 if loudspeaker and microphone are

positioned more or less freely within the room. The frequency response is apparent but

rather uneven, or “ragged“ resulting from reflections off the walls, ceiling, floor etc. that

arrive after direct radiation and cause interference. This is more obvious in the time

domain which is selected by Ctrl U to view the impulse response. Figure 35 shows the

impulse response of the frequency response in Figure 34. Approximately 8 ms after the

direct sound and the dying of the impulse a series of reflections looking like spikes
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appears. The reflections can be distinguished from the dying impulse response by their

particular shape. Spike shapes are generated by high frequencies that have died early in

the impulse response. They should no longer appear after approxmiately 5 ms. To cut off

the spikes from the impulse response after 8 ms an appropriate window was applied.

AD/DA LS sensitivity

Mic preamp gain 0 dB 7 Enter microphone preamp

gain when using external

units

Correct by 0 dB 7 e.g. –6 dB for half space

measuring

LS impedance 8 Ohm 7 Nominal loudspeaker

impedance

(measure to verify if in doubt)

Mic-LS distance 2 m 7 Distance between measuring

microphone and loudspeaker

front (automatically

determined by detect

distance )

Note chapter 8.5 !!

Mode single 7 Single or continuous

measuring

Averaging 4 7 Increase if strong interference

occurs

Level -12 dBu 7 Line output level - note:

internal power amp +20 dB

Build imp. resp. post comp 7 Calculate impulse response

from compensated frequency

response again and process

(see also 8.5)

Pre = use the impulse response of
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AD/DA LS sensitivity

the measured signal path for
windowing

Post =  Calculate impulse

response from compensated
frequency response again and
process, i.e. use the test object
impulse response for windowing

Delay shift < no 7 Automatic

loudspeaker/microphone

delay compensation (see also

8.5)

Window no 7 Turn off window and check

impulse response first

Equalizing File lsco14.spk 7 Reference measurement file

Smooth no 7 Turn off smoothing and

evaluate frequency response

first

Dynamic Range 50 dB 7 Standard value = 50 dB

On top 110 dB 7 Set depending on expected

measuring range

Reference and more ... Must always be executed

before a measuring series

Go for it ! ß Start measuring

Table 19 AD/DA LS sensitivity  menu setting
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19

Figure 34 Frequency response in a room with pronounced
interference

20

Figure 35 Impulse response in a reflecting room
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The window was shaped non-symmetrically to pass the impulse response 100% from its

start and cut off completely after 8 ms. Fade-out was to be continuous after

approximately 6 ms instead of  discontinuous. For that purpose the first cursor is placed

on the impulse response time axis at 6ms, the second at 8 ms. The 100% passband is left

of the first cursor, fade-out starts at the 6 ms cursor position, and cut-off is at the 8 ms

position of the second cursor. The window is set after cursor placement by striking W

(=Window). After returning to the frequency response display by Ctrl M and the LS-

Sensitivity menu again the Window option is activated and the window is available

as defined. The window is active during the next measurement which is started simply by

striking ↵. The example set-up result is shown in Figure 37. The interference effects have

nearly disappeard and the frequency response is much closer to that of a loudspeaker.

Switching to the time domain by Ctrl U shows the windowed impulse response (see

Figure 36) without reflections. Unfortunately the windowing has also caused the loss of

low frequency information which can be seen by the early and exceptionally straight

slope below 200 Hz. This effect can be estimated by a rule of thumb: the frequency

domain result is valid above the frequency the wavelength of which is equal to half the

window length. Accordingly, the cut-off frequency is 250 Hz  at  a window length of

8 ms.

The Edit signal processing menu contains the Apply Window function for time

signals to apply the window to already existing measurements. If the frequency domain is

active, i.e. if a frequency response is displayed, the impulse response must be calculated

first by an inverse Fourier transformation (IFFT). It requires 2n+1 values between the

cursors which must be positioned at both ends of the spectrum at 0 Hz and half the

sampling rate (22k05 at 44k1). They are placed automatically in the frequency domain by

the Entire function of the Display menu or the ↑E keys. The number of frequency

lines between the cursors is shown under total bins (e.g. 8193) on the monitor below

right. The IFFT is calculated by the Trans menu and IFFT or directly by striking the

Ikey.

The display changes automatically to the time domain and the impulse response appears

on the monitor. The impulse response is shown in its entire length by striking the ↑E key

combination. The windowing process is similar to the description above. The cursors are

placed at both ends of the window range and activated by Apply Window. The

Blackman-Harris 3-Term is a standard window function which is applied asymmetrically

on the right in this case. The settings are Slope=right and Range=cursor.



MF Audio Measuring System: Examples                                                                      131/277

                                                                                                                                                       

© by Audio & Acoustics Consulting Aachen V 3.2E printed 12.12.99 11:02

21

Figure 36 Impulse response, window length 8 ms

22

Figure 37 Frequency response resulting from the windowed
impulse response
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The problem of insufficient resolution inevitably remains after the explanation of

windowing. Complementary nearfield measuring offers a solution for frequencies with

long wavelengths relative to driver dimensions. The measuring microphone is placed very

close to the driver cone (≈0.5cm) to ensure that direct radiation is dominant over all

reflections. Due to the substantially higher level in front of the driver input sensitivity

must be adjusted accordingly to prevent overload. The environment does not play a part

in this set-up. Unfortunately, this practical method is suitable for measuring very low

frequencies only, i.e. if the cone still vibrates as a unit, no cone resonances occur and

diffraction has no effects. Also, no definitive statements can be made on loudspeaker

sensitivity or phase relations. These can be established, however, by combining nearfield

and full-space results. Level and phase relations are provided by full-space measuring

while the nearfield measurement supplies the necessayry low frequency information.

The following example explains the nearfiel measurement of a small bass reflex

loudspeaker. Both cone and vent must be individually measured since the vent

contributes to bass radiation. Both files are saved separately and added subsequently.

First, weighting of the files relative to surface area must be calculated by extracting the

root of the relation between the radiating surfaces. The vent area is calculated by the

actual aperture size. The cone radius is measured by including half of the suspension.

Independent of shape (cone, dome) a level circular surface area is always calculated, not

the actual surface. The cone surface of the test object is 227 cm², the vent area 50 cm²

resulting in a relation of (50/227)½ = 0.47 equivalent to –6.57 dB. This is the multiplying

factor for the tunnel measurement. For editing measuring results the cursors must be

placed at both ends of the range that is to be processed. In this case the complete tunnel

measurement spectrum is to be multiplied so the cursors are positioned at its ends by the

↑E combination. The factor is entered in Multiply  in the Edit menu. Next, the file

must be saved again, and the level change should be entered in the comment line for

convenience. Access to the comment line is gained by striking the K key. Adding both

nearfield measurements ist the next step. For that purpose one file is loaded, the second is

added by the Read-Block function of the Edit menu. This is a fundamental MF

function that allows adding files to a loaded file which might already contain several

curves. The new files can be attached as further channels or mathematically linked to the

already loaded files, i.e. added. Figure 38 and Figure 39 show the individual cone and

tunnel measurements, Figure 40 shows the total of both curves. Attention: for addition

the complex add function must always be used instead of the add mag function that only

adds magnitudes. The result is saved as a nearfield measurement in a new file, an

appropriate comment should be entered.
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23

Figure 38 Nearfield measurement in front of an 8“ cone

24

Figure 39 Nearfield measurement in front of the vent
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25

Figure 40 Nearfield measurement total incl. surface area weighting

26

Figure 41 Nearfield and windowed full-space measuring
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Combining the recent nearfield measurement with the full-space measurement is the last

step. The combination process is as follows: the file loaded first covers level, phase

relations and the range between the blend frequency and the upper cut-off. The second

file covers the range between 0 and the blend frequency, i.e. the full-space measurement

is loaded first in this case. The nearfield measurement is loaded next by the Read-

Block function. The blend frequency can be selected in Modus combi. A suitable

frequency can be found by loading both files and normalizing them to a common value,

i.e. the full-space measurement is loaded from the file menu, and the nearfield

measurement is loaded as second channel in Mode new channels by the Read-Block

function. Next, both curves are normalized to a common value at the active cursor

position by the Edit menu Normalize function. The blend frequency should be in a

range where both curves largely correspond. Figure 41 shows the exemplary full-space

and nearfield measurements. A suitable frequency range for combination can be seen

between 200 and 300 Hz. Both measurements were finally combined at 220 Hz resulting

in the curve in Figure 42. What seems to be a complicated procedure soon becomes

routine. It is important to gain a lot of experience measuring loudspeakers to correctly

assess results and the validity of a measurement. A basic rule is, sudden peaks and rapidly

changing minimums and maximums are usually artificial products of the measuring set-

up and cannot be attributed to the loudspeaker.

27

Figure 42 Nearfield and full space measuring combined at 220 Hz



MF Audio Measuring System: Examples                                                                      136/277

                                                                                                                                                       

© by Audio & Acoustics Consulting Aachen V 3.2E printed 12.12.99 11:02



MF Audio Measuring System: Examples                                                                      137/277

                                                                                                                                                       

© by Audio & Acoustics Consulting Aachen V 3.2E printed 12.12.99 11:02



MF Audio Measuring System: Examples                                                                      138/277

                                                                                                                                                       

© by Audio & Acoustics Consulting Aachen V 3.2E printed 12.12.99 11:02

8.4 Impulse and Step Response Measuring

While phase and frequency values are shown along the frequency axis a step response

curve shows the sound pressure level resulting from a voltage jump along the time axis.

The same applies to the impulse response where loudspeaker response to a very short

voltage impulse is measured. Each of the curves, i.e. complex frequency response

including phase response, impulse and step response contains identical information on

the measured system and can be transformed into the others without loss. The impulse

response is mathematically calculated from the complex frequency response by an

inverse Fourier transformation while the step response is calculated from the impulse

response by a time integration. Conversely the impulse response is calculated from the

step response by differentiating, and the complex frequency response is calculated from

the impulse response by a Fourier transformation.All display types can be generated just

as easily in the frequency and time domains. During  normal measuring the impulse

response is calculated before the complex frequency spectrum from the sampled signal.

The frequency spectrum is multiplied by the compensation spectrum next. The impulse

response calculated previously has not been compensated yet and shows the response of

the complete measuring distance instead of the exclusive test object response which may

deviate more or less from each other. After switching the measuring menu Build imp res.

option to post comp the impulse response is calculated again from the compensated

frequency spectrum. The key combinations Ctrl M for magnitude, Ctrl P for phase

and Ctrl U for impulse response allow switching between the displays. The step

response is displayed by selecting the calculation in the Edit menu under Integrate

if the impulse response is shown in the time domain. Depending on the total time signal

length there is not much to recognize at first in the impulse or step response display. For a

better view it is recommended to place the active cursor close to the step or the impulse

start and to zoom in or out of the display by the + and – keys. Figure 43 up to Figure 46

show the amplitude and phase response of three exemplary systems and the

corresponding impulse and step responses.



MF Audio Measuring System: Examples                                                                      139/277

                                                                                                                                                       

© by Audio & Acoustics Consulting Aachen V 3.2E printed 12.12.99 11:02

28

Figure 43 Amplitude response of three exemplary loudspeakers

29

Figure 44 Phase response of three exemplary loudspeakers
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30

Figure 45 Impulse response of three exemplary loudspeakers

31

Figure 46 Step response of three exemplary loudspeakers
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8.5 Impulse Response Pre- and Post-comp and Delay Shift Options

All measuring functions with reference files for frequency response measuring,

loudspeaker sensitivity, polar measuring etc. provide the switchable option Build Impulse

Response pre- or post-comp. To understand this option the measuring process must be

explained. After selecting a test signal a reference or system measurement is made. The

result is saved as a complex frequency response in a compensation file. The reference

measurement for polar measuring with activated Normalize to 0° option is the on-axis

frequency response measurement. Later compensation by the reference file does not only

correct frequency and phase response but also compensates system and group delay.

Measuring with pre-comp or post-comp setting is basically as described in Table 20.

The relation between delay compensation and impulse response windowing deserves

special mention. When pre-comp is selected the window is applied to the impulse

response of the entire measuring period including system (1-2 ms) and test object delay.

The adjustable Group delay comp. Offset, i.e. the delay between loudspeaker and

microphone, is subtracted only, if the Delay shift option is activated. An example is

shown in  Figure 47. The impulse is delayed by approximately 1.3ms due to system delay

that has not been compensated yet by the Build impulse response = pre comp setting.

The delay resulting from the distance between loudspeaker and microphone has been

subtracted already since the Delay shift was activated. Figure 48 shows the measurement

with identical settings and additionally activated windowing to cut off the subsequent

reflections.

If post-comp has been selected the window is applied to the impulse response that has

been processed by the reference measuring compensation file, i.e. system delay and

potential delay offset have already been compensated. The maximum impulse response

peak is usually the first sample. Figure 49 shows the measurement in Figure 48 with post

comp setting. Since all delays have been subtracted the impulse response is that of the test

object.

Usually, impulse response windowing is only necessary for measurements in

reverberating environment. Because of driver arrangement however, portions of the

impulse response may already occur before the maximum. Without delay compensation,

this effect can be caused by a horn-loaded high frequency driver that is recessed from the

mid/low driver. Problems arise in conjunction with the Detect Distance and a window.

The Detect Distance automatically determines the distance between loudspeaker and

microphone by the distance between 0 and impulse response maximum. Usually, the
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acoustic center of the high-frequency driver is the deciding factor. If the detected distance

is used for delay compensation the impulse response peak moves to the start of the time

signal when post comp is selected, and the correct minimum phase of the high frequency

driver is calculated when determining phase response. However, if a window function is

applied to evaluate the forepart of the impulse response and to cut off the rest, potential

portions before the peak are cut off by the window because they have been shifted to the

end by the cyclic impulse response movement during delay compensation.

This effect can be avoided by entering a value slightly smaller than that determined by the

Detect Distance function if a window must be applied to the measurement. Of course,

the actual distance between loudspeaker baffle and measuring microphone can be

measured and entered to assure that no early impulse response portions are cut off by a

window.
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32

Figure 47 Frequency and impulse response measured with pre-comp and
Delay shift setting; frequency response compensated only, the 1.3ms
system delay is evident in the impulse response.

33

Figure 48 Frequency and impulse response measured with pre-comp and
Delay shift setting; additionally a window cuts off impulse response
reflections.

34

Figure 49 Frequency and impulse response measured with pre-comp and
Delay shift setting; additionally a window cuts off impulse response
reflections. The impulse response is that of the loudspeaker
exclusively.
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35

Figure 50 Frequency and impulse response measured with post-comp and
Delay shift setting and window with actual distance measured
between microphone and loudspeaker (d=0.55m).

The current version of the program provides a Delay shift option to deactivate the

loudspeaker/microphone delay compensation.

Without the Delay shift option the impulse response with delay caused by the distance

between loudspeaker and microphone is shown. Windows can be easily placed to cut off

disturbing reflections. If Delay shift is activated the minimum phase of a loudspeaker is

still displayed. However, windows should be selected and placed carefully.

For most applications it is recommended to use the Build impulse response = post comp

and Delay shift = no settings. With these settings the impulse response shows the exact

delay between loudspeaker and microphone, system delay has been subtracted and

frequency response has been compensated accordingly.
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Pre-comp signal processing Post-comp signal processing

1. AD/DA
A 2n-1 value test signal is sent across the measuring
distance and recorded

AD/DA
A 2n-1 or 2n value test signal is sent across the
measuring distance and recorded

2. FHT
Calculates the impulse response of the full
measuring period
Only for 2n-1 value test signals

FHT
Calculates the impulse response of the full
Measuring period
Only for 2n-1 value test signals

3. Delay (opt.)
If the delay shift option is activated during
loudspeaker measuring, the delay resulting from
sound velocity and distance between microphone and
loudspeaker is subtracted

Delay (opt.)
If the delay shift option is activated during
loudspeaker measuring, the delay resulting from
sound velocity and distance between microphone
and loudspeaker is subtracted

4. Window (opt.)
An optional window is applied

5. FFT
The complex frequency response is calculated from
the impulse  response

FFT
The complex frequency response is calculated from
the impulse  response ( 2n-1 signals) or directly from
the input data sampled by the system (2n signals)

6. Comp
The complex response of the total measuring period
is divided by the compensation file resulting in the
complex response of the actual test object and
compensating the system delay.

Comp
The complex response of the total measuring period is
divided by the compensation file resulting in the
complex response of the actual test object and
compensating the system delay.

7. IFFT
An inverse Fourier transformation calculates the test
object impulse response from its complex cfrequency
response

8. Window (opt.)
An optional window referring only to the test object
impulse response is applied

9. FFT
A FFT calculates the complex test object frequency
response again from the windowed impulse response

10. Smooth (opt.)
Optional smoothing may be applied with different
parameters to magnitude, delay or both.

Smooth (opt.)
Optional smoothing may be applied with different
parameters to magnitude, delay or both.

11. Displaying the results
Frequency response (Ctrl M)  Phase response (Ctrl P)  Delay (Ctrl L) Impulse response (Ctrl U)

Table 20 Pre- and post-comp setting steps
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8.6 Generating Decay Response Spectra

Decay spectra provide additional information on loudspeaker time response that cannot

be gained from from frequency and ohase response. Cone resonances and break-up or

dips and peaks are easier to detect in decay spectra than in impulse and frequency

response curves. The loudspeaker characteristics shown in a decay spectrum are basically

contained in and calculated from the impulse response. It is only the layout of the graph

that provides additional information. To calculate frequency response, a fixed section or

the complete loudspeaker impulse response is transformed into the frequency domain by

an FFT. To generate a decay spectrum, a shorter time window is superimposed on the

impulse response and transformed in fixed intervals. The individual frequency spectra are

shown consecutively in a three-dimensional diagram. A time axis (z-axis) complements

the usual frequency (x-axis) and level (y-axis) axes.

The graph which resembles a waterfall indicates the dying rate of loudspeaker vibrations

depending on frequency. The ideal case is a loudspeaker that dies as quickly and

consistently as possible at all frequencies. Normal loudspeakers, however, usually

produce a rather rugged waterfall graph with varying numbers of resonances of varying

length. Resonant frequencies stand out as towering peaks. The example in Figure 52

shows the decay spectrum of the loudspeaker frequency response in Figure 51. It is

apparent how single peaks result from resonances, e.g. 600 and 800 Hz. Also, the

increasing delay caused by the high pass characteristics of the loudspeaker is obvious

which must not be mistaken for a resonance.

For those reasons the decay spectrum should always be considered when evaluating a

loudspeaker. For decay spectrum calculation a change to Maxils is necessary. This

program requires a time signal file containing the loudspeaker impulse response to

calculate the decay spectrum. The file format must be ITA with header and 2 byte values

and the file must contain no more than 4096 values. MF generates such a file easily from

a loudspeaker frequency response measurement. The full frequency spectrum must be

transformed into the time domain (↑E to include all values between the cursors, I next to

start the inverse FFT) and the first 4096 values must be saved as a new impulse response.

The Write Block function of the Edit menu saves any section between the cursors as a

new file. The left cursor is placed on the first sample, the right cursor on sample 4096.

Jumps to cursor distances of 2n are easily accomplished by the tab keys. After cursor

placement the section in between is saved in ITA 2 byte format for time signals by

Write Block in the Edit menu. It is useful for further processing if the impulse

response maximum is within the first 2-4 ms. The resulting file should consist of 8448

bytes after saving. The oversensitive character of Maxils requires exactly this size and
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format and nothing else. The impulse response peak should be in the initial range as

shown  in Figure 51. If the peak is at the far end of the impulse response after IFFT, i.e. if

it is not among the first 4096 samples, the time signal must be moved by the

Cyclic Move function of the Edit menu. The active cursor (yellow) must be placed

shortly (2-4 ms) before the impulse response maximum for that purpose.

8.6.1 Maxils

It is necessary now to exit MF and to start Maxils which is possible in DOS mode or

Windows. Since Maxils distinguishes automatically between spectrum files and time

signals the MF time signal including the loudspeaker impulse response can be loaded

directly by the File-load menu. The impulse response which should look the same as

the first impulse response section saved in MF can be surveyed in the Display-

impulse response menu. An intermediate step is the subtraction of a potential DC

offset from the impulse response by the Evaluate-Offset function. By Display-

Decay spectrum this is shown more or less as required. Under normal circumstances

modifications of the display are necessary to meet particular demands. Adjustments such

as window function and scaling of the time, frequency and level axes can be made in

Settings-Options-Parameters(Dec).
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Decay response parameter options in Maxils

Menu item Function

Alpha window function 7 0..1              time window size
0=0% (square window)
1=100% (sym. Hanning window)
0.1=10% (sym. Hanning window with 90%

pass range)

Number-Steps 7 Number of spectra (1..40)
i.e. time axis resolution

Impulse response length $ Impulse response length by the number of
samples loaded (standard value = 4096)
2n values no higher than 4096

FFT length $ Time window length (standard value = 2048)
2n values no higher than 2048

Divisor-2 7 FFT length = impulse response length/2

Divisor-4 7 FFT length = impulse response length/4

Divisor-8 7 FFT length = impulse response length/8

Divisor-16 7 FFT length = impulse response length/16

Zoom factor 7 Zoom factor = 1, time window covers the
complete impulse response
Zoom factor = 4, time window covers the initial
impulse response zoomed by 4

The number of steps remains constant

Delay 7 The offset at  the initial impulse response is
subtracted, a corresponding offset is added to
the time axis

Normalized display 7 Maximum of all spectra = 0 dB
Delay response is calculated twice for
normalizing
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Decay response parameter options in Maxils

Lower cutoff 7 Low frequency limit of the display

Upper cutoff 7 High frequency limit of the display

Level scale 7 Decay response level scale
(Standard 30 dB =  –25..+5 dB)

Table 21 The decay response parameter menu in Maxils

36

Figure 51 Impulse and frequency response for decay response
calculation

37

Figure 52 Impulse and decay response (zoom factor 5) in Maxils
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38

Figure 53 Time windows, moved for individual spectra (start
position 0 ms ; center 22 ms ; final position 46.4 ms)

Figure 51 shows the frequency response in MF and the first 4096 samples of the impulse

response from which the decay spectrum is to be calculated. The impulse response

maximum is approximately 2.5 ms after the time signal start. There is no danger of cutting

off the maximum in the first spectrum by windowing. The Maxils standard setting is a

window length of  2048 samples with a range of 10%, i.e. a symmetrical pass band of

90%. The pass band of the  first window starts at 2.322 ms, i.e. after 103 samples The

window movement across the impulse response from start to end is shown in Figure 53

with the standard setting and zoom factor 1. For the display in Figure 52 a zoom factor of

5 was chosen for the time axis. As can be seen by the time axis beginning at 0 ms a zero

offset was selected for the decay spectrum in Figure 52. The lower and upper limits of the

frequency axis are 20 Hz and 20 kHz respectively. The level range is 30 dB.

When using Maxils the accessory graphics driver VGA16.BGI or EGAVGA.BGI must be

in the directory set in the Path-BGI item of the File menu.
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8.7 Polar Measuring of Loudspeakers

Polar measuring establishes the planary dispersion of a sound source. Levels are shown

relative to angle in a circular diagram ( Figure 54). Frequencies are distinguished by

multiple curves. Resolution in octave steps requires 9 polar plots for instance, and  1/3

octave resolution requires 27 polar plots. 1/3  and octave resolution are usually shown

with sufficient clarity in a polar plot. For three-dimensional diagrams or  graduating-color

level displays a frequency axis must be determined. A two-dimensional isobar display

and a 3D display of planary dispersion are shown  in Figure 55 und Figure 56.

39

Figure 54 Standard 1 kHz octave polar plot including 1/3 octaves
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40

Figure 55 2D isobar directivity plot of a singular plane

41

Figure 56 3D isobar directivity plot of a singular plane

Two basic kinds of polar measuring display must be distinguished. The first version

shows all values relative to on-axis measuring at 0°. In this case frequency response at 0°

is always completely linear and level is 0 dB at all frequencies. The deviation from on-axis

measuring  is indicated by angle.
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The second version displays absolute levels relative to a predetermined value, i.e. the

actual frequency response at any angle is shown. The appropriate version is selected by

the type of reference measuring. For the display relative to on-axis measuring the

measurement is made in the 0° position across the full distance including loudspeaker if

Normalize to 0° has been selected. Additional reference measuring is not required. For

absolute levels, however, an initial reference measurement is necessary. This is identical

to normal loudspeaker measuring in the AD/DA LS sensitivity menu.

The Excel macro processes the relative display only. For absolute display the scaling

must be changed in the POLMAKRO.XLS file or directly in the display. The relative

display usually causes problems if frequency dips resulting from interference effects are

on the center axis. These can often be seen on the vertical plane of polar measurings.

Dispersion in this frequency range seems to widen relative to the particular dip although

this is not the case when absolutely viewed.

8.7.1 Polar Measuring Steps and Variations

Four output files are selectable for polar measuring. The first (with the usual extension

".SPK")  generates normal FFT spectra, i.e. an individual spectrum is registered for each

measurement. Spectrum names are generated automatically and include the vertical and

horizontal measuring angles (VxxxHxxx.SPK). Since 3 figures are available only for each

angle 360° are added to negative angles, e.g. the name of a measurement with a vertical

angle of -30° and a horizontal angle of150° is V330H150.SPK.

The comment line for these spectra is also generated automatically and contains the

following data: manufacturer and test object name as entered in the Polar data setup

window followed by "Polar Resp." And the angles "Ver xxx°" and "Hor yyy°". If

manufacturer and name require more than 39 of the 71 comment characters the name is

abbreviated to leave room for the angle entries.

Spectrum name and comment line are also generated if "Excel-ASCII" or "UNF+GDF"

have been selected as output format. In this case, however, the spectrum files will not be

saved. To save individual spectra the high frequency resolution of FFT spectra is usually

favorable. The Smooth switch (its accompanying parameters add the spectral lines to

result in steps of constant relative bandwidth) should be set to no.

Another possible output format is "POX" which contains the polar measuring levels for

the Excel spreadsheet. It is currently defined for measuring in a singular plane only.

When selecting quarter space, half space or full space the data of the other vertical planes

are also written into this file one below the other. The file is no longer macro-compatible
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but it can be easily split by an ASCII editor. For that purpose the horizontal angles in the

first column are helpful.

The third possible output  simultaneously generates the "Ulysses Native Format" (UNF),

and "Generic Device Files" (GDF) still used by EASE. To generate valid files quarter

space measuring is necessary at least although they are generated by Monkey Forest

when measuring in the horizontal plane only.

Both ASCII files are generated AFTER finishing the measuring series. Before measuring,

a 0 signed binary file is set up with all measuring positions and frequencies. It contains

levels in dB without header in IEE 754 Single Precision (32-bit) floating point format  (as

array [Ver][Hor][Freq]) and can be easily read in by custom programs. After each

individual measurement of the series the file is opened to register levels relative to

position. After saving it is closed again to prevent the loss of all data saved so far in case

of intentional or unintentional abort (e.g. by mains fuse triggering). Measuring is simply

started again and, by striking the '+' key,   the vertical angle is set to the recent plane that

has not been saved completely. The binary file is NOT initialized again in this case (i.e. if

name and size remain) and maintains the levels already saved. They are complemented by

the following measurements. This feature is also practical if a fault becomes apparent

during graphic editing after measuring has been completed. The measurement of the

vertical angle in question is simply repeated. After reaching the faulty horizontal angle the

measurement can also be aborted by the ESC key during horizontal measuring.

The binary file prefix is identical to that of the UNF  and GNF files, the extension is

".TMP". Despite the temporary file identification it is not automatically deleted by

Monkey Forest and remains available for completion by partial measurements later on.

When entering the "Device Name" the first eight characters are used automatically for the

output file prefix (POX, TMP, UNF and GDF), i.e. it must not be entered separately.

However, it can be changed anytime if so required.

In many instances polar measurements require windowing. When accessing the "Polar

Response" menu the window parameters are automatically copied from the "LS

sensitivity" submenu. The best settings can be found experimentally by various

loudspeaker measurements.
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8.7.2 Rotary Plate

Measuring the dispersion characteristics of a loudspeaker (directivity) at varying angles

requires a rotary mechanism for loudspeaker or microphone. Usually, the microphone is

at a fixed position while the loudspeaker is rotated, e.g. by a simple manually operated

mechanism. The Italian manufacturer Outline offers a rotary plate with an excellent

cost/performance ratio which is automatically triggered by MF. The control unit (ET1) is

connected to the parallel PC interface (LPT1:) by a special cable and set to the desired

interval (e.g. 5° or 10°). The cable must be wired as follows:

LPT1: D-Sub connector (male) 25 pin to PC

ET1: D-Sub connector (male) 9 pin to control unit

D-Sub25 pin 6     to D-Sub9 pin 2

D-Sub25 pin 18    to D-Sub9 pins 4+5

Since the plate position is not reported back to the program the rotary plate must be set to

a defined start position by the control unit before measuring, i.e. the 0° position. Setting is

accomplished by Turn table select under Polar Response in the AD/DA

menu. Moved by You can be selected alternatively to position loudspeaker or microphone

manually between measurements.
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8.7.3 The Polar Response Menu

The polar response menu settings in AD/DA are shown in the following table. Many

settings correspond with those of the LS-Sensitivity menu. Also, measuring itself is

largely identical to the AD/DA LS sensitivity menu item. Window functions set in

AD/DA LS sensitivity are automatically copied to the Polar Response menu,

i.e. windows set in LS sensitivity can be used for polar measuring.

AD/DA Polar Response

Measurement Conditions

Mic preamp gain 0 dB 7 Enter microphone preamp

gain when using external

units

Correct by 0 dB 7 e.g. –6 dB for half space

measuring

LS impedance 8 Ohm 7 Nominal loudspeaker

impedance

Mic-LS distance 2 m 7 Distance loudspeaker - mic

Setups

Turn table select Rotary plate settings

Polar data setup Measuring method and data

format selection

Reference and more ... Reference measuring

(N/A for Normalize to 0°)

Excitation

Averaging 4 7 May be increased if strong

interference occurs

Level -12 dBu 7 Line output level - note:

internal power amp +20 dB
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AD/DA Polar Response

Impulse response processing

Build imp. resp. Pre comp 7 Pre = use the impulse response of
the measured signal path for
windowing

Post =  Calculate impulse

response from compensated
frequency response again and
process, i.e. use the test object
impulse response for windowing
(see also 8.7.4)

Delay shift < no 7 Automatic loudspeaker – mic

delay compensation (see also

8.5)

Window No 7 Impulse response window

function

Caution: use only in pre-

comp setting with Normalize

to 0°

Spectral processing

Equalizing File Polco14.spk 7 Reference measurement file

for polar measuring

When normalizing to 0° this file
contains the 0° measurement

Smooth Yes 7 Automatic smoothing

depending on resolution, e.g.

1/10 octave

Display

Dynamic Range 50 dB 7 Level scale

On top 110 dB 7 Set depending on the

expected measuring range
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AD/DA Polar Response

Go for it ! ß Start measuring

Basic settings # Go to AD/DA basic settings

menu

Quit Quit polar menu

Table 22  AD/DA Polar Response  menu settings

Polar Response Settings

Vertical Coverage

Sphere 7 Horiz.only measure one
plane only for polar plots and 2D or
3D isobar displays

¼ space measure ¼  spherical
grid

½ space measure ½  spherical
grid

full space measure full spherical
grid

Angle range $ Vertical angle range
(adjusts automatically)

Angle step 7 Vertical angle resolution =
horizontal angle resolution

Horizontal Coverage

Angle range ± 90° 7 Angle range:

±90° for isobars

±180° for polar plots

otherwise 0...180° for grids

Angle step 5° 7 Angle resolution,

standard = 5° or 10°
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Normalize to 0° Yes 7 Normalize all measurements
to center axis (0°)
Do not use with post-comp
settings and window
functions !!!

When selecting No a
reference measurement must
be made

Skip 0° No 7 Set measuring series

automatically to 0 dB when

normalizing to 0°

Frequency range

Lower cut off 15.6 Hz 7 ASCII file low frequency cut-

off: 15.6 Hz

Upper cut off 21.2 kHz 7 ASCII file high frequency

cut-off: 21.2 kHz

Frequency steps 1/10 – octave 7 Frequency resolution:

1/10 oct. for isobars

1/3 oct. for polar plots

Output File

Output Spk/Excel-Ascii 7 Save all angles in a spectrum

file (ITA format) or save all

values under Excel in an

ASCII file for processing

Ascii file name XXX-HOR.POX 7 ASCII file name

File extension adjusts

automatically

Device name Loudspeaker type (for ASCII

file comment)

Manufacturer Manufacturer name (for
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ASCII file comment)

Quit Return to polar response

menu

Table 23  Polar Response Settings  submenu

The distance between microphone and loudspeaker must be sufficiently great for polar

measuring to prevent separation between individual drivers. As a rule of thumb

measuring distance must be at least five times the greatest distance between the centers of

two drivers on the baffle. In 0° position the center axis of the enclosure must be aligned to

the microphone. This is usually the main direction of dispersion. If dispersion

characteristics are non-symmetrical to the center axis, i.e. the geometrical axis is not the

main direction of dispersion (various downfills have been designed that way on purpose)

the measuring set-up should still be aligned to the geometrical axis.
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8.7.4 Polar Measuring Windows

Polar measuring in non-anechoic environment requires windowing. Small loudspeakers

can be placed in 2m height by a stand on the rotary plate. The microphone which is also

mounted on a stand in 2m height is placed 1-2 m away. At 1m distance direct radiation

arrives after approximately 2.9 ms while floor reflections travel a distance of 4.47 m and

arrive after13 ms. A window must be applied to the impulse response of this set-up which

is non-symmetrical on the right and cuts off no later than 10ms after direct radiation.

At this stage a problem may occur. In the post-comp setting a window exclusively refers

to the impulse response of the measurement, i.e. windowing in this setting cuts off the

peak immediately even at minor movement towards the end since the measuring result

contains deviation of magnitude and delay from the center axis only. For windowing

polar measurements the pre-comp setting in Build imp. resp. must always be

selected. In this case the window is applied to the impulse response before compensation

by the reference measurement. For the above set-up example a window must be applied

which is non-symmetrical on the right and cuts off completely after 13ms. The best

possible window placement can be found in advance by an AD/DA LS sensitivity

measurement. It is automatically copied for polar measuring application. The

Build imp. resp. setting must be pre-comp in both cases.
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8.7.5 Processing by Excel 5.0

Two polar measuring formats must be distinguished for further evaluation. The first

covers an angle range of -90° - +90° with a 5° resolution, i.e. the spreadsheet contains 37

lines assigned to the individual angles.

The frequency range is 15.6 Hz - 21112.1 Hz in 1/10 octave steps, i.e. the spreadsheet

contains 105 frequencies with their own columns each. An Excel 5.0 macro

(PP Directivity) generates 2D and 3D directivity plots as shown in Figure 55 and

Figure 56 from this spreadsheet. It is absolutely necessary to keep the lower and upper

angle and frequency range values and the number of values. The spreadsheet contains

levels in dB relative to 1W and 1m or levels relative to the 0° value . Table 24 shows a

section from an ASCII spreadsheet for polar measuring as generated by MF. Each

spreadsheet is prefixed by a 7-line header which contains informationen on the data

format.

The second format covers an angle range of -180° - +180° in 73 or 37 steps respectively at

5° or 10° resolution, frequency resolution is 1/3 octave. The spreadsheet contains 32

frequencies from 15.6 Hz - 20158.7 Hz. The accompanying macros are Polarplots5°

and Polarplots10°. The ASCII files can be loaded in Excel as user-defined. The

valid data range begins in line 8 with the frequency line. Displays generated by Excel can

easily be processed as PCX praphics.

f[Hz]-> 15,6 16,7 17,9 19,2 20,6 22,1 23,7 25 ......

 -90ø -22,2 -22,4 -27,9 -30,6 -26,7 -25,4 -28,8 -29,7

 -85ø -21,1 -17,8 -16,9 -17,9 -22,9 -25,6 -24,3 -25,2

 -80ø -25 -21,7 -21,9 -22 -22 -23,9 -29,2 -25,5

 -75ø -22,3 -20,6 -21,1 -21 -19,6 -20,8 -26,4 -24,9

 -70ø -20 -20,7 -27,5 -31,1 -27,2 -26,7 -32,2 -29,6

 -65ø -19,7 -19,2 -23 -26,6 -29,5 -30,8 -29,5 -26,1

 -60ø -25 -23,8 -24,6 -23,9 -19,6 -20,6 -30,7 -29,6

 -55ø -17,7 -16,1 -15,5 -13,9 -9,9 -9,1 -13,5 -22,2

 -50ø -17,5 -18,7 -24,3 -26,5 -20,8 -17,8 -19,4 -21,5

 -45ø -20,8 -25,1 -37,2 -41,6 -28,4 -20,6 -22,1 -25,4

 -40ø -22,8 -22 -28,3 -32,2 -30,3 -30,7 -34,9 -33,9

 -35ø -25,9 -28 -36,6 -40,6 -34,1 -29,3 -27,5 -26

 -30ø -18,1 -19,2 -25 -28,6 -27,2 -26,2 -25,7 -29,6

....

Table 24 ASCII spreadsheet section of a polar measurement,
across = angles, down = frequencies
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8.8 Measuring and Evaluating UNF and GDF Data

This chapter is currently in preparation. However, all functions are fully featured by MF

already  (see previous chapter).

42

Figure 57 3D UNF file displays from Ulysses (Ulysses © by IFB), 4 kHz
octave, 5 dB/div, resolution 5°
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8.9 Measuring Maximum SPL and THD of Loudspeakers

Apart from frequency response and directivity the maximum sound pressure level (max.

SPL) is one of the most important characteristics to evaluate loudspeaker performance.

This value determines the ability of a loudspeaker to cover a certain spatial area.

Simulation programs require reliable information to calculate sound reinforcement

systems, e.g. to calculate speech comprehensibility in noisy environments.

Calculating the maximum SPL from sensitivity and power handling usually results in

exaggerated levels. This mthod does not allow for many effects such as electrical power

compression, port compression, cone resonances and limited cone excursion. Therefore

these theoretical levels are far from being realistic especially at lower and higher

frequencies.

Complete measuring series which determine THD and SPL along the frequency axis in

intervals are more revealing. In its AD/DA menu, MF provides three distinct methods

using pure sine wave signals to measure THD. After transmission by the test object the

signal is transformed into the frequency domain by an FFT and analyzed which includes

approximately –80 dB THD of the A/D and D/A converters. Measuring the system with

bridged inputs and outputs reveals the limits of this method. However, they are fully

sufficient for loudspeaker measuring with usual THD levels of –60 bis –40 dB at lower

power levels. Attention: The internal amplifier should not be used for loudspeaker THD

measuring due to ist low power of 20 W. Maximum output power and gain of external

amplifiers should be specified and entered in the MF measuring menus if necessary.
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THD+N single f Frequency and level of the sine wave test signal are fixed. Only

THD or the complete noise floor including non-harmonic

distortion, noise and hum (THD+N) are analyzed. The display

refers to fundamental + THD, fundamental + THD+N or a

selectable reference level. It shows the fundamental, THD and the

noise floor as FFT spectrum (see Figure 58) with the resolution

selected in Degree.

THD+N (f) The level of the sine test signal is fixed, its frequency is variable.

Only THD or the complete noise floor including non-harmonic

distortion, noise and hum (THD+N) are  analyzed. The display

refers to fundamental level + THD or + THD+N. It shows THD or

THD+N along the frequency axis (see Figure 59) and harmonic

distortions k if required.

LS max. SPL Frequency and level of the sine wave test signal are variable. Only

THD or the complete noise floor including non-harmonic

distortion, noise and hum (THD+N) are  analyzed. Evaluation

always refers to fundamental level + THD or + THD+N. The

display shows the maximum levels at fixed percentages of THD

along the frequency axis (see Figure 62) This menu item is also

useful for measuring the power bandwidth of amplifiers and

transformers.
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Figure 58 THD and noise at 80 Hz @ 130 dB/1m of an 18“ loudspeaker

44

Figure 59 THD, k2 and k3 of a loudspeaker at a constant input
level eqivalent to 95dB @ 1m @ 1 kHz
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Figure 60 Maximum levels at 1% and 3% THD (the dips at 65 Hz
and 85 Hz result from the measuring room acoustics)
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THD+N single f

Excitation

Mode Single Single or continuous

measuring

Degree 13 FFT length = 213 = 8192

Pre sends 1 Pre-sent measuring periods

without evaluation

Averaging 1 Number of measuring

periods to be averaged

Excitation 1.0013 kHz Exciting frequency
the value is always set to an
integer number of periods within
FFT length

Dither No Add dither to sine wave

signal

Level 0 dB FS ; 20 dBu System output level in dB

FS or dBu

Display

Dynamic range 140 Display range in dB

On top 5 Upper display limit

Normalize to 1V Yes No = The spectrum is

normalized to the reference value

Yes = The spectrum is

normalized to 1V = 0 dBV, i.e.the
levels of all other values are
shown relative to the total of
fundamental +THD or
fundamental +THD+N.
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THD+N single f

Reference S+THD S+THD =  include only

harmonic distortion

S+THD+N = include all

distortion and noise

Info Window Yes Open info window while

measuring

Show THD up to K 3 Show k-values in the info

window up to the selected

number

Table 25 The AD/DA menu THD+N single f
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THD+N (f)

Excitation

Degree 13 FFT length = 213 = 8192

Pre sends 1 Pre-sent measuring periods

without evaluation

Averaging 1 Number of measuring

periods to be averaged

Dither No Add dither to sine wave

signal

Level 0 dB FS ; 20 dBu System output level in dB

FS or dBu

Frequency range

Lower cut off 21.53 Hz Measuring series low

frequency start band

Upper cut off 11.00 kHz Measuring series high

frequency stop band

Steps log Linear or logarithmic

frequency increments

Frequ. increment 1/6-octave Frequency resolution

Display

Dynamic range 140 Display range in dB

Reference S+THD S+THD = include harmonic

distortion only

S+THD+N = include all

distortion and noise
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THD+N (f)

Show THD up to K 3 Show k-values up to the

selected number in the

response curve

Draw every time Yes Draw response curves

during a measuring series

Info Window Yes Open info window while

measuring

Table 26 The AD/DA menu THD+N (f)
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LS max SPL

Measurement conditions

Mic preamp gain 0 dB Enter microphone preamp

gain when using external

units

Correct by 0 dB e.g.. –6 dB for half space

measuring

Mic-LS distance 1m Distance between

measuring microphone and

loudspeaker baffle

PA gain 26 dB External power amp gain

Excitation

Degree 12 FFT length = 212 = 4096

Averaging 1 Number of measuring

periods to be averaged

Dither No Add dither to sine wave

signal

Recovery (max) 2s Interval between two

measurements
Maximum value at reaching the
selected maximum output level,
select corresponding shorter
intervals for lower levels.

DA and PA level range

Minimal < -35 dB FS 0.94 W Initial measuring series

value

( in this case –3 dB FS)
equivalent to 0.94 W at an 8 Ohm
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LS max SPL

load at 26 dB power amp gain

Maximal > -6 dB FS 749 W Measuring series end value
(in this case 0 dB FS)
equivalent to 749 W at an 8 Ohm
load at 26 dB power amp gain

Level increment 1 dB Level resolution

Return to Min - no Start measuring series at

minimum level for each

frequency

Frequency range

Lower cut off 21.53 Hz Measuring series low

frequency start band

Upper cut off 11.00 kHz Measuring series high

frequency stop band

Steps Log Linear or logarithmic

frequency increments

Frequ. increment 1/6-octave Frequency resolution

Display

Dynamic range 50 Display range in dB

On top 140 dB Maximum display level

Reference S+THD S+THD = include harmonic

distortion only

S+THD+N = include all

distortion and noise
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LS max SPL

Show THD up to K 3 Show k-values up to the

selected number in the info

window

Thresholds 3%   10% Show max SPL response at

the selected percentage

Draw every time Yes Draw response curves

during a measuring series

Info Window No Open info window during

measuring

Table 27 The AD/DA menu LS max SPL

An completely anechoic environment is even more important for measuring THD with

sine wave test signals than it is for frequency response measuring. The curve results from

multiple individual measurements with discrete sine wave test signals. If interference with

direct radiation is caused by reflections nearly any measuring fault can occur at individual

points due to phase cancellation. The example in Figure 60 shows interferences at 65 Hz

and 85 Hz where the measuring room was not anechoic. The basic rule in this case is also:

the distance of all reflecting surfaces from the measuring set-up must be great compared

to the distance between loudspeaker and microphone. If no anechoic room is available It

is not always easy to meet this demand when measuring large loudspeakers if no

anechoic room is available. The maximum SPL of the measuring microphone must also

be considered.

For loudspeaker measuring an initial THD measurement along the frequency axis at

constant input voltage is recommended. The curves already show potential weak spots

even at lower levels. The power fed to the speaker can be calculated from the selected

system output voltage and power amp gain. The lower cut-off frequency should be

adjusted to the loudspeaker and not be more than ½ octave below the tuning frequency

of bass reflex systems. Special caution is necessary when measuring midrange and high

frequency ways individually. The measuring range should not commence well below the

resonant frequency in their case as well. The upper cut-off frequency is limited to

approximately 11 kHz by the sampling rate of the system. The harmonics of higher

frequencies are higher than half the sampling rate and beyond the audibility range, i.e.
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they cannot be heard or registered by the measuring system. A frequency resolution of

1/6 octave has proved sufficient.

This display can be used to determine THD of a loudspeaker along the frequency axis at a

constant terminal voltage that is equivalent to  a certain SPL, e.g. 95 dB at a distance of

1m. A little arithmetic illustrates the relation. An average sensitivity of 89 dB @ 1W/1m is

specified for a passive nearfield monitor between 100 Hz and 10 kHz. A typical operating

level is 95 dB at a distance of 1m. Therefore the loudspeaker must be measured with a

voltage that is equivalent to 4 W at the nominal impedance. This equals a terminal voltage

of 5.6 Veff (= 17.26 dBu) at an 8 Ohm speaker. If a power amp with 26 dB was used in this

example an output level of -8.74 dBu would have to be entered under Level in the

measuring system.

Besides THD the harmonic curves k2 - k10 (Show THD up to K) can be shown

individually to indicate which harmonics constitute the major portions of the THD curve.

2nd order harmonics are not very critical for loudspeakers since they do not stand out as

unpleasant and leave the impression of more volume to a certain extent. This measuring

series is especially useful to evaluate individual THD components and to display THD at a

typical operating level. An example of a studio monitor operating at 95 dB/ 1m is shown

in Figure 59. Besides THD 2nd order k2 and 3rd order k3 are also shown.

A second measuring series of the same loudspeaker was carried out to determine

maximum SPL in 1m distance at a fixed THD limit (see Figure 60). The level range must

be entered in addition to the frequency range for this series. Within these limits the

measuring algorithm calculates maximum SPL at the predetermined THD value

beginning with the smallest values. The system output level is increased by adjustable

intervals until the THD limit is reached, until a limiter is detected or until the maximum

output voltage is reached. F PA loudspeakers THD limits of 3% and 10% have proved

useful, for studio monitors and home stereo systems smaller values of 1% and 3% are

recommended.
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Attention: Before starting maximum SPL measuring the power handling capacity of the

loudspeaker must be considered. Potential dangers are mechanical overload which results

in the voice coil striking the pole piece or the the tearing of the cone, and thermal overload

by power dissipation in the voice coil which may result in coil burn-out or separation of

the windings from the coil former. Passive loudspeaker crossovers or transformers are

also endangered by thermal overload or excess-voltage. Special caution is necessary

when measuring home stereo loudspeakers since they usually do not incorporate

protection circuits common with PA and studio systems. Low frequency drivers are

basically more endangered by mechanical overload whereas midrange and high

frequency drivers are endangered by thermal overload primarily. Long cone excursions at

higher low frequency levels cause excessive THD, and the measuring algorithm cuts off

automatically. However, this is not always the case with midrange and high frequency

drivers, and the measuring system might increase levels to such an extent that the light

high frequency driver voice coils cannot dissipate the heat sufficiently anymore. For high

level protection the maximum output voltage can be limited. The upper and lower limits

are entered in the corresponding DA and PA level range window in dB FS relative to the

maximum system output voltage. Additionally there is a power rating in Watts which

results from power amp gain as set in PA gain and system output level at an 8 Ohm load.

SPL Max measuring can only be carried out in single channel mode without the Auto

Range function. While measuring the following info window can be opened. Status

indicates when limits are exceeded.
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SPL max measuring window

Distortion

Frequency in Hz Measuring frequency

DA level in dB FS System output level relative to FS

PA power in W Output power calculated from

measuring level and power amp gain

at an 8 Ohm load

SPL (1m) in dB Sound pressure level at 1m distance

Sens. (1m) in dB Loudspeaker sensitivity calculated

from power and SPL. (As opposed to

sensitivity @ 1W/1m this value allows
conclusions on power compression.)

Status NOSIG
LIM
CLIP
UNDER
OVER

No input signal
Limiter detected in signal chain
Clipping detected in signal chain
THD limit reached at lowest level
THD limit not reached at highest level

Ch 0

K2 value in dB K2 relative to fundamental

K3 value in dB K3 relative to fundamental

K... values in dB K... up to 10th order

Σ-K value in dB THD relative to level

THD+N/S value in dB THD and noise relative to test signal

level

Table 28 SPL max measuring window
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The level and sensitivity values shown in the info window are only correct if a single

loudspeaker and a power amplifier are connected. Multi-amped or electrically coupled

systems cannot be evaluated due to frequency-dependent amplification levels. The

fullscale (FS) value of the measuring system output is set as usual in AD/DA under

Basic settings. A DA fullscale value of +20 dBu should be sufficient even for

power amps with lower gain.

The PA gain value has no influence on the correctness of SPL max measuring. However,

the Mic preamp gain and Mic-LS distance settings are of utmost importance, and

microphone sensitivity must be entered under Miscellaneous in the AD/DA menu.
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8.10 Measuring Impedance and Thiele-Small Parameters

Impedance measurements are carried out quickly and easily by MF and its accompanying

hardware. The standard settings have been chosen to provide convenient loudspeaker

impedance measuring.

The measuring procedure is similar to those of the other menus. First, a measurement at a

fixed load is made to serve as a reference for further measuring. Apart from the reference

load there is a shunt resistor wired in series with the test object to measure voltage drop.

Impedance measuring is therefore based on the reference measurement, the reference

load and the shunt resistor. The test object is simply connected to the front-end MDP

terminals. The monitor amp gain should be set to 20 dB (Cal.), the test signal level to –

10...-20 dBu. When starting the measurement the front-end automatically switches the

10 Ohm reference load in place of the test object to the output. It is not necessary to

disconnect the test object since the outputs are automatically switched off during the

reference measurement. The measurable variable is determined across the integrated

1 Ohm shunt resistor. A red LED labeled 10Ω Cal. indicates the reference measurement

on the front panel. Using the standard settings the measuring result should be free of

interference and distortion (see Figure 61). The Autorange mode is recommended for

impedance measuring (AD/DA Basic settings menu).

After reference measuring the test object is measured. The output voltage is calculated

from the voltage set in the reference menu under Level plus 20 dB monitor amp gain.

AD/DA Impedance

Excitation

Mode Single Single or continuous measuring

Pre sends 1 Number of pre-sent MLS

Averaging 1 Number of measurements to be

averaged

Impulse response processing

Build imp. resp. Pre comp Calculate impulse response from the

compensated frequency response

again
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AD/DA Impedance

Window Yes Impulse response window function

Type Bl-H. 4-Term

right slope

Start: 70 ms

Length: 30 ms

Window type, start and length

(the standard setting is ideal for

loudspeaker impedance measuring)

Spectral processing

Equalizing File IMPCO15.SPK Reference measurement file name

Smooth No Smoothing
(Attention: smoothing narrow impedance
maxima may result in serious faults)

Display

On top 50 Ohm Display range

Info Window no Info window

Table 29 The AD/DA Impedance menu

AD/DA Impedance reference

Excitation

Degree 15 Test signal degree

Resolution ∆f = ft/2
Grad

Standard: ∆f = 44k1/215 = 1.35 Hz

Exciter MLS Test signals:

Impulse Dirac Impulse
2n-Signal Multi-sine signals from a

file which must be
generated first

                (see also chapter 8.15)
MLS unweighted maximum

length sequences

Origin Internal Test signal source:
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AD/DA Impedance reference

Internal computer generated
automatically when calling
up a measurement

File time signal loaded from a
file (see also 8.15)

Ext. Hardware external hardware
generator

Level -10 dB FS Test signal level in dB FS or in dBu

Interleave 1 Interleaved sampling for external test

signals with a multiple integer higher sampling
rate to extend the measuring range for special
applications

Equalization

Equalizing File IMPCO15.SPK Reference measurement file

Lower cut off 1 Hz Compensation low frequency cut-off
(lowest value approx. 1 Hz since the front-end
is not DC coupled)

Upper cut off 22.05 kHz Compensation high frequency cut-off
(highest value approx.. 22 kHz equivalent to ½
sampling rate)

Reference R 10 Ohm Reference load
(integrated in the front-end, automatically
connected in place of the test object during
reference measuring)

Shunt R 1 Ohm Shunt resistor for current measuring
(integrated in the front-end, automatically
connected in series with the test object during
reference measuring)

Table 30 The AD/DA impedance reference menu

Figure 62 shows the impedance measurement of a small bass reflex loudspeaker. The

result is always available in complex form, i.e. magnitude (Ctrl M), phase (Ctrl P)

and real (Ctrl R)or imaginary phase angles(Ctrl I) can be displayed. Impedance

is also shown along the frequency axis by a Nyquist plot (Ctrl O).
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Several sources for potential impedance measuring errors must be mentioned briefly. The

measured value always refers to all connections on the front-end outputs, i.e. it includes

cable and connector resistance. The measuring error is inversely proportional to the test

object impedance. A loudspeaker with a nominal impedance of 2 Ohms and 0.4 Ohm

cable and connector resistance result in a 20% measuring error. To avoid this error the test

object should be measured with shorted terminals first and the result should be saved in

an individual file. It is later subtracted from the measurement.

Non-linear loudspeaker response may also interfere with impedance measuring.

Specifications should never be considered absolutely constant. Non-linearities that are

more or less pronounced may be caused by multiple dependencies, e.g. cone

displacement. “Ragged“ impedance curves similar to those caused by distortion during

frequency response measurements are the result. Open chassis react especially critical

during impedance measuring due to long excursions even at lower power levels. In this

case the test signal level must be attenuated until distortion levels are acceptable. The

Averaging value may be increased simultaneously if necessary. If test signal levels are

varied by software entry (under Level) instead of the front-end gain control a new

reference measurement is not necessary. Figure 62 shows the impedance measurement of

a small bass reflex enclosure with a tuning frequency of approximately 110 Hz at the

minimum impedance.



MF Audio Measuring System: Examples                                                                      183/277

                                                                                                                                                       

© by Audio & Acoustics Consulting Aachen V 3.2E printed 12.12.99 11:02

46

Figure 61 Impedance measuring reference
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Figure 62 Impedance measurement of a small bass reflex
loudspeaker

MF enables the quick determination of Thiele-Small parameters by two impedance

measurements of a driver that is not mounted in an enclosure, i.e. the chassis must be

detached. Air vents in the pole piece must not be closed, e.g. by placing the loudspeaker

on a table, or an air cushion builds up which is nonexistent during normal operation

causing additional compliance. The unmodified chassis is measured first. The resulting

curve shows the resonant frequency at the maximum impedance and the rising

impedance at higher frequencies caused by voice coil inductance. The resonant frequency

of an unused chassis is usually higher than specified. By feeding a subsonic sine wave

signal (5 Hz) for several hours before the the chassis can be conditioned before

impedance measuring. The signal level should be low but cone excursion must be clearly

visible.
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Figure 63 Impedance measurement without and with added weight

Simply seen a loudspeaker is a spring-and-mass system with a resonant frequency. The

resonance is determined by the dynamic mass of diaphragm, voice coil, suspension and

the mass of air that is moved. The compliance of the unmounted chassis is primarily

determined by the spider. To determine the individual quantities of mass and  compliance

one or the other is altered by a known quantity and a second measurement is made. By

mounting the chassis in a totally sealed enclosure with a known volume the compliance is

increased by the pneumatic spring and the resonant frequency of the mounted chassis

rises. The second method is easier and increases the dynamic mass by an additional mass

of known weight. The measurement with added weight results in a lower resonant

frequency. This method is aided by MF, i.e. the unmounted chassis must be measured

without and with added weight which should be roughly equivalent to the dynamic

loudspeaker mass. Plasticine is recommended due to its ductile and adhesive qualities. It

can also be removed easily without residue. Formed into a long roll it is preferably placed

and slightly pressed around the fold between cone and dust dome.

Both impedance measurements must be saved in two separate files or in two channels of

a single file. No special order is required. The following window can be called up in the

Info Loudspeaker param menu if both curves have been loaded as shown in

Figure 63.
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Impedance PHL 6,5" mit und ohne Zusatzmasse (20g) fr=47 Hz

Region        : cursor/fixed
Lower limit   :    4.0375 Hz
Upper limit   :   20.0003 kHz
Diameter      :       163 mm
Added weight  :        20 g
------ Thiele Small Parameter -----
f s           :   46.4478 Hz
R DC          :    3.2251 ê
Q MS          :      4.99
Q ES          :      0.23
Q TS          :      0.22
V AS          :   54.1542 l
----- More parameters -----
M dyn         :   13.3617 g
C MS          :  878.7157 æm/N
R ms          :  781.7737 mNs/m
Bl            :    7.6147 Vs/m

Quit

Figure 64 Thiele-Small parameters printed from MF.PRO file
(Ctrl Print prints current window display)

Several entries are necessary. Lower Limit and Upper Limit determine the frequency

range to be evaluated. Since the voice coil DC resistance RDC is evaluated at the lower

limit this value is more important. Favorable values are between 1 and 4 Hz for the

Lower Limit and between 1 and 20 kHz for the Upper Limit. Also, cone diameter and the

amount of added weight must be entered. Determining the Thiele-Small parameters

becomes increasingly inaccurate the loser the resonant peaks of the curve with added

weight and that without are. As a rule of thumb the resonant frequency with added mass

should be lower than 0.7 times the resonant frequency without. The cone diameter should

be measured by including approximately half the suspension. The parameters are

afterwards listed in the Loudspeaker Parameters window as shown Figure 64. The

Ctrl Print combination copies the window contents and the comment line of the

current file to the ASCII file MF.PRO for further documentation and processing. An

already existing MF.PRO file is not overwritten. Current window contents are simply

appended. Pointer: This protocol function enables the transfer of all windows with their

current settings to the protocol file to document complete procedures.
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8.11 Measuring S/N and Noise Levels

The signal-to-noise ratio, i.e. the dynamic range, is an essential index of audio equipment

quality. It is determined by the maximum output voltage before clipping and and the

noise level in quiescent condition. An equalizer was used as test object which provides an

output voltage of 21 dBu equivalent to 8.7 Veff or 12.3 Vs. A level of 0 dBu is equivalent to

775mVeff or 1 mW at 600 Ohms. The noise level is the total of noise, hum etc. present at

the output without any input signal. The inputs should be terminated at low impedance or

shorted to prevent false results by pick-up. The measuring system output should never be

connected to the test object input or the residual D/A converter noise will be a part of the

measurement.

MF determines the noise level by an FFT analysis. First, a noise spectrum is established

as shown in Figure 65. The left curve displays the spectrum without weighting, the right

curve is A-weighted. The A-curve (see Figure 66) represents the frequency-dependent

sensitivity of the human ear, i.e. those frequencies the human ear is especially sensitive to

are weighted correspondingly more than those it is less sensitive to. A-weighting can be

selected during measuring or multiplied into the spectrum afterwards by Edit A-

weighting. The process is canceled by Edit A-unweighting. A-weighting is

indicated by an A above left on the monitor. The spectrum level statistics can be read

during the measurement if the info window has been opened, or under

Spectral statistics in the Info menu after measuring.
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Figure 65 EQ output noise
left: (20 Hz - 20 kHz unweighted) overall level -81.5 dBu
right: (20 Hz - 20 kHz A-weighted) overall level -83.4 dBu

50

Figure 66 A-curve and inverted A-curve

MF measures signal spectra in the AD/DA menu under AD only. Before measuring the

system noise level should be checked. The front-end inputs must be open for that

purpose. The noise level should be significantly lower than that of the connected test

object. The measuring system A/D converter provides a dynamic range of approximately

80 dB with a wide adjustment range provided by the front-end pre-amps. The system

input sensitivity can be varied by MF from -62.5 dBu to +40 dBu. Settings are made in

the AD/DA menu under Basic settings. At lesser preamp gain the noise level is

dominated by the A/D converter, at high gain it is dominated by the preamp. The

following table shows noise levels at various input sensitivity values.

Input sensitivity
in dBu

Noise level in dBu
20Hz - 20kHz unweighted

Resulting
measuring dynamics in dB

+40 dBu (=77.5 Veff) -35 dBu 75 dB

+20 dBu (=7.75 Veff) -55 dBu 75 dB
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Input sensitivity
in dBu

Noise level in dBu
20Hz - 20kHz unweighted

Resulting
measuring dynamics in dB

0 dBu (=775 mVeff) -75 dBu 75 dB

-20 dBu (=77.5 mVeff) -94 dBu 74 dB

-40 dBu (=7.75 mVeff) -108 dBu 68 dB

Table 31 16-bit system measuring dynamics and noise level at
varying input sensitivity

Even very low levels in a range of –100 dBu can be measured as shown in the table. The

Autorange function can be activated to automatically select the most appropriate input

sensitivity. Under certain circumstances  a suitable setting may not be found and gain

settings are switched back and forth.. In this case the Autorange mode must be switched

off and input sensitivity must be adjusted manually.

The AD/DA menu contains the following functions under AD only :

AD only

Excitation

Mode Single Single or continuous measuring

Averaging 1 Number of measurements to be

averaged
Each doubling the number of measurements
reduces the noise level by 3 dB

AD decimation % 1 Reduces the sampling rate
Reduces bandwidth and increases resolution
accordingly.

Length 371.5 ms Evaluated time signal length

Samples/channel 16384 Number of samples = 2n

Remove DC Yes Subtract DC offset from time signal
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AD only

Windowing

Window No Impulse response window function

Type Bl-H. 4-Term

symmetrical

Range: all

Window type and shape

Spectral processing

Equalizing None None: no weighting in the frequency
domain

File: weighting via a chosen spectrum
file

A-weigh: A-weighting

Sinc(x): (sin x)/x weighting

J-filt: Weighting by a filter defined by
J-filter
(see also 10.4)

Smooth No Smoothing in the frequency domain

Channel combine none Link Ch0 and Ch1 during two-channel

measuring

Display

Dynamic Range 140 dB Display range

On top 20 dB Upper display limit

Ref. for 0 dB 0 dBu 0 dB reference

Max: maximum spectrum value
Fixed: selectable value
0 dBu: 775 mV
AD FS: A/D converter fullscale

dB reference 0 dBu Selectable 0 dB reference

for “fixed“

Info Window no Info window
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Table 32 Standard settings of the AD/DA AD only menu

Various statistic signal values can already be read in the info window while measuring.

The evaluated frequency range is shown under Lower and Upper Limit. It can be selected

in the Info menu under Spectral statistics. If a spectrum file has been saved

the values can be recalled and the frequency range can be changed in this menu anytime.

The measured noise level is shown as voltage level or level in in dBu under Overall. The

typical values are determined by an FFT length of 16K and weighted between 20 Hz and

20 kHz. In the Edit menu The optional A-weighting can be selected directly during the

measurement or switched on for already existing files anytime in the Edit menu where it

can be canceled as well.

To determine the S/N ratio of audio equipment the maximum undistorted output voltage

level must also be measured. The AD/DA menu contains the THD+N single f

function to analyse THD at a fixed frequency, e.g.. 1 kHz.

The following table shows the THD+N single f  function settings:

THD+N single f

Excitation

Mode Single Single or continuous

measuring

Degree 13 FFT length = 213 = 8192

Pre sends 1 Pre-sent measuring periods

without evaluation

Averaging 1 Number of measuring

periods to be averaged

Excitation 1.0013 kHz Exciting frequency
value is always set to an integer
number of periods within FFT
length

Dither No Add dither to sine signal

Level 0 dB FS ; 20 dBu Output level in dB FS or
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THD+N single f

(reduce if necessary) dBu

Display

Dynamic range 140 Display range in dB

On top 30 Upper display limit

Normalize to 1V No No = normalizes the spectrum to

the reference value

Yes = normalizes the spectrum

to 1V = 0 dBV, i.e. the levels of
all other values are shown relative
to the total of fundamental +THD
or fundamental+THD+N.

Reference S+THD S+THD = only harmonic

distortion is included

S+THD+N = all distortion and

noise is included

dB Reference 775 mV Reference value for

normalizing

(775 mV for dBu)

Info Window Yes Open info window while

measuring

Show THD up to K 3 Show k-values up to the

selected number in the info

window

Table 33 The AD/DA menu THD+N single f

At above settings the signal spectrum is shown relative to 775 mV, i.e. in dBu. The output

level can be increased by menu setting or by the test object level control until the

operating limit is reached. This is indicated by a sudden increase of distortion. The level of

the fundamental is shown slightly below this limit, e.g. at 0.1% or -60 dB THD

respectively. By placing the active cursor by ↑M on the fundamental line during the

measurement or after frequency, voltage and level can be read directly.
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Figure 67 THD and noise of an EQ at 20 dBu (l) and 21 dBu (r)
output level

Common line outputs usually provide maximum levels of  20..26 dBu. Special care must

be taken to prevent overload of the A/D converter which can be easily accomplished by

the Autorange function. Also, a sudden increase in distortion must not necessarily result

from reaching the operating limit of the test object output stage only. Depending on the

levels of the individual stages overload may occur at lower levels already. It is

recommended to set the test object for operation as desired and to measure output noise

and maximum output level with this setting. The usable dynamic range is limited by these

values.

The dynamic range of the exemplary equalizer was determined as follows:

20 dBu –(-81.5 dBu) = 101.5 dB unweighted 20 Hz- 20 kHz 16K FFT

20 dBu –(-83.4 dBu) = 103.4 dB  A-weighted 20 Hz- 20 kHz 16K FFT
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8.12 Measuring Power Amplifiers

This chapter is currently in preparation.
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8.13 Measuring and Evaluating Room Impulse Response

The acoustic parameters of a room are based on room impulse response. Reverberation

time, definition, clarity, center time, rapid STI etc. can all be calculated from the room

impulse response which must be measured accurately. However, this is not quite easy.

Ideally, a point source which radiates all frequencies evenly, i.e. a source with

omnidirectional characteristics is required. Since such a source does not exist

compromise solutions are necessary, e.g. a blank pistol fired within the room or a similar

fulminant source the signal of which is recorded directly by the measuring system.

The AD/DA menu item AD only can be used to record the signal. Recording time

depends on RAM and should always be sufficient if recent PCs are used. As an

alternative a DAT recording of the signal can be transfered to the computer. In both cases

it is important to prevent overload of the recording system.

8.13.1 Measuring Room Impulse Response with Loudspeakers

Measuring with a loudspeaker is less critical. Noise and sweep exciting signals with their

even energy distribution across longer periods of time permit accurate recording level

adjustment. Apart from preventing overload it is important to achieve a sufficient signal-

to-environment-noise ratio. Directivity is the crucial issue when measuring with

loudspeakers since all loudspeakers are far from the ideal of a point source. A few

dodecahedron loudspeakers specially designed for that purpose have more or less

omnidirectional characteristics up to 2 kHz. Above that these systems have  multiple

conical directivities which excite the room differently in various directions. Very small

dodecahedrons reach their power handling limit at lower frequencies after a short time.

Separate measurements of the low frequency, mid- and high frequency ranges with two

or three dodecahedrons to cover the 125 HZ to 4 kHz octave range seem to be the best

compromise currently. Usually standard loudspeakers will have to be used which require

critical examination of results and a series of measurements with different alignments if

possible. The measuring microphone should have omnidirectional characteristics, of

course. machen sollte.
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8.13.2 Measuring Menu

The actual impulse response measurement is made by measuring the frequency response

as usual. This is carried out in the AD/DA menu. The frequency domain must always be

chosen to use a compensation file. If a colored noise signal is used for excitation a

reference measurement must be made first which covers the transfer function of the

complete measuring distance and subtracts it from the measurement to result in the actual

test object response only. The easiest solution is using the familiar loudspeaker measuring

function LS sensitivity. With the Build imp. resp. = post comp and Delay shift =

no settings this function provides the completely compensated impulse response. Any

noise sequence and sweep signal variants can be used as test signals. Attention must be

paid to their length which must be chosen depending on the expected reverberation time.

At a sampling rate of 44.1 kHz a noise sequence of the 16th degree results in an impulse

response length of 216/44100=1.48 seconds. If the length is insufficient the number of

samples should always be increased instead of reducing the sampling rate to maintain

compatibility to the 44.1 kHz standard. The procedure is identical to loudspeaker

measuring as described in 8.3. Microphone compensation can also be selected if

microphone measurement files are available. Since room reflections are to be determined

a window must not be applied of course.

8.13.3 Reference Measuring

The components of a measuring loop must be discussed further. Refering to the ideal of a

loudspeaker with point source characteristics and an omnidirectional microphone, the

loudspeaker and microphone set-up in an anechoic environment  must be taken into

account by reference measuring to capture all constituents including loudspeaker and

microphone frequency response. Room interference is non-existant under anechoic

conditions. Next, loudspeaker and microphone are set up in the room to be measured,

and rersponse is evaluated again. The result of the anechoic measuring serves as a

reference, i.e.  the room is the only variable within the measuring loop. As a result, room

and impulse response might be measured accurately by this method. However, directivity

remains a weak spot in this configuration. Loudspeaker frequency response should be

compensated because of potentially serious interference. If  reference measurements

incorporating loudspeaker and microphone in an anechoic environment  cannot be made,

a simple MF reference measurement is recommended. Additional frequeny response

measurements can be used  for further processing.
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8.13.4 Room Impulse Response

A room impulse response that has been measured any which way should be checked for

a suffcient S/N ratio. Figure 68 shows an exemplary measurement of an average

loudspeaker system. Figure 70 shows the impulse response magnitude, and Figure 71

shows the integrated impulse response.

52

Figure 68 Room impulse response as time signal (Ctrl T)
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Figure 69 Room frequency response
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Figure 70 Impulse response energy (Ctrl E)
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Figure 71 Integrated room impulse response (Ctrl N)

8.13.5 Evaluation

If the displayed time signal is a room impulse response (see Figure 68), definition D,

clarity C and center time ts can be determined by Room Acoustics in the Info

menu. The calculations to define the room acoustics parameters were taken from ISO

3382. The following formulas determine definition D, clarity C and center time:
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The right choice of the evaluation start (t=0) which should be shortly before the direct

sound is vital for the correctness of these three parameters. The end should be where the

level of the dying impulse answer is still noticeably higher than the noise level. The start

can be determined manually or automatically. For noise suppression and enhanced

results the average noise level can be detected.
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Room Acoustics

Region cursor/fixed
Detail selection - determined by the position of
the cursors within the time signal, or fixed.

Lower Limit 66.6 ms Start entry if "Region" is set at "fixed". If "Start-
Detect" is activated the actual starting point is
determined by a search routine.

Upper Limit 1.48 s End entry. If this is less than 80 ms from the start
it is internally set to this minimum value for the
integral calculus. If the time signal is shorter "no
80 ms" is shown in the column of the
corresponding channel instead of the parameters.

Start detect no/yes If this function is activated the start is
determined by detecting impulse response peak.
After detecting the impulse response maximum
the start is fixed at the first level which differs
less than the threshold value from the maximum.
This function can beactivated anytime by the
Shift-I hotkey for visual control in the time
domain.

Threshold -20 dB Threshold value entry for the start detection
function. -20 dB are recommended by ISO 3382.

Noise detect no/yes If this function is activated the average impulse
response noise level is determined by averaging
the time signal energy from time signal start to
the start of the integration range. A time offset
can be entered under "Start minus" to shorten
the range that is averaged since the start of the
integration range already captures the first spurs
of the rising impulse if "Start detect" is activated.
For accurate automatic detection the measuring
period must be long enough to ensure that
impulse response start and end fall below the
noise floor. If "Noise detect" is not activated a
noise level can be entered manually, or "0" if no
correction is required.

Evaluatiom from head/tail If “Noise detect“ is activated the noise level
energy is averaged from time signal start to the
start, or after the time signal end. The section to
be averaged is set under “Length“.

Length 10% Section length after the time signal end in % of
total time signal length.

upto start minus If “Noise detect“ is activated the energy is
averaged from 0 s bis to the integration start
minus the selectable offset in [s]. The offset
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Room Acoustics

prevents the addition of the first impulse
response spurs to noise. If integration start
minus offset result in negative times noise level
is not determined. "Noise detect" is most useful
if "Start detect" is activated.

Noisefloor

(RMS)

If “Noise detect“ is not activated this menu item
instead of "up to start minus" appears to enter a
fixed value for noise voltage. This value can be
found by limiting a range characteristic for the
noise floor by the cursor keys and calling up
signal statistics where it is listed under "RMS". If
noise suppression is not required“0“ must be
entered. Entering exaggerated values by mistake
result in negative integral values. In this case
"invalid" is shown instead of the unuseful values.

Ch0

Start 71.95 ms $ Start of the evaluation range

Noise floor 70.48 mV $ Noise level

Noise crest 11.9 dB $ Noise level crest factor

Definition D50 72.8 % $ Definition

Clarity C80 5.724 dB $ Clarity

Center Time ts 59.735 ms $ Center time

Table 34 The Info Room Acoustics menu



MF Audio Measuring System: Examples                                                                      203/277

                                                                                                                                                       

© by Audio & Acoustics Consulting Aachen V 3.2E printed 12.12.99 11:02

8.13.6 Reverberation time

The basic purpose of an integrated impulse response is the evaluation of room

reverberation time. This is easily and quickly accomplished by Monkey Forest. The

complete time signal is shown logarithmically as energy (Figure 70) by Strg-E. In this

curve, the right cursor is placed on the bend between linear descent and the horizontal

noise floor (at approximately 650ms). The left cursor remains at the left edge even if the

impulse starts later. The Strg-N combination switches directly to the integrated impulse

response (Figure 71) which evaluates the time signal section marked by the cursors only.

The reverberation times (which comply to ISO 3382) of the integrated impulse response

can be called up in the Info menu under Decay times. EDT (Early Decay Time) is

calculated from the section between -0.1 and -10 dB while the reverberation times T5 up

to T40 jare calculated from -5 dB on (T5 from -5 to -10 dB, T40 from -5 to -45 dB). For

slope calculation a linear regression is carried out within the integrated impulse response.

This places a straight line in the interval of interest in such a way that the total of the

squared deviations is insignificant. The value in the graph below right refers to the descent

of the reverberation curve between the cursors. The reverberation time is determined by

the gradient of the straight line which results from connecting the two points of

intersection between cursor and integrated impulse response. The info window shows the

following values for the exemplary measurement:

IMP-RAUM.DAT Integrated impulse response

-------- Ch 0 -------

EDT :     1.3 s
T5  :    1.62 s
T10 :    1.79 s
T20 :    1.66 s
T30 :     1.5 s
T40 :     ---

Figure 72 Info window with reverberation times from room impulse
response

A time signal file may contain several impulse responses. Their acoustic parameters are

shown in individual channels starting with Ch0. It is recommended to file the original

impulse response in Ch0 and those that have been filtered in the other channels.
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8.13.7 1/3 Octave and Octave Filters

Room impulse responses  and acoustic parameters have been examined across the

auditory range so far. Occasionally a limited frequency range is of interest. A typical

application is the specification of the frequency-dependent reverberation time in octave

bands. anzugeben. Also, measured and calculated room impulse responses or ETCs can

be compared in octave or 1/3 octave bands. With its  J-filter option MF provides an

extensive convenient menu which accomplishes filtering in the time and frequency

domains in no time. The impulse response is loaded for filtering and processed by J-filter.

The J-Filter menu in Edit can be called up for time signals and frequency spectra.

Chapter 10.4 provides detailed information on the J-filter. A few exemplary settings for a

1/3 octave and an octave filter bank are explained here. To illustrate filter characteristics

the actual filter can be viewed in the Set Mode of the time domain. The following settings

generate a filter set (Filterset=multiple) of 1/3 octave filters between 125 Hz and 8 kHz

with a slope of 48 dB/oct.
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Mode             : set/filt
Phase            : complex/0ø   Domain   : ana/dig
Filter No Pg   :         1    Link all : no/yes
------------------ Characteristics --------------------
Type           : LP/HP/LP+HP/AP/BP/Notch/PEQ/PZ
Shape          : rect/crit/Bess/But/LiRi/Chebyshev
Power            :         1
Degree           :         8
Slope            :    48.165 dB/octave
Attenuate at fc  :    3.0103 dB

Gain             :         0 dB
------------------ Frequency range --------------------
Upper cut off    :         8 kHz <- Copy from cursor
Lower cut off    :       125 Hz
Filterset        : single/multiple
Steps            : lin/log
Bandwidth        : 1 /   3.00 - octave
Reference        :         1 kHz

Figure 73 J-filter set-up for 1/3 octave filter bank in the frequency
domain

56

Figure 74 Filter set in 1/3 octave steps



MF Audio Measuring System: Examples                                                                      206/277

                                                                                                                                                       

© by Audio & Acoustics Consulting Aachen V 3.2E printed 12.12.99 11:02

57

Figure 75 Filter set in octave steps

To process a selected impulse response by these filters J-Filter must be called up in

the time domain and in Filt Mode. The Filt Mode processes a signal by the required filters

in contrast to the Set Mode which only generates impulse response and the filter transfer

functions respectively. The following window shows the J-filter settings for octave

filtering of the impulse response in Figure 68. After processing the filtered signals are in

channels 0..6 in ascending order. Ch0 starts with the 125 Hz filter, Ch6 ends with the 8

kHz filter. The reverberation time of the filtered impulse response is determined the same

as that of the unfiltered room impulse response.
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Mode             : set/filt
Error Feed Back :  no/yes     Reverse  : no/yes
Filter No Pg   :         1    Link all : no/yes
------------------ Characteristics --------------------
Type           : LP/HP/LP+HP/AP/BP/Notch/PEQ/PZ
Shape          : rect/crit/Bess/But/LiRi/Chebyshev
Power            :         1
Degree           :         6
Slope            :    48.165 dB/octave
Attenuate at fc  :    3.0103 dB

Gain             :         0 dB
------------------ Frequency range --------------------
Upper cut off    :         8 kHz
Lower cut off    :       125 Hz
Filterset        : single/multiple
Steps            : lin/log
Bandwidth        : 1 /   1.00 - octave
Reference        :         1 kHz

Figure 76 J-filter setup for an octave filter bank to process an
impulse response in the time domain

Integrated imp.resp. IMP-OCTA.DAT Ch0 Impulsresponse
with octave filter 125 Hz (Ch0) to 8 kHz (Ch6)

-------- Ch 0 ------ Ch 1 ------ Ch 2 ------ Ch 3 ------ Ch 4 ------ Ch 5 ------ Ch 6 ---
EDT :    1.07 s    892.69 ms     1.21 s      1.43 s      1.36 s    778.89 ms   241.41 ms
T5  :    1.25 s      1.31 s      1.34 s      1.85 s       2.2 s      1.62 s    459.06 ms
T10 :    1.49 s      1.77 s      1.66 s      1.63 s      1.77 s      1.57 s      1.08 s
T20 :    1.36 s      1.48 s      1.33 s      1.33 s      1.32 s      1.19 s    907.85 ms
T30 :    1.14 s      1.32 s      1.15 s      1.29 s      1.24 s      1.06 s    828.44 ms
T40 :     1.1 s      1.27 s      1.08 s       1.2 s      1.19 s      1.03 s    764.36 ms

Figure 77 Info window with reverberation times from room impulse
response in octave steps Ch0=125 Hz ; Ch6=8 kHz

Figure 77 shows the info window with the reverberation times determined from a total of

impulse responses processed by octave filters. For a complete display of all values it is

recommended to load the unfiltered impulse response as the eighth channel (Ch7). The

info window can be copied into the MF.PRO file by Ctrl Print where it can be

processed as text. The file name is always placed first in the info window to document

serial measuring easily and clearly.
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Figure 78 Octave filtered room impulse response in Ch0 ... Ch6

59

Figure 79 Room response octave filters in Ch0 ... Ch6
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8.13.8 Measuring ETC

The ETC (Energy Time Curve) quickly provides an overview of the impulse response

time characteristics. The logarithmized impulse response magnitude is shown along the

time axis. Larger energy portions that arrive long after the direct sound and that are

regarded as disturbing echoes and similar effects can be easily seen. Apart from wide

band display MF calculates ETCs also in 1/3 octave and octave steps and are easy to

compare with ETCs calculated by room simulation programs.

After loading the impulse response in MF the Envelope function can be called up in the

Edit menu which carries out all calculations. The Shift Y combination switches to

logarithmic scaling. The display range is selected by the Display range function in

the Display menu.

60

Figure 80 ETC of the impulse response in Figure 68
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Figure 81 ETC‘s of the impulse response in Figure 68
with octave filters (time axis enlarged)
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8.13.9 Measuring STI and RASTI

STI (Speech Transmission Index) and RASTI (Rapid STI) are popular criteria to

determine speech comprehensibility between a transmitter (e.g. a speaker) and a receiver (

a listener) position. These can be a speaker and a listener in a room with or without PA

system. STI calculation is based on the transfer function between transmitter and receiver.

The transfer function must be measured as complex frequency response or impulse

response with sufficient length. The impulse response must have died completely within

the evaluated time period. In large rooms with long reverberation times test signal of

degrees 16 to 18 should be used.

For the STI value the loss of modulation depth of modulated frequency noise during

transfer is evaluated. Following the statistic signal parameters of speech the effect on

modulation depth is determined in 7 octave bands of 125 Hz to 8 kHz with 14 modulation

frequencies each of 0.63 Hz to 12.7 Hz. Modulation loss can be caused by reverberation,

echoes etc. and noise. For measuring appropriate noise signals are sent through octave

filters for the seven frequency bands and modulated by the corresponding frequencies.

würden. The factor by which the modulation depth has decreased is determined at the

receiver position. The value which depends on the modulation frequency is between 1 (no

effect on modulation) and 0 (modulation is completely masked). MTF (Modulation

Transfer Function) is shown along the frequency axis. The range between 0.5 and 16 Hz

is of importance for STI which can be calculated from the impulse response in a few

steps. First, the impulse response must be filtered by octave filters for the seven

frequency bands. Seven MTFs are calculated from the seven filtered impulse responses.

For sufficient resolution impulse response length should be at least 262144 values or it

must be lengthened to this value by adding zeroes. Next, the impulse response is squared,

rectified and transformed into the frequency domain where it is normalized to 1 (=0dB) at

0 Hz to provide the MTF. This value must be converted to S/N for STI calculation and the

average dB value of the 0.5 - 16 Hz range must be determined. Values above +15 dB or

below     –15 dB are regarded as “runaways“ and limited to +15 or –15 dB. The values of

the seven octave bands are weighted and averaged, therefore the final average value is

always between–15 and +15 dB. At last, the dB value is converted to a value between 0

and 1 which is the STI value. More information on STI and RASTI can be found in the

approprite literature. MF calculates and indicates the STI value in a single process.

 RASTI is a simplified version of STI with only two frequency bands of 500 Hz and

2 kHz and 4 or 5 modulation frequencies. To determine RASTI the resulting 9 values are

averaged without weighting.
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The following example is based on a room transfer function which was measured

between a PA system and a listener position in the auditorium. A wide band impulse

response of the transfer distance is shown in the next graph. The transfer is dominated by

the loudspeaker systems installed right and left of the stage. Only a small part of the direct

sound from the speaker position arrives in the auditorium. Since the listener position was

not aligned with the center stage the signals of both loudspeakers arrive with a time offset.
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Figure 82 Impulse response measured in a room with PA

After loading the impulse response in MF and placing the cursors at both ends

(Shift E) the 7-band octave filtering is carried out by J-filter. The settings are identical

to those in Figure 74. The setting of the multiple filter set must be 6th order Butterworth

LP+HP from 125 Hz to 8 kHz. After calculation the filtered impulse responses are

available in channels 0 to 6, the 125 Hz octave in Ch0 and the 8 kHz octave in Ch6. This

7-channel file should be saved for security. The following graph shows the seven filtered

impulse responses on top of each other.
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Figure 83 Octave filtered impulse response

The next step is extending the impulse responses to 262144 (265K) values if they are

shorter. The right cursor is activated (R) and theExtend function is called up in the

Edit menu. The new setting is Extend to length 262144 with 0. Impulse response

length is 5.94s after that.

To calculate MTF the impulse response must be squared by the

Raise to the power  function in the Edit menu. The Power value is 2, of course.

The All channels option must be set to yes to square all seven impulse responses. Since

negative values remain negative in MF after squaring another step is necessary for

generating magnitude.This is in the Edit menu under Rectify. All channels = yes

must be selected here as well. The result is shown in the following graph.
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Figure 84 Squared and rectified impulse responses

The squared impulse responses must be transformed into the frequency domain in their

complete length next. (Shift E and F). The processing of 7 FFTs with 256K values

each takes a little time. The result is normalized to 0 Hz = 1 (0 dB). This is accomplished

by cursor placement at 0 Hz on the left graph end (Shift E und L) and the

Normalize function of the Edit menu. The settings are New magnitude = 1V ; All

same level = yes and All channels = yes. All spectra should be normalized to1 (=0dB) at

0 Hz. Now the MTFs are shown (see Figure 85). Only the range between 0 and

approximately 20 Hz is of interest which reduces the amount of data considerably. The

left cursor remains at 0 Hz, the right cursor is placed at approximately 20 Hz. This section

is saved as a new file by the Write Block  function of the Edit menu. All channels =

yes must be selected here as well. The other settings are Format=ITA/4 byte und

Region=cursor.
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Figure 85 Complete modulation transfer functions normalized to
1 at 0 Hz

The file is now reduced to the range up to 20 Hz and provides quick further evaluation.

Additionally, the phase should be set to 0° for all channels. The cursors are placed at both

ends of the spectrum (Shift E) and the Phase function is called up in the Edit

menu. The settings must be Mode=set ; Phase=0° and All channels=yes. After setting

the phase to 0 the file must be saved again. With linear scaling of the y-axis (Shift Y)

the following graph is displayed which shows MTF values in a range of 0..1.
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Figure 86 MTF for the 7 octave bands up to 20 Hz

The next step is the conversion of MTF m(f) values to S/N values. The simple equation is

S/N = 10 log (m/1-m) dB

It can be easily accomplished by the Edit menu functions. A minus sign is placed before

all values by the Negate function. This does not change the magnitude display, phase

should be –180° however. The next step is the addition of a value of 1 by the Add

function (Magnitude=1 ; Phase=0°).

All functions always refer to all channels and the range of 0 - 20 Hz beziehen. Therefore

the two cursors must always be placed at both ends and the All Channels option must

always be set to yes. The result (1-m(f)) can be saved in a temporary file. The source file

with the m(f) function is loaded next and divided by the temporary file (1-m(f)). The

Read Block  function with Mode=div setting automatically divides all 7 channels of

the source file by the temporary file loaded by the Read Block  function.

Shift Y selects the logarithmic display with dB values. These values do not correspond

with the required values yet since they do not refer to energy and are calculated with 20

log instead of 10 log. MF scales the display to 10 log easily by the Edit menu function

Stretch/squeeze and the settings Factor=0.5 and Reference=1.
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The average dB values for the STI-relevant range of 0.5 Hz (=Lower Limit) to 16 Hz

(=Upper Limit) can be read by selecting theSpectral statistics  function in the

Info  menu. Region must be set to fixed and the Upper and Lower Limit values must be

entered. The average dB value of each channel for this range can be read under Goe-µ-dB.

A total of 7 values for the seven octave bands are available for further processing. The

Goe-µ-dB value results from averaging the dB values within the relevant range which

corresponds to the STI definition. It is not necessary to read the individual values of the

14 modulation frequencies. However, no limiting to ±15 dB is carried out. The maximum

and minimum values (also in the spectral statistics window) should be checked if the

±15 dB range is exceeded. If this is the case the 14 values must be read individually,

limited if necessary, and averaged. The following table shows the results of the example

described above. No maximum or minimum 0.5 and 16 Hz exceeded ±15 dB.

Channel Ch0 Ch1 Ch2 Ch3 Ch4 Ch5 Ch6

Octave band 125 250 500 1000 2000 4000 8000

Goe-µ-dB 4.94 5.37 2.02 3.84 5.48 7.36 8.99

Weighting factor 0.13 0.14 0.11 0.12 0.19 0.17 0.14

The average dB value of the seven octave bands with their weighting factors must be

determined manually. The average is calculated from the total of the seven dB values

multiplied by their weighting factors. The result of the example is 5.63 dB. The STI value

is calculated as follows:

STI = (5.63 dB + 15 dB)/30 dB = 0.687

There it is !!!

In the future all that is accomplished without time-consuming calculation by simply

striking a key. The purpose of this example is a better understanding of STI and the Edit

menu functions.

An STI or RASTI value determined this way is still incomplete since the effects of noise

on modulation depth have not been included. It should be specified correctly as Noiseless

STI or Noiseless RASTI.
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8.14 Measuring SPL

SPL measuring is accomplished by MF with or without its own test signals. Signal

display is in the time or frequency domain and complemented by an info window with

statistic signal values. To determine the time response or the spectral signal distribution

the AD only (in time and frequency domain) or SPL (frequency domain only)

functions of the AD/DA menu must be selected. If a test signal, e.g. pink noise, is used the

AD & DA simultanously function (in time and frequency domain) must be

applied. The test signal must be saved in an appropriate file (*.DAT) as time signal with 2n

values. Generating 2n time signal with the required frequency weighting is explained in

detail in chapter Fehler! Verweisquelle konnte nicht gefunden werden.

For accurate SPL evaluation the 0 dB reference must be calculated from microphone

sensitivity and the value of 20µPa for a sound pressure level of 0 when using the

AD only and AD & DA simultanously functions. If microphone sensitivity is

15 mV/Pa for instance the dB reference value to be entered is calculated the following

way: 20⋅10-6 Pa ⋅15mV/Pa = 300⋅10-9 V = 300 nV. The dB reference value can only be

entered in the frequency domain. However, it also refers to the dB values in the time

signal window. Due to the revised SPL function which is only available in the frequency

domain this calculation is not necessary since microphone sensitivity and external

preamp gain can be entered directly.

Signal response is shown and statistically evaluated within the selected length in the time

domain.. Maximum SPL (Maximum Level) and the RMS value (RMS Level) of the time

window can be read as SPL in dB, or directly as microphone output voltage. The crest

factor in dB is also calculated from these values and shown. The signal can be saved as

time signal for further processing. The time signal section regarded for statistical values is

selected in the Info menu under Signal statistics.

The same applies to frequency domain display. The selected number of values is

sampled, windowed if necessary, and transformed into the frequency domain by an FFT.

The displayed frequency spectrum always refers to the section that has been selected

under Length in the time domain. As with the time signal section selection a frequency

range for the statistic signal values can be selected for the info window under Spectral

statistics in the frequency domain. The following table shows the settings that are

possible for the AD only function in the frequency domain.
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AD only

Excitation

Mode Single Single or continuous measuring

Averaging 1 Number of measurements to be

averaged

for SPL measuring always = 1

AD decimation % 1 Reduces the sampling rate
Reduces bandwidth and increases resolution
accordingly

Length 371.5 ms Evaluated time signal length

Samples/channel 16384 Number of samples = 2n

Remove DC Yes Subtract DC offset from time signal

Windowing

Window No Time signal window function before

FFT

Type Bl-H. 4-Term

symmetrical

Range: all

Window type and shape

Spectral processing

Equalizing None None: no weighting in the  frequency
domain

File: weighting by the selected
spectrum file

A-weigh: A-weighting

Sinc(x): (sin x)/x weighting

J-filt: weighting via a filter defined by
J-Filter (see also 10.4)

Smooth No Smoothing in the frequency domain
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AD only

Channel combine none Link Ch0 und Ch1 during two-channel

measuring

Display

Dynamic Range 140 dB Display range

On top 0 dB Upper display limit

Ref. for 0 dB 0 dBu 0 dB reference

Max: maximum spectrum value
Fixed: selectable value
0 dBu: 775 mV
AD FS: A/D converter fullscale

dB reference 0 dBu Selectable reference value for 0 dB

for “fixed“
V is calculated from the product of
microphone sensitivity in V/Pa and the

reference value of 20µPa for 0 dB SPL

Info Window Yes Info window

Table 35 The AD/DA AD only with SPL measuring settings

The AD & DA simultanously function provides time signal and time signal level

selection in addition to the settings in Table 35.

A typical application is shown by the following example.A PA system is tuned to provide

a C-weighted SPL of 80 dB in the auditorium when fed with –8 dBu RMS pink noise. A

16K long time signal with pink noise can be found in the PINK-16K.DAT file which is

entered under Signal File. The measuring system is switched to the frequency domain by

Strg M and the AD & DA simultanously function is called up in the AD/DA

menu. The pink noise output level is set at –8 dBu, and the measuring system input is

connected to one of the outputs by an XLR cable. The measurement is started without

the Equalizing File (none) and without smoothing (Smooth: no). 0 dBu must be selected

as 0 dB reference. The level is shown in dBu under Level overall in the info window. The

evaluated frequency range is 0-20 kHz. Necessary level corrections can be made in the

measuring menu. Das zugehörige Spektrum, das Meßmenu und das Infofenster zeigt
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Figure 87 shows the spectrum, the measuring menu and the info window. If the setting

range is insufficient the DA fullscale value must be increased under basic settings.

67

Figure 87 Setting the system output level to -8 dBu by pink noise
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------------------- Excitation --------------------

Mode             : single/repeat

Pre sends        :         1

Averaging        :         1

AD decimation %  :         1

Level ñ          :         0 dB FS   -0.0 dBu
Signal file      : PINK-16K.DAT
Remove DC        : no/yes
------------------- Windowing ---------------------
Window           : no/yes

-------------- Spectral processing ----------------
Equalizing       : none/file/A-weigh/sinc(x)/J-filt

Smooth           : no/yes
-------------------- Display ----------------------
Dynamic range    :        50 dB
On top           :       -15 dB
Ref. for 0 dB    : Max/fixed/0 dBu/AD FS
dB reference     :  774.5967 mV      0.0 dBu
Info window      : no/yes
---------------------------------------------------

Measuring menu AD & DA simultanously while setting the output signal level

Region        : cursor/fixed

Lower limit   :         0 Hz

Upper limit   :        20 kHz

---- U eff --------- Ch 0 -----------
Maximum       :   76.4402 mV
Minimum       :    9.1643 µV
Max-Min       :    76.431 mV
Average       :    3.3133 mV
Overall       :  285.6182 mV
---- Level --------------------------
Maximum       :   -20.115 dBu
Minimum       :    -98.54 dBu
Max-Min       :    78.424 dB
Average       :   -47.376 dBu
Overall       :   -8.0658 dBu

Info window with statistic signal parameters for Figure 87

After setting the correct output level the measuring microphone is connected and the dB

reference is adjusted to the microphone output voltage at 20µPa SPL. Unter Equalizing

File wird eine Datei A file (C-KURVE.SPK) containing the C-weighting as frequency file

is selected under Equalizing File. Figure 88 shows the measuring result and the C-

weighted frequency response..
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Figure 88 Setting the PA level to 80 dB SPL, C-weighted frequency
response

------------------- Excitation --------------------

Mode             : single/repeat

Pre sends        :         1

Averaging        :         1

AD decimation %  :         1

Level ñ          :         0 dB FS   -0.0 dBu
Signal file      : PINK-16K.DAT
Remove DC        : no/yes
------------------- Windowing ---------------------
Window           : no/yes

-------------- Spectral processing ----------------
Equalizing       : none/file/A-weigh/sinc(x)/J-filt
Equalizing file  : C-KURVE.SPK

Smooth           : no/yes
-------------------- Display ----------------------
Dynamic range    :        50 dB
On top           :        75 dB
Ref. for 0 dB    : Max/fixed/0 dBu/AD FS
dB reference     :       300 nV   -128.2 dBu
Info window      : no/yes
---------------------------------------------------

Measuring menu AD & DA simultanously during PA measurement

Region        : cursor/fixed

Lower limit   :         0 Hz

Upper limit   :        20 kHz
---- U eff --------- Ch 0 -----------
Maximum       :  474.8375 µV
Minimum       :  182.6652 nV
Max-Min       :  474.6548 µV
Average       :   37.8507 µV
Overall       :    3.2629 mV
---- Level --------------------------
Maximum       :    63.988 dB
Minimum       :   -4.3093 dB
Max-Min       :    68.298 dB
Average       :    42.019 dB
Overall       :     80.73 dB
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Info window with statistic signal parameters for Figure 88

The frequency response at the listening position is adjusted next by a 1/3 octave EQ. The

C-weighting must be switched off for this measurement (Equalizing File: none). All

other settings remain. In addition, smoothing with the following parameters is selected:

Smoothing of     : magnitude/group delay/both

Process          : continous/steps

Method           : averaged/added
Reference        :         1 kHz
Bandwidth        : 1 /   3.00 - octave

Region           : cursor/fixed

The spectrum magnitude is smoothed in 1/3 octave steps. Averaging across a certain

range Zu (averaged) and adding all frequency lines within this range (added) must be

distinguished. The frequency line density doubles when doubling the frequency due to

their linear intervals, i.e. the magnitude total of the individual frequency lines within an

octave increases by 3 dB, and 1 dB within a third octave. Pink noise with a level drop of

3 dB/octave, i.e. with a constant energy across the frequency, compensates this rise and

results in a straight line in this display. This measuring method is therefore identical to

tuning by a noise generator and a 1/3 octave analyzer. The system should not be tuned to

linear frequency response should since the room acoustics are included in the

measurement. A loudspeaker with linear tuning would produce a linear response in full

space if this measuring method is used. Due to frequency-dependent room reverberation

times serious deviations from linear response occur. The total energy level within a room

is higher at low frequencies where reverberation time is usually longer than at high

frequencies. This measuring method is practical only if the room reverberation times are

known and a corresponding target function is at hand for tuning. It has proved useful for

the quick tuning of cinema systems where guidelines are set for reverberation times to

achieve identical conditions in varying environments. Figure 89 shows the curve that was

tuned by pink noise in 1/3 octave steps.
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Figure 89 Target function (red) with tolerance (bl-gr) for a cinema
system measured without subwoofer

8.14.1 The SPL function

The revised SPL function includes the AD & DA simultanously and AD only

functions described in chapter 8.12. It has been primed for SPL measuring and provides

the direct entry of several values such as microphone sensitivity. Entries not required for

SPL measuring have been left out for convenience.

Sound pressure level

Measurement conditions

Mic sensitivity 15 mV/Pa Microphone sensitivity must be

entered in mV/Pa

Mic preamp gain 0 dB Microphone preamp gain must be

entered when using external units

(otherwise = 0 dB)

Mode single/repeat Single or continuous measuring
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Sound pressure level

Degree 14 FFT length for signal analysis without

test signal, otherwise 2n test signal

length is set automatically

Excitation

with excitation no/yes Send additional test signal while

measuring

Pre sends 0 Pre-sent sequences before measuring

Averaging 1 Number of measurements to be

averaged

for SPL measuring always = 1

Level ± -20 dB FS Test signal level

Signal file C:\MAXIDAT\
PINK_NOI.DAT

Test signal source file

Windowing

Window yes/no Time signal window function before

FFT

Type

Mode

Bl-H. 4-Term

symmetrical

Range: all

$ Window type and shape

Spectral processing

Equalizing None None: no weighting in the  frequency
domain

File: weighting by the selected
spectrum file

A-weigh: A-weighting

Sinc(x): (sin x)/x weighting

J-filt: weighting via a filter defined by
J-filter (see also 10.4)
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Sound pressure level

Smooth yes/no Smoothing in the frequency domain

Display

Dynamic Range 100 dB Display range

On top 100 dB Upper display limit

Info Window no/yes Info window

Table 36 The SPL... menu with SPL measuring settings

A typical use of the SPL function is the measuring of SPL within a room. A test signal is

not required (with excitation = no). After entering microphone sensitivity and external

preamp gain (if applicable, e.g for B&K microphones with 200 V polarization voltage) the

measurement is started in continuous mode (Mode = repeat) with the required

resolution. Measuring length and resolution are set by the FFT degree (Degree).

Degree=14 is a standard value. The period of time that is analyzed is

214/44100 Hz = 371.5ms long and frequency resolution is (44100 Hz)/214 = 2.69 Hz. This

value may be increased or decreased if necessary. A symmetrical Blackman-Harris-4-term

window across the complete time period is recommended (range=all). An evaluation

function can be selected under Spectral processing, A-weighting and a sinc(x) function

are selectable directly. Other filter functions can be loaded as a file (file) or generated by

by J-filter. If the J-filter option has been selected the J-filter window can be accessed

immediately from the SPL window to set the filter functions. Smoothing should be

switched off at first (smooth=no), to prevent that narrow band peaks are veiled in the

frequency spectrum. The info window can be faded in during the measurement

(Info window = yes) which continuously updates the spectral statistics. The evaluated

frequency range which can be selected in advance under Spectral statistics in

the Info menu is shown on top of the window.
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8.15 Generating Test Signals

Integrating a D/A converter into a measuring system provides the opportunity to

sythesize measuring signals and to call them up as a file. It renders the second FFT

channel obsolete since the test signal is desterministic and requires calculation only once.

It is discrete when periodically repeated, and amplitude and phase of each frequency it

contains can be set independently. Noise signal of any color can be generated from

amplitude spectra by random phase selection. The measuring signal is obtained directly

by an IFFT. The crest factor, i.e. the energy at a fixed maximum amplitude, can be

optimized if the phases are “stolen“ from the spectrum of a maximum length sequence.

Test signals with the advantageous length of 2n  and characteristics similar to maximum

length sequences can be generated this way.

In Figure 90 sind zwei Signale, die aus dem selben Magnitudesspektrum hervorgegangen

sind, zu sehen. Trotz identischer Leistung jeder enthaltenen Frequenz scheinen die

korrespondierenden Zeitsignale auf den ersten Blick nichts gemein zu haben. Das

gesuchte Übertragungsverhalten ergibt sich aus den Messungen, genau wie bei der

Zweikanal-FFT-Analyse, durch Division des Ausgangsspektrums mit dem Spektrum des

Anregungssignals. Im ungestörten Fall ergeben sich dabei die gleichen Resultate.

Superb sweep signals are generated from amplitude spectra by transforming a spectrum

into the time domain with 0° phase  and windowing the symmetrical impulse answer. The

window should be no more than half the width of the time period. After transformation

into the frequency domain again the desired transit time is impressed. After IFFT a non-

overlapping sweep signal is at disposal. If the amplitude response of a sweep signal with

logarithmic frequency increments is to be time-constant the magnitude must fall by

3 dB/octave.

Figure 88 shows two signals generated from the same amplitude spectrum. At a first

glance the corresponding time signals seem to have nothing in common although the

energy of each frequency is identical. As with a two-channel FFT analysis response is

obtained by dividing the response spectrum by that of the test signal.

Test signals of any length can be generated at random by an inverse discrete Fourier

transformation since amplitude spectrum and test signal phase can be selected freely in

the frequency domain. For evaluation by FFT their length is restricted to 2n which is no

impediment in practice. If the frequency resolution

df = fs/N fs = sampling rate N  = number of samples
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is insufficient it can be doubled by selecting the next higher square.

Recently pseudo noise signals of FFT typical 2n length are used in some FFT-based

measuring systems. They go by the somewhat strange name of “multi-sinus-signal“

presumably to express that the periodic test signal consists of a defined number of sine

waves with controlled amplitude and phase. However, this is true for any periodic signal

such as the maximum length sequences described later that are often contrasted with

multi-sinus-signals. The simple FFT of the response of a system followed by the division

by the exciting spectrum is fully sufficient to determine the transfer function and

advantageous for realizing a measuring system. The impulse response is obtained by an

IFFT, interference and reflections can be windowed if necessary (as is nearly always the

case with acoustic measuring). The corrected impulse response can be transformed into

the frequency domain by an FFT which increases the number of transformations

necessary for a measuring run to three. Computing time is approximately twice the

amount required for the MLS method which is negligible considering the speed of

modern PC’s. For state-of-the-art measuring systems maximum length sequences have

lost their attractivity.
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Figure 90 Pink noise (l) and pink sweep (r) amplitude response

71

Figure 91 Pink noise (l) and pink sweep (r) group delay

72

Figure 92 Pink noise (l) and pink sweep (r) time signals

The following list explains the process of generating random 2n signals.

1 If no measuring file exists a new file with a frequency spectrum is started. Degree

must be selected in the File menu depending on the required frequency resolution

before opening the new file by New.

For example, resolution is df = fs/2
n,  fs = sampling rate and n = degree
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df = 44100/214 = 2.69 Hz

Frequency resolution is shown below right on the monitor.

2 The required spectrum is generated. Possible sources are a measurement file, J-filter

or any other MF frequency spectrum.

3 The processing range must cover the complete spectrum. Left cursor at 0 Hz and

right cursor at 22.05 kHz. Shift E (↑E) for Entire.

The phase must be set to 0°. Edit menu: Phase: Set = 0°

4 A delay is added to the spectrum by Group delay in the Edit menu. For noise

signals random must be selected. For sweep signals the delay must be set with

logarithmic frequency increments. The setting is log inc. under Mode. Also, start and

end values for the right and left cursors must be entered. The left cursor is typically

set to 0, the right cursor placement is depending on time signal length calculated from

the number of sampled values.For example: Length = 2n/fs = 214/44.100 s-1 =

16384/44.100 s-1 = 371.52 ms, fs = sampling rate and n = degree

5 The signal with amplitude and delay is available in the frequency domain and

requires transformation into the time domain by an inverse FFT. The processing

range must cover the complete spectrum. Left cursor at 0 Hz and right cursor at

22.05 kHz.

IFFT must be selected next in the Trans menu.

6 The signal is saved for measuring use.

7 Exciter 2n-signal must be set in the appropriate measuring menu, and the time signal

file name is entered under Signal file. The Build impulse response option is switched

to post comp for 2n signals.
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9 System Specifications including ITADDA16

The ITADDA16 is based on an AD/DA ISA plug-in with a Crystal CS4231 chip. The A/D

and D/A converters provide a nominal 16-bit resolution at sampling rates between 5.5 and

48 kHz. The accompanying two-channel front-end incorporates line inputs and outputs, a

dual-channel monitor amp  and dual microphone preamps with 48 V phantom power.

Max. bal. line output level: 20 dBu ( > 600 Ohm)

Max. power amp output level: 23 dBu ( > 4 Ohm)

Input sensitivity in dBu: -40, -20, 0, +20, +40 dBu, selectable

Input sensitivity in Veff: 7.75 mV, 77.5 mV, 775 mV, 7.75 V 77.5 V

Input impedance: 5 kOhm

S/N @ -20..+40 dBu fs: typ. 75 dB

THD @ 14 dBu 20-20k typ. -80 dB (0.01%)

Phantom power: 48 V, switchable to both inputs

73

Figure 93 Phase and frequency response without compensation
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74

Figure 94 Input noise @ -40 dBu input sensitivity

75

Figure 95 THD at simultaneous AD/DA operation, level +14 dBu
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10 Crossover Works Option

This chapter is currently being revised and no longer up-to-date.

The following chapter lists the Crossover Menu items in detail with brief explanations.

The symbols refer to the importance of each parameter. All set-up parameters and format

settings have been chosen for trouble-free operation in conjunction with HUGO. The

settings must be adjusted when using DSP hardware that is not compatible with HUGO.

Settings are identical for HUGO and its “little brother“ LCH.

Symbol

: For service purposes only; do not adjust

$ Read only; no entry intended

I Attention: adjust settings only when familiar

with hardware and signal processing

M Important parameter; do not adjust running on

standard hardware

7 Entry necessary

Table 37 Symbols
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10.1 Set-up File Menu

The Setup file menu is the standard MF file menu which contains all file

management functions. Each calculated filter set is saved in an identically named file with

the extension FCS which contains all Crossover Menu settings for the corresponding

filter set. Settings can be reproduced anytime by an FCS file. The target function should

also be saved apert from the loudspeaker source data. A data record for the digital

controller is completely documented by by loudspeaker measuring data, target function

and the FCS file.

Parameter Definition

Path Current path

Mash File mask (*.FCS for setup files)

Name File name

Load Load file

Save Save file

Rename Rename file

Delete Delete file

Make Dir Set up new directory

Remaining Allocatable space on current drive

Exit MF Exit MF

DOS command Change to DOS mode

Sort File list sorting criteria

name/date/size  ;  up/down

Table 38 Entry window Setup file under Crossover work
in the Edit menu
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10.2 General Settings

The operating mode of the digital crossover is determined in the General Settings

menu. This includes the sampling rate and the number of ways. Also, the coefficient

format must be set as specified by HUGO. All settings are HUGO standard. For loading

the calculated coefficients in other units the appropriate format can be selected in the

Coef Format window.

Parameter Definition

Ways Number of ways used in HUGO

entry necessary for internal multi-way operation,

maximum number = 4

7

Sampling Rate Sampling rate = 44.1 or 48 kHz 7

FFT degree FFT degree for all coefficient generating calculations

Standard setting = 14

Increase degree to 15 if the SUB or LOW ways

contain more than 512 coefficients

I

Window type Window type for filter functions

Standard = Kaiser Bessel

I

Measured with Refers to loudspeaker measurement files required

for filter calculation.

Measured by HUGO or an external system?

7

Overwrite files Overwrite coefficient files with or without advance

warning

7

Coefficients Number of coefficients of the individual ways 7

Coef format ... Coefficient format IM

... Format Coefficient file output format

(also ASCII), standard = ITA

IM

... Size Coefficient display in X bytes, standard = 4 byte IM

... Byte order Byte order, standard = Intel IM

Setup ... Hardware setup for HUGO I

... Downsampling Sub = 16 times fg = 1.0 kHz $
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Parameter Definition

LOW = 16 times fg = 1.0 kHz

MID = 4 times  fg = 4.0 kHz

HIGH =1 time  fg = 22.0 kHz

... Max coefs Maximum number of coefficients allowed by RAM

irrespective of computing power

SUB = 700,  LOW = 650,  MID =  480,  HIGH =

300

I

Filter MIPS Computing power required by the current setting. A

warning is issued when exceeding the value set for

HUGO. Maximum value = 19 MIPS at

DSP56009/80

$

FIR multipath Splits a way internally to several ways with differing

downsampling steps.

none internal ways = external ways

mid+high mid and high intern à high output

low+mid low and mid intern à mid output

low+mid+high low, mid, high intern à high

output

Table 39 General settings entry window under Crossover work in
the Edit menu
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10.3 Target Response

The Target response menu item enables the entry of a target function, i.e. the

desired frequency response of a loudspeaker system in conjunction with the digital

crossover. Basically the lower and upper frequency cut-offs must be entered only.

Frequency response can be manipulated further under Freq. response =

user defined. An easier and better way is the processing of the target function saved

in the XT.SPK file by J-Filter in the Edit menu. After loading the XT.SPK file the

Mode=filt setting is selected in J-Filter to shape frequency response by analog filter

functions comparable to a fully parametric EQ. As an option the accompanying phase

response or the amplitude response only can be adopted. Selection is by

Phase=complex/0°.

76

Figure 96 Target response example (XT.SPK)
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Parameter Definition

Upper boundary

Cut off (-6 dB) Upper frequency limit of the selected function

Shape Low pass filter characteristics:

Windowed (FIR TP filter, number of coefficients

selectable under Width)

Critical

Bessel

Butterworth

Linkwitz Riley

Slope oder Width Filter slope in dB/Oktave or FIR filter width by

number of taps

Lower boundary

Cut off (-6 dB) Lower frequency limit of the selected function

Shape High pass filter characteristics:

Windowed (FIR LP filter, number of coefficients

selectable under Width)

Critical

Bessel

Butterworth

Linkwitz Riley

Slope oder Width Filter slope in dB/Oktave or FIR filter width by

number of taps

Freq. response flat = no filter or frequency response manipulations

except HP and LP above

user defined = EQ menu (not recommended, use J-

Filter from the Edit menu)

Target Output File name for target function, standard = XT.SPK

Table 40 Target Response entry window under Crossover work in
the Edit menu
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10.4 J-Filter

This chapter is currently in preparation.
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10.5 Create prototype bandpass

The target band passes of the individual ways with x-over and filter are designed in

Create prototype bandpass. Apart from crossover frequency filter

characteristics must be entered which must not be equivalent to crossover slope and

include acoustic loudspeaker response. For instance, if a mid/low frequency system in a

totally sealed enclosure which falls off by 12 dB/octave (2nd order HP) below its resonant

frequency is to be tuned to a total 4th order 24 dB/octave high pass by the crossover the

Lower Boundary Slope must be set to 24 dB/octave. In that case an electrical filter

function of 12 dB/octave is assigned to the crossover which adds up to 24 dB/octave with

the loudspeaker that represents 12 dB/octave acoustic filter.

Attention: Very high filter slopes may cause long delays in the crossover range that may

result in serious delay errors at minimum phase compensation and high group delay  at

linear phase compensation.

Parameter Definition

Upper boundary

Cut off Upper band cut-off of the selected way

(SUB,LOW,MID)

Shape Low pass filter characteristics:

Windowed (FIR LP filter, number of coefficients

selectable under Width)

Critical

Bessel

Butterworth

Linkwitz Riley

Slope oder Width Filter slope in dB/Oktave or FIR filter width by

number of taps

Lower boundary
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Parameter Definition

Cut off Lower band pass cut-off of the selected way

(LOW,MID,HIGH)

Shape High pass filter characteristics:

Windowed (FIR LP filter, number of coefficients

selectable under Width)

Critical

Bessel

Butterworth

Linkwitz Riley

Slope oder Width Filter slope in dB/Oktave or FIR filter width by

number of taps

Level Levels for the individual ways

(SUB,LOW,MID,HIGH)

Only the actual level differences of the complete

function are set, i.e. no power amp adjustment or

adjustment to the differing sensitivities of the

individual ways!!!

I

Target input File name of the function selected from the Target

response menu, standard = XT.SPK

Bandpass output File name for the newly created bandpass functions,

standard = XBPROT.SPK

Table 41 Create Prototype Bandpass entry window under
Crossover work in the Edit menu
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10.6 Process band pass

The band passes that have been in prototype form so far are processed in the

Process band pass menu for harware compatibility. Some filter functions cannot

be accomplished as designed due to the limited number of filter coefficients. If no further

settings are made Process band pass generates the functions that can be realized

from the prototypes in the XBPROT.SPK file and saves them in the new file XB.SPK.

Basically, the number of coefficients selected in General settings  is used for the

filter function. Filter length of high pass functions in the LOW, MID and HIGH ways can

be reduced artificially to a selectable percentage. This method is recommended for

brickwall filters which cause excessive delay due to their high slope.

Parameter Definition

Lower slope Allows reducing the effective number of
coefficientes nur for high pass filters only in the
respective way (in % relative to the selected number
of coefficients), standard = 100%

I

Brickwall thres. Limit below which maximum filter slope is set
independent of the selected slope. Important for the
downsampling ways where high rejection is required
above half the sampling rate. Standard = -40 dB

I

Target input File name of the function selected from the Target
response menu, standard = XT.SPK

Bandpass input File name of the bandpass function selected from
the Create prototype band pass menu,
standard = XBPROT.SPK

Bandpass output Result of the Process Bandpass Menu which further
processing is based on, standard = XB.SPK

Table 42 Process Bandpass entry window under Crossover work
in the Edit menu
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10.7 Limiter settings

All limiter settings and power amp parameter input occur in the Limiter settings

menu. The limiter functions are only valid for devices compatible with HUGO.The 2 ms

pre-delay of the HUGO peak limiter guarantees that limits are absolutely maintained. To

make the most of amplifier peak power a larger surge value with accompanying time

constant can be selected.

The thermal limiter is based on a simple thermic voice coil model with two time

constants. The short time constant allows for the voice coil heat capacity only whereas

the longer time constant also includes the heat capacity of magnet and loudspeaker

chassis. The voice coil of a loudspeaker driven with constant power heats up rather

quickly to a certain temperature where the coil is in thermal balance with ist colder

environment. The magnet heats up much slower by the heat dissipated from the voice

coil. The coil temperature gradient falls with increasing magnet temperature, i.e. the the

voice coil heats up further.

Only the short time constant can be fixed in Limiter Settings. The long time constant is

calculated by an averaged factor from the short one. Both values are critical and require

several tests for verification.

Power amp gain is a most important parameter. It must be set precisely since HUGO does

not provide sense inputs.

Parameter Definition

Impedance Nominal loudspeaker impedance 2,4,8,16 Ohms

Amps

Gain Power amp gain in dB !!! 7

Contin. output Continuous output at above impedance

Surge Peak output at above impedance

Surge duration Time constant for surge value

Speaker

Peak limit Peak power handling

Thermo limit Continuous power handling

Time constant Time constant for heating up M
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Parameter Definition

Units The previous values may be entered in Watts/Volts

RMS/Volts Peak/dBu/dBV or mixed units.

Conversion is automatic. Power in Watts is relative

to above nominal impedance.

Referred Output Output reference is selectable for all units above

except Watts. Voltage values refer to power amp

output (Amps) or controller output (HUGO).

Set to full scale output Set all limiters to maximum value

Lim Setup ....

... Max DA DC-err. --- I

... Max DA level Maximum controller output level in dBu

HUGO standard = 16 dBu

GAE DSC28: 0, 6, 12 or 18 dBu  internally jumper-

selectable

7

... Peak DA voltage Maximum controller output voltage in Vs

HUGO standard = 6.915 Vs

$

Table 43 Limiter settings entry window under Crossover work in
the Edit menu
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10.8 FIR coef generation

The FIR filter coefficients are calculated in the final shape in the

FIR coef generation menu. All previous processing steps are imported from the

Bandpass input file. The loudspeaker frequency responses are imported from the

loudspeaker measurement files under Speaker.

Parameter Definition

Stereo setup Individual filtering of left and right channels yes/no

Single step Single step mode for test purposes yes/no :

Display text Text (max.18 characters) later displayed by the

controller

Gain adjust Level adjustment for the complete set of coefficients

Optimize passes Number of passes to optimize the filter function at

the selected width,  1-3 recommended

Filter ident 1 I

Speaker Loudspeaker measuring file names

Inv. Dynamic Maximum preemphasis to compensate loudspeaker

frequency response, 12 dB recommended

Delay lin LS minimum filtering

lin FIR linear phase filters only

minimal minimum phase filters (short delay)

Process speaker ... see Table 45

Self response Measuring file, that includes controller frequency

response without filters in CH0..3. Load

NEUTRAL.BLK in HUGO first.
CH0=SUB ; CH1=LOW ; CH2 = MID ; CH3=HIGH
File name =  XC44.....SPK

Target input File name of the function selected from the Target

response menu, standard = XT.SPK

Bandpass input File name of the bandpass function selected from

the process band pass menu, standard =

XB.SPK
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Parameter Definition

Coef output Target file containing coefficients and limiter settings

for HUGO.

This is later loaded in HUGO by Dispatch FIR

set to HUGO or programmed into an EPROM.

Create Diracs Generates a target file without filter function.

File name = NEUTRAL.BLK

Text = through

Limiter settings remain operative.

Table 44 FIR coef generation entry window under Crossover
work in the Edit menu

The Process speaker window enables processing of the measured loudspeaker

frequency responses before compensation and crossover filters are calculated. Even

though the HUGO high-resolution FIR filters provide the potential it is not always

practical to compensate each frequency response dip and peak by a filter. For that reason

frequency response can be smoothed in advance in the Process speaker menu.

Cmp&squeeze is another method of processing which compares the original curve with a

smoothed curve the smoothing width of which is adjustable. The portions below the

smoothed curve are weighted by the Below smoothed factor, those above by the

Above smoothed factor (factor 1 = no weighting). Peaks can be compensated completey

while dips can be marginally compensated or ignored by the appropriate settings. Serious

dips caused by cone break-up for instance must by no means be compensated by

increasing the controller level at the corresponding frequency. A Cmp&squeeze setting of

Width=1/3 oct, Above=1.0 and Below=0.3 is recommended. The results may not look

perfect since the frequency response dips can still be seen. As far as sound characteristics

go this setting is preferable to complete compensation.

Parameter Definition

Smooth Advance smoothing y/n

Width 1/Oct. Smoothing width (1/6 oct. recommended)

Smoothing of Smoothing magnitude, delay or both

Cmp & squeeze Compares with a smoothed response and

compresses dips and peaks by various ratios  y/n

Width 1/Oct. Smoothing width of the comparative response (1/3
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Parameter Definition

oct. recommended)

Above smoothed Compression factor for peaks

(1.0 recommended)

Below smoothed Compression factor for dips

(0.3 recommended)

Table 45 Process speaker entry window for preprocessing
loudspeaker measuring files
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77

Figure 97 Loudspeaker measurement with/without smoothing
Parameter in Process speaker: smooth=yes
1/6 oct. smoothing of magnitude

78

Figure 98 Loudspeaker measurement with/without Cmp & squeeze
Parameters in Process speaker: Cmp&squeeze=yes
Width = 1oct., Above smoothed = 1.0, Below smoothed = 0.3
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10.9 Dispatch FIR set to HUGO

Coefficient files with filter and limiter data can be loaded easily and quickly to HUGO by

Disptach FIR set to HUGO via the serial PC port. Port selection and setting are

accomplished in the menu item HUGO Remote under RS232 config.

Parameter Definition

Path Current path

Mash File mask (*.BLK for coefficient files)

Name File name

Load Load file

Mode append = append new file to previous file in

HUGO memory

overwrite = overwrite previous file in HUGO

memory with new file

Rename Rename file

Delete Delete file

Make Dir Start new directory

Filter Filter name of the selected coefficient file $

Mode Stereo or mono mode of the selected coefficient file $

Coefs Number of filter taps in the individual ways of the

selected coefficient file

$

Extract coefficients Writes the filter functions of the individual ways as

impulse responses in separate files with *.DAT

endings that can be read in as time signals again.

Remaining Allocatable space on current drive

Exit MF Exit MF

DOS command Change to DOS mode

Sort File list sorting criteria

name/date/size  ;  up/down
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Table 46 Dispatch FIR set to HUGO entry window under
Crossover work in the Edit menu
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10.10 HUGO Remote

HUGO Remote  provides remote PC control of most HUGO main menu functions.

Currently the EQ functions are not PC controllable yet.

This chapter is currently being updated!

Parameter Definition

Midi channel Midi channel = 0 I

Command 7 I

Parameter No. 0 I

Parameter val. 0 I

RS 232 config ... Serial interface selection COM 1,2,...

Interface protocol = 9600/8/1/None/no

7

Input Analog or digital input, or analog input and digital

insert

Filter (del) Filter set selection

Delete filter set by striking del

Vol ± Volume setting

Balance Balance setting

Output Output channel selection

0=SUB left 4=SUB right

1=LOW left 5=LOW right

2=MID left 6=MID right

3=HIGH left 7=HIGH right

Phase invert Invert output phase

Mute (all) Mute or activate output,

all mutes all outputs

Table 47 HUGO Remote entry window under Crossover work in
the Edit menu
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11 HUGO

This chapter is currently being updated!

11.1 Keyboard

Setup Menu F1 Main Menu F2 EQ Menu F3 á Level selection
in a menu

Shift ß Move left on a
selected level

à Move right on a
selected level

â Level selection
in a menu

Table 48 HUGO keyboard (ITA version 2nd generation)

Parameters are set by the rotary control. For large steps the control must be pushed in, for

smaller steps press the shift key additionally. All entries must be confirmed after selection

by pushing the rotary control.
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11.2 Setup Menu

No. Text Bedeutung Use

1. Select project HUGO, artificial head EQ, ... L

2. Brightness

Display ; LEDs

LED and display brightness ☺

3. Midi-Settings

Channel ; Out

Midi setup incl. channel selection (1-

16), output = Out, Through or Loop

☺

4. AES-Stat. Samplerate Current sampling rate $

5. AD-Settings

Clock ; Intern AD

A/D mode: 2 stacked A/D converters,

or 4 non-stacked A/D converters

M

6. DSP-Routing Internal matrix M

7. DSP-Tools For service only :

8. DSP-Prog. Select

DSP0...5

HUGO DSP functions M

9. P-Heap For service only :

10. Version number Reset and software registration

number

$

Table 49 HUGO Setup menu
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11.3 Main Menu

No. Text Definition Use

1. Select For service only :

2. Volume ; Balance Master volume 20 dB = 0 dB gain

without filters, with Diracs

(NEUTRAL.BLK)

Max.output - max. input 16-27 dBu

Max. FIR Gain -3 dB

EQ-Volume -6 dB

Total = -20 dB

Maximum filter preemphasis must be

subtracted from total (e.g. 12 dB)

☺

3. Mute Left Mute output CH1..4 left ☺

4. Mute Right Mute output CH1..4 right ☺

5. Input Select Analog or digital only, or

analog + digital insert

☺

6. Filter Select Filter set selection for X-over and

system EQ with FIR filters

☺

7. Master Delay Master delay without DSP and filter

delay

☺

8. Limiter Release Threshold Limiter release time constant

Threshold is smaller than value

selected in setup

☺

9. Gain CH1 CH2 CH3 CH4 Gain for individual outputs

left and right linked

☺

10. Delay Left Delay for individual outputs left ☺
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No. Text Definition Use

11. Delay Right Delay for individual outputs right ☺

12. Phase Inv. Left Invert phase of individual outputs left ☺

13. Phase Inv. Right Invert phase of individual outputs

right

☺

14. Level Meter Level meter on/off ☺

Table 50 HUGO Main Menu
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11.4 EQ Menu

No. Text Definition Use

1. EQ Select 0...16 Save EQ settings ☺ 7

2. EQ Volume ; EQ On/Off Volume -24..0 dB (default -6 dB)

3. EQ-Noise Shaper Select

4. EQ Filter 1 Type/Q/Hz/dB ☺

5. ..... ☺

6. EQ Filter 14 ☺

Separate settings left/right

No. Type Q Hz dB No. Type Q Hz dB

Ch L Ch R

Table 51 HUGO EQ menu (optional)

14 parametric EQs are provided for the left and right inputs each. Both channels can be

linked. If Link mode is selected after processing the channels individually both channels

reflect the settings of the channel that was active last.

The filter type (LP/HP/PEQ/LS/HS) is activated by striking the enter key. If the shift key

is pressed during parameter setting the smallest interval, i.e. the highest resolution is

selected. For fast interval increase the rotary control must be pushed in conjunction with

the entry function.
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Settings for left and right linked

No. Type Q Hz dB ----- ----- ----- ----- -----

Link ----- ----- ----- ----- -----

Table 52 HUGO EQ menu (optional)

Type: Low pass, high pass, peak, low shelving 6 or 12 dB, high shelving 6 or 12 dB

Q: filter quality

Hz: filter frequency

dB: filter gain in dB
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11.5 Remote control
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11.6 Inputs and outputs

Input: - stacked A/D converter (20-bit each)

- full drive at +27 dBu @ 1kHz

- S/N 127 dB

Output: - 20-bit D/A converter (BB PCM1702)

- 4-times/8-times oversampling filter

- maximum output level +16 dBu

- GAE DSC28: 0, 6, 12 or 18 dBu internally jumper-selectable

- S/N 114dB

79

Figure 99 HUGO SUB,LOW,MID and HIGH frequency response
without filter (volume = +22 dB)
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80

Figure 100 THD @ 1 kHz ; analog input ; HIGH output

81

Figure 101 THD throughout the frequency range @ +10 dBu input
level, analog input, HIGH output
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82

Figure 102 DIM100 ; analog input ; HIGH output
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12 Appendix

12.1 Figures

Figure 1 Front view of the ITADDA Front-end 12
Figure 2 Frequency response measurement with correct level (below) and excessive level

(above) 18
Figure 3 Frequency response measurement with insufficient level (below) 18
Figure 4 File header for time signals and frequency spectra in C  (definition for Maxils) 25
Figure 5 File header for time signals and frequency spectra in Pascal  (definition for MF

compatible to Maxils) 27
Figure 6 File header for polar plots in C for Maxils 28
Figure 7 Frequency weighting of a peanut sequence 53
Figure 8 Loudspeaker frequency response (l) and decay (r) 62
Figure 9 Loudspeaker phase response (l) and group delay (r) 62
Figure 10 Impulse (l) and step response (r) of the three loudspeakers 64
Figure 11 Frequency (l) and phase response (r) of the three loudspeakers 64
Figure 12 Maximum level at a selected THD limit (l) and THD, k2 and k3 at a defined level (r) 69
Figure 13 Isobar display of horizontal (above) and vertical (below) dispersion (3 dB/div) 73
Figure 14 Anechoic and reverberant field response (l) and resulting reverberant field EQ curve (r) 74
Figure 15: Above: Amplitude response (-6 dB/octave) of noise and sweep signals. Center: Group

delay response. Below: time signals. 80
Figure 16 Basic operation of a TDS measuring system. The broken lines are operative only if the

cos signal is used as exciter for the second measuring to eliminate low frequency ripple
(as described later). 83

Figure 17: Linear (l) und logarithmic graphs (r) of impulse response (grey) and energy time curve
(black) of a 15“ bandpass subwoofer. 84

Figure 18: Measuring interference and resulting impulse responses. Left: interference by a single
peak, right: interference by distortion (raised to power 0,96). To distinguish the sweep
responses they are on the -20 dB axis. The impulse response amplitudes (black =
sweep) have been magnified, maximum voltage is 1V. 89

Figure 19: Measuring interference by time variance and resulting impulse responses. Above: time
variance for simulation, center: response to noise (grey) and sweep signals (–20dB
axis,black).  Below: impulse response from IFFT (maximum voltage = 1V) 91

Figure 20: Effect of a typical 8 times oversampling filter (black) on a maximum length sequence
(grey). Because of the 0dB low pass filtering the crest factor falls off to 7,76 dB. The
MLS magnitude must not exceed 41% of maximum voltage. 94

Figure 21: Sine-shaped time variance interference (amplitude 0.5 samples, cf. Figure 19) of a
linear MLS measurement. Left:spectrum, right: resulting impulse response (peak = 1V) 95

Figure 22: Left: MLS section from numerical shift register values (DC offset removed by
subtraction of ½ sequence length). Right: Crosscorrelation by Hadamard
transformation with normal binary MLS (at the right) A binary MLS of the same
amplitude would cause a 1V peak in the crosscorrelation function. Below:
corresponding response, normal MLS level = 0 dB. 98



MF Audio Measuring System: Appendix                                                                      265/277

                                                                                                                                                       

© by Audio & Acoustics Consulting Aachen V 3.2E printed 12.12.99 11:02

Figure 23: Time signal, impulse response and response of a  filtered 13th degree MLS (Crest: 7,6
dB) suitable for loudspeaker measuring. To distinguish impulse response amplitude it
has been enlarged, the amplitude of the first value left is 1V. 99

Figure 24: Frequency response of an inexpensive 16-bit sound card Codec equipped measuring
system with a colored MLS as in figure 23 (grey) and resulting compensation response
(black) with 30 dB inversion dynamics. Test signal coloring, slight digital filter ripple,
low pass characteristics from 18 kHz and analog high pass characteristics below 50 Hz
are evident.. 101

Figure 25: Impulse and frequency response of a PA loudspeaker at 2m height including floor
reflections. To distinguish reflections the impulse response Y-axis has been enlarged
(impulse response peak: 7.36 kPa). Left: original including reflections, right:
windowed. 106

Figure 26: Noise floor of the measurement in Figure 25, enlarged across the measuring period 106
Figure 27 Exemplary reference measurement, degree = 14, file name COMP14.SPK 116
Figure 28 Frequency response of the exemplary digital EQ 117
Figure 29 Phase response of the measurement shown in Figure 28 118
Figure 30 Impulse response of the measurement shown in Figure 28 118
Figure 31 Phase response of the measurement in Figure 28 without delay (minimum phase) 119
Figure 32 Left: Prefiltered MLS reference measurement with and without microphone

compensation Right: Sennheiser KE4-211-2 compensation file 124
Figure 33 Reference measurement with system levels too high (above), accurate (center) and too

low (below). 125
Figure 34 Frequency response in a room with pronounced interference 129
Figure 35 Impulse response in a reflecting room 129
Figure 36 Impulse response, window length 8 ms 131
Figure 37 Frequency response resulting from the windowed impulse response 131
Figure 38 Nearfield measurement in front of an 8“ cone 133
Figure 39 Nearfield measurement in front of the vent 133
Figure 40 Nearfield measurement total incl. surface area weighting 134
Figure 41 Nearfield and windowed full-space measuring 134
Figure 42 Nearfield and full space measuring combined at 220 Hz 135
Figure 43 Amplitude response of three exemplary loudspeakers 139
Figure 44 Phase response of three exemplary loudspeakers 139
Figure 45 Impulse response of three exemplary loudspeakers 140
Figure 46 Step response of three exemplary loudspeakers 140
Figure 47 Frequency and impulse response measured with pre-comp and Delay shift setting;

frequency response compensated only, the 1.3ms system delay is evident in the impulse
response. 143

Figure 48 Frequency and impulse response measured with pre-comp and Delay shift setting;
additionally a window cuts off impulse response reflections. 143

Figure 49 Frequency and impulse response measured with pre-comp and Delay shift setting;
additionally a window cuts off impulse response reflections. The impulse response is
that of the loudspeaker exclusively. 143

Figure 50 Frequency and impulse response measured with post-comp and Delay shift setting and
window with actual distance measured between microphone and loudspeaker
(d=0.55m). 144

Figure 51 Impulse and frequency response for decay response calculation 149
Figure 52 Impulse and decay response (zoom factor 5) in Maxils 149
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Figure 53 Time windows, moved for individual spectra (start position 0 ms ; center 22 ms ; final
position 46.4 ms) 150

Figure 54 Standard 1 kHz octave polar plot including 1/3 octaves 151
Figure 55 2D isobar directivity plot of a singular plane 152
Figure 56 3D isobar directivity plot of a singular plane 152
Figure 57 3D UNF file displays from Ulysses (Ulysses © by IFB), 4 kHz octave, 5 dB/div,

resolution 5° 163
Figure 58 THD and noise at 80 Hz @ 130 dB/1m of an 18“ loudspeaker 166
Figure 59 THD, k2 and k3 of a loudspeaker at a constant input level eqivalent to 95dB @ 1m @

1 kHz 166
Figure 60 Maximum levels at 1% and 3% THD (the dips at 65 Hz and 85 Hz result from the

measuring room acoustics) 167
Figure 61 Impedance measuring reference 183
Figure 62 Impedance measurement of a small bass reflex loudspeaker 184
Figure 63 Impedance measurement without and with added weight 185
Figure 64 Thiele-Small parameters printed from MF.PRO file (Ctrl Print prints current

window display) 186
Figure 65 EQ output noise  left: (20 Hz - 20 kHz unweighted) overall level -81.5 dBu  right:

(20 Hz - 20 kHz A-weighted) overall level -83.4 dBu 188
Figure 66 A-curve and inverted A-curve 188
Figure 67 THD and noise of an EQ at 20 dBu (l) and 21 dBu (r) output level 193
Figure 68 Room impulse response as time signal (Ctrl T) 198
Figure 69 Room frequency response 199
Figure 70 Impulse response energy (Ctrl E) 199
Figure 71 Integrated room impulse response (Ctrl N) 200
Figure 72 Info window with reverberation times from room impulse response 203
Figure 73 J-filter set-up for 1/3 octave filter bank in the frequency domain 205
Figure 74 Filter set in 1/3 octave steps 205
Figure 75 Filter set in octave steps 206
Figure 76 J-filter setup for an octave filter bank to process an impulse response in the time

domain 207
Figure 77 Info window with reverberation times from room impulse response in octave steps

Ch0=125 Hz ; Ch6=8 kHz 207
Figure 78 Octave filtered room impulse response in Ch0 ... Ch6 208
Figure 79 Room response octave filters in Ch0 ... Ch6 208
Figure 80 ETC of the impulse response in Figure 68 209
Figure 81 ETC‘s of the impulse response in Figure 68 with octave filters (time axis enlarged) 210
Figure 82 Impulse response measured in a room with PA 212
Figure 83 Octave filtered impulse response 213
Figure 84 Squared and rectified impulse responses 214
Figure 85 Complete modulation transfer functions normalized to 1 at 0 Hz 215
Figure 86 MTF for the 7 octave bands up to 20 Hz 216
Figure 87 Setting the system output level to -8 dBu by pink noise 222
Figure 88 Setting the PA level to 80 dB SPL, C-weighted frequency response 224
Figure 89 Target function (red) with tolerance (bl-gr) for a cinema system measured without

subwoofer 226
Figure 90 Pink noise (l) and pink sweep (r) amplitude response 231
Figure 91 Pink noise (l) and pink sweep (r) group delay 231
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Figure 92 Pink noise (l) and pink sweep (r) time signals 231
Figure 93 Phase and frequency response without compensation 233
Figure 94 Input noise @ -40 dBu input sensitivity 234
Figure 95 THD at simultaneous AD/DA operation, level +14 dBu 234
Figure 96 Target response example (XT.SPK) 239
Figure 97 Loudspeaker measurement with/without smoothing Parameter in Process speaker:

smooth=yes  1/6 oct. smoothing of magnitude 250
Figure 98 Loudspeaker measurement with/without Cmp & squeeze Parameters in Process

speaker: Cmp&squeeze=yes  Width = 1oct., Above smoothed = 1.0, Below smoothed =
0.3 250

Figure 99 HUGO SUB,LOW,MID and HIGH frequency response without filter
(volume = +22 dB) 261

Figure 100 THD @ 1 kHz ; analog input ; HIGH output 262
Figure 101 THD throughout the frequency range @ +10 dBu input level, analog input, HIGH

output 262
Figure 102 DIM100 ; analog input ; HIGH output 263
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All Figures are contained in the ZIP file MFA-PCX.ZIP as PCX or TIF graphics

in 150x150 dpi 16 color format.
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12.2 Tables

Table 1 File menu functions 25
Table 2 Domain menu functions 30
Table 3 Display menu functions and entry windows 32
Table 4 Edit menu functions and entry windows 36
Table 5 Info menu functions and entry windows 37
Table 6 Trans menu functions and entry windows 39
Table 7 Signal processing settings menu Trans (Alt T, P) 40
Table 8 Signal processing settings menu Sliced (Alt T, S) 41
Table 9 AD/DA menu functions and entry windows (Alt A) 43
Table 10 Macro menu functions and entry windows (Alt R) 46
Table 11 Utility menu functions and entry windows 47
Table 12 Scaling function for display and printout 57
Table 13 AD/DA basic settings for example measurements 110

Table 14 Exemplary settings for frequency response measuring of EQs, power amps and preamps 112
Table 15  AD/DA Frequency Response menu settings 114

Table 16 AD/DA Frequency Response Reference menu settings 115

Table 17 AD/DA LS sensitivity Reference and more menu settings 124

Table 18 Input sensitivity and output level settings for loudspeaker measuring 126
Table 19 AD/DA LS sensitivity  menu setting 128
Table 20 Pre- and post-comp setting steps 145
Table 21 The decay response parameter menu in Maxils 149
Table 22  AD/DA Polar Response  menu settings 158

Table 23  Polar Response Settings  submenu 160

Table 24 ASCII spreadsheet section of a polar measurement, across = angles, down = frequencies 162
Table 25 The AD/DA menu THD+N single f 169

Table 26 The AD/DA menu THD+N (f) 171

Table 27 The AD/DA menu LS max SPL 174

Table 28 SPL max measuring window 177
Table 29 The AD/DA Impedance menu 180
Table 30 The AD/DA impedance reference menu 181
Table 31 16-bit system measuring dynamics and noise level at varying input sensitivity 189
Table 32 Standard settings of the AD/DA AD only menu 191

Table 33 The AD/DA menu THD+N single f 192

Table 34 The Info Room Acoustics menu 202

Table 35 The AD/DA AD only with SPL measuring settings 221

Table 36 The SPL... menu with SPL measuring settings 228

Table 37 Symbols 235
Table 38 Entry window Setup file under Crossover work in the Edit menu 236

Table 39 General settings entry window under Crossover work in the Edit menu 238
Table 40 Target Response entry window under Crossover work in the Edit menu 240
Table 41 Create Prototype Bandpass entry window under Crossover work in the Edit menu 243
Table 42 Process Bandpass entry window under Crossover work in the Edit menu 244
Table 43 Limiter settings entry window under Crossover work in the Edit menu 246
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Table 44 FIR coef generation entry window under Crossover work in the Edit menu 248
Table 45 Process speaker entry window for preprocessing  loudspeaker measuring files 249
Table 46 Dispatch FIR set to HUGO entry window under Crossover work in the Edit menu 252
Table 47 HUGO Remote entry window under Crossover work in the Edit menu 253
Table 48 HUGO keyboard (ITA version 2nd generation) 254
Table 49 HUGO Setup menu 255
Table 50 HUGO Main Menu 257
Table 51 HUGO EQ menu (optional) 258
Table 52 HUGO EQ menu (optional) 259
Table 53 The Monkey Forest CD contents as of 16 June,99 273
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12.3 Software Directory

Software included with MF.

Dateiname Dateityp Funktion Datum

EXEFILES

MF EXE Monkey Forest without HUGO option

(standard)

18.6.99

MFX EXE Monkey Forest including HUGO option 18.6.99

MAXILS EXE Maxils generates decay spectra and graphically

displays GDF data

13.2.99

PRINTGL EXE DOS shareware program for converting HPGL

graphics to PCX format

30.12.92

PLOT-VGA BAT Batchfile for displaying HPGL files on the

monitor (based on Printgl)

11.11.98

PLOT-PCX BAT Batchfile for converting HPGL to PCX

graphics with 150x150 dpi (based on Printgl)

3.11.98

UNIVESA EXE Graphics driver necessary for older graphics

boards

14.2.98

POLMAKRO XLS Excel 5.0 macro for polar plots, 2D and 3D

isobar display

(compatible with Excel 5.0 only!!)

14.2.99

EGAVGA BGI Graphics driver for Maxils 4.5.90

VGA16 BGI Graphics driver for Maxils 20.8.90

SANS CHR Zeichensatz für HPGL Grafiken aus MF 31.3.92

MAXIDAT

ERDNUß9 DAT Test signal - weighted MLS with 29-1 values 15.10.94
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ERDNUß10 DAT Test signal - weighted MLS with 210-1 values 15.10.94

ERDNUß11 DAT Test signal - weighted MLS with 211-1 values 15.10.94

ERDNUß12 DAT Test signal - weighted MLS with 212-1 values 15.10.94

ERDNUß13 DAT Test signal - weighted MLS with 213-1 values 15.10.94

ERDNUß14 DAT Test signal - weighted MLS with 214-1 values 15.10.94

ERDNUß15 DAT Test signal - weighted MLS with 215-1 values 15.10.94

ERDNUß16 DAT Test signal - weighted MLS with 216-1  values 15.10.94

PINK-NOI DAT Pink noise with 214 values 18.5.99

PINK-SWE DAT Pink sweep with 214 values 8.6.99

DOKU

PRINTGL DOC Explanations for Printgl 30.12.92

MFA-V31D DOC MF instruction manual German version, Word

97 file including all graphics

16.6.99

MFA-V31D PDF MF instruction manual German version,

Acrobat PDF file including all graphics

16.6.99

MFA-V31E DOC MF instruction manual English version, Word

97 file including all graphics

28.6.99

MFA-V31E PDF MF instruction manual English version,

Acrobat PDF file including all graphics

14.6.99

MFA-PCX ZIP All instruction manual graphics in individual

PCX files with 150 dpi resolution

16.6.99

FILTER

EXAMPLE
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Table 53 The Monkey Forest CD contents as of 16 June,99

Differing from the software installation by disk as described in 2.1 the complete directory

structure of the Monkey Forest CD should be adopted. Only the EXEFILES path must be

entered in the AUTOEXEC.BAT file PATH statement. For personal measuring an

independent directory should be set up. Updating is considerably simplified by keeping

the system files in a separate directory.

Various exemplary measurements can be found under Example. A complete record with

all measurements including polar data of the EAW model KF750 is filed under

EAWKF750. Exemplary measurements of dispersion with horizontal and vertical isobar

curves and a complete GDF file are in the Polar directory. The Micro directory contains

both a Sennheiser and a Monacor microphone compensation file.

The pick files of the examples in chapter 8 are listed under PCK files.

Since the examples are continuously updated and complemented they have not been

charted in this manual.
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12.4 Bibliography

The bibliography is currently in preparation.
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12.5 Index

The index is currently in preparation.
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Graphics File Index

                                                  
1 ABB: ROBBO.TIF
2 ABB: PEGEL-1.PCX
3 ABB: PEGEL-2.PCX
4 ABB.3: ERDNUSS.PCX
5 ABB: M57-FRE.PCX UND M57-ZER.PCX
6 ABB: M57-PHA.PCX UND M57-LAU.PCX
7 ABB: ALLE-IMA.PCX UND ALLE-SPA.PCX
8 ABB: ALLE-FRE.PCX UND ALLE-PHA.PCX
9 ABB: LSR-MAX.PCX UND LSR-95DB.PCX
10 ABB: ISO-HOR.PCX UND ISO-VER.PCX
11 ABB: DIR-FRDI.PCX UND DIFF-EQ.PCX
12 ABB: COMP14.PCX
13 ABB: EQ-FRE.PCX
14 ABB: EQ-PHA1.PCX
15 ABB: EQ-IMP.PCX
16 ABB: EQ-PHA2.PCX
17 ABB: LSCO14.PCX UND SEN-MIC.PCX
18 ABB: LSCO14F.PCX
19 ABB: CC82-1M.PCX
20 ABB: CC82-IMP.PCX
21 ABB: CC82IMPF.PCX
22 ABB: CC82-WIN.PCX
23 ABB: CC82-NM.PCX
24 ABB: CC82-NT.PCX
25 ABB: CC82-NAH.PCX
26 ABB: CC82WINA.PCX
27 ABB: CC82-KMB.PCX
28 ABB: ALLE-FRE.PCX
29 ABB: ALLE-PHA.PCX
30 ABB: ALLE-IMA.PCX
31 ABB: ALLE-SPA.PCX
32 ABB: HT-FRE1.PCX UND HT-IMP1.PCX
33 ABB: HT-FRE2.PCX UND HT-IMP2.PCX
34 ABB: HT-FRE3.PCX UND HT-IMP3.PCX
35 ABB: HT-FRE4.PCX UND HT-IMP4.PCX
36 ABB: TOP-IMP.PCX UND TOP-FRE.PCX
37 ABB: TOP-MAXI.PCX UND TOP-ZER.PCX
38 ABB: TOP-IMPW.PCX
39 ABB: POLAR-1K.PCX
40 ABB: DIR-HORI.PCX
41 ABB: DIR-HORD.PCX
42 ABB: KS-UNF.PCX
43 ABB: THD-80HZ.PCX
44 ABB: LSR-95DB.PCX
45 ABB: LSR-MAX.PCX
46 ABB: IMPCO15.PCX
47 ABB: CC82IMPE.PCX
48 ABB: PHL-TSP.PCX
49 ABB: EQ-NOIS.PCX UND EQ-NOISA.PCX
50 ABB: A-KURVE.PCX UND AI-KURVE.PCX
51 ABB: EQ-THD20.PCX   EQ-THD21.PCX
52 ABB: IMP-RAUM.PCX
53 ABB: RUEF.PCX
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54 ABB: IMP-POW.PCX
55 ABB: IMP-INT.PCX
56 ABB: TERZFILT.PCX
57 ABB: OCTAFILT.PCX
58 ABB: IMP-OCTA.PCX
59 ABB: FRE-OCTA.PCX
60 ABB: ETC.PCX
61 ABB: ETC-S125.PCX BIS ETC-8K.PCX UND ETC-SA.PCX
62 ABB: IMP-RAUM.PCX
63 ABB: IMP-OCTA.PCX
64 ABB: IMP-SQRE.PCX
65 ABB: MTF-KOMP.PCX
66 ABB: MTF-REDU.PCX
67 ABB: PINK-0DB.PCX
68 ABB: PINK80DB.PCX UND C-KURVE.PCX
69 ABB: KINOMESS.PCX
70 ABB: 2X PINK-SPK.PCX
71 ABB: PINK-LAN.PCX UND PINK-LAS.PCX
72 ABB: PINK-NOI.PCX UND PINK-SWP.PCX
73 ABB: ROBO-FRE.PCX
74 ABB: ROBNOISE.PCX
75 ABB: ROBO-THD.PCX
76 ABB: XT.PCX
77 ABB: SMOOTHED.PCX
78 ABB: COMPSQEU.PCX
79 ABB: XC44.PCX
80 ABB: HUGOTHDL.PCX
81 ABB: HUGOTHDF.PCX
82 ABB: HUGODIML.PCX


